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Ce manuel décrit I'utilisation, sous Windows, de la
suite bureautique intégrée OpenOffice dans ses
versions Apache OpenOffice™, OOoLight et
OOo04Kids.

OpenOffice se compose d'un ensemble de
programmes intégrés dans une méme interface,
qui permettent de créer les types de documents
les plus courants : documents texte, feuilles de
calcul, présentations et dessins.

1.1. A propos de ce document

La forte intégration de la suite OpenOffice permet
de dégager un grand nombre de fonctionnalités et
concepts communs a tous ses modules. Ce sont
ces éléments communs aux modules Writer, Calc,
Impress et Draw qui sont abordés dans cette
premiere partie.

Une telle approche favorise une prise en main
rapide, car elle met directement en évidence les
automatismes d'utilisation communs a tous les
modules de la suite. Elle permet aussi de se
libérer d'une redondance de descriptions dans la
documentation des différents modules, pour
mieux se concentrer sur leurs spécificités.

Lorsque des fonctionnalités sont plus complétes
dans certains modules (cas des tableaux, par
exemple), elles sont décrites ici de maniére
générale, avant d'étre abordées plus en détails
dans le manuel des modules concernés.

OOoLight et OOo4Kids étant des versions allégées
d'OpenOffice, vous aurez parfois a réactiver des
fonctionnalités qui ont été masquées, mais pas
supprimées, par souci de simplification.

Pour effectuer ce travail, vous pouvez vous référer
au chapitre de ce manuel qui traite de la personna-
lisation des barres de menu et des barres d'outils.

Apache OpenOffice (AOO) est une suite
bureautique intégrée libre et gratuite (licence
Alv2.0) développée par [I'Apache Software
Foundation (A.S.F.). Vous pouvez lutiliser
Iégalement sans frais de licence, aussi bien en
entreprise qu'a votre domicile, et méme participer
a son développement puisque son code source
est ouvert.

AOO intégre les applications suivantes : Writer
(traitement de texte), Calc (tableur), Impress
(logiciel de PréAO), Base (base de données),
Math (pour I'édition de formules mathématiques),
et Draw (logiciel de dessin vectoriel et de PAO).

OOoLight est une version allégée, dérivée du
code d'OpenOffice. Sous licence libre LGPL 3.0,
elle est développée par l'association EducOO.org.
et cible plus spécialement les adultes et les
seniors utilisant la bureautique de fagon moins
intensive.

Elle se caractérise par une interface simplifiée,
adaptable au niveau de compétence de
l'utilisateur, une totale indépendance vis a vis de
Java et ne posséde pas de module de base de
données.

00o04Kids est une version dérivée et simplifiée
de OpenOffice, sous licence libre LGPL 3.0,
développée par l'association EducOO.org.org
avec la participation d'acteurs du monde de
I'éducation.

Son ergonomie et ses fonctionnalités ont été
adaptées a un public jeune (7-12 ans). Elle se
caractérise par une interface adaptable au niveau
de [l'utilisateur, l'intégration de polices cursives,
une totale indépendance vis a vis de Java et
I'absence de module de base de données.

1.2. Crédits

Ce document a été réalisé a I'aide du traitement
de texte Writer des suites OOolLight et Apache
OpenOffice™.

Captures d'écran

Elles ont été réalisées et retouchées a l'aide des
logiciels Greenshot et Irfanview.
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1.Introduction

Logos

Les logos OOoLight et OO04kids ainsi que le logo
situé sur la page de couverture sont des
réalisations de Ben BOIS.

Le logo d' Apache OpenOffice sur la page de
couverture provient de :

http://www.openoffice.org/images/AOO _logos/

1.3. Conventions d'écriture

Les commandes

Les commandes et raccourcis clavier sont tous
écrits en gras.

— La commande Fichier > Imprimer ...> Options
- Avancé signifie qu'il faut commencer par
cliguer sur le menu Fichier, puis sur la
commande Imprimer ..., puis sur le bouton
Options .... dans la boite de dialogue
d’'impression, puis enfin sur l'onglet Avancé
dans la nouvelle boite de dialogue qui s'ouvre.

— Le raccourci Ctrl+N signifie qu’il faut d'abord
appuyer sur la touche Ctrl et la maintenir
enfoncée, puis appuyer sur la touche N du
clavier pour créer un nouveau document vide.

Les rubriques et les options

A quelques exceptions pres, les noms des boites
de dialogue ainsi que les rubriques et options
gu'elles renferment sont écrits en italique. Par
contre, les intitulés des boutons commande sont
écrits en gras.

Les remarques et
commentaires

Remarques et commentaires additionnels sont
présentés dans une ligne de tableau, comme ici.

1.4. License de ce document

Titre : Découvrir OpenOffice — L'environnement et
les commandes de base.

Version : 26.04.13
Copyright 2012 - 2013 Guy WATERVAL

Licensed under the Apache License, Version 2.0
(the "License"); you may not use this file except in
compliance with the License.

You may obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in
writing, software distributed under the License is
distributed on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND,
either express or implied.

See the License for the specific language
governing permissions and limitations under the
License.
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Ce chapitre décrit l'utilisation du clavier et de la
souris, des notions normalement connues sur
lesquelles vous ne devriez pas devoir vous
attarder.

2.1. Le clavier suisse romand

SUISSE

(10 (i

CELLL FEEL L LT T 1o (EEE
Sudaanauanazme |-
S P E T g )

SETTITTT T I s

Crédit :
http://www.edufr.ch/csmfr/fr/Publications/Initiation/
1/Default.htm

On y distingue quatre zones principales :

1. Les touches de fonction FlI a F12 jouent un
role variable d'une application a l'autre.

2. Le clavier principal correspond a celui d'une
machine a écrire.

3. Les 4 touches fléchées de navigation, pour
le déplacement du curseur, surmontées d'un
groupe de 6 touches utilisées pour I'édition et
la navigation dans un document.

4. Le pavé numérique dont les touches
posseédent deux modes de fonctionnement
entre lesquels on peut basculer en appuyant
simplement sur la touche Num Lock (premiére
touche en haut a droite du pavé numérique).

— Le mode numérique : signalé par une lampe
témoin allumée, est automatiquement activé au
démarrage de l'ordinateur et ses touches
permettent alors d'insérer les valeurs et
opérateurs arithmétiques qu'elles représentent.

— Le mode non numérique : la lampe témoin est
éteinte et les touches présentent alors une une
fonction de navigation ou d'édition (touches Ins
et Del).

Quelques touches particulieres

Esc (Escape) annule l'opération en cours.
Referme une boite de dialogue sans exécuter la
commande.

Backspace supprime la sélection courante
(texte, image, fichier, dossier, etc.). Lors de la
saisie d'un texte, produit I'effacement du dernier
caractere entré (situé immédiatement a gauche
du point d’'insertion).

Delete : supprime la sélection courante (texte,
image, fichier, dossier, etc.). Lors de la saisie de
texte, efface le caractére situé a droite du point
d’insertion.

Alt Gr : permet, lorsqu’on maintient cette touche
enfoncée, d'accéder a la troisieme fonction des
touches du clavier. La combinaison des deux
touches Ctrl et Alt (appuyées en méme temps)
produit le méme effet que la touche AltGr.

Ctrl : touche utilisée en combinaison avec une
autre touche du clavier pour lancer une
commande (raccourci clavier).

ALT : touche utilisée en combinaison avec une
autre touche du clavier pour lancer une
commande (raccourci clavier).

Enter : touche de validation.

Tab : touche de tabulation, déplace le point
d’insertion jusqu’au taquet de tabulation suivant.
Dans un tableau, permet de terminer la saisie
d’'une information dans une cellule et de déplacer
le point d’insertion dans la cellule suivante (vers la
droite). La touche permet encore de passer d’'une
rubrique a l'autre dans une boite de dialogue.

Print Screen sous Windows, copie I'écran
dans le presse papiers de Windows.
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Utilisation du clavier

L'entrée au clavier des lettres majuscules peut
se faire de deux fagons:

— En combinaison avec une touche Shift. Situées
a gauche et a droite du clavier principal et
identifices par des fleches montantes, ces
touches permettent I'entrée des lettres
majuscules et des caractéres figurant en haut
des touches a plusieurs fonctions.

— A l'aide de la touche Caps Lock. Située a
gauche du clavier principal, cette touche
posséde deux états : activé ou pas (commande
bascule ou interrupteur). Lorsqu'elle est activée,
toutes les lettres tapées le sont en majuscules.

Pour effacer un caractére, utilisez I'une des
procédures suivantes :

— Placez le point d'insertion juste a gauche du
caractere a effacer puis appuyez sur Delete
pour effacer le caractere et déplacer
automatiguement la suite du texte dun
caractére vers la gauche.

— Placez le point d'insertion a droite du caractére
a détruire, puis appuyez sur Backspace. Le
caractére est effacé et la suite du texte se
déplace d'un caractere vers la gauche pour
combiler le vide créé.

Pour supprimer un passage de texte
sélectionné appuyer sur Delete ou sur
Backspace. En cas d'erreur, la zone détruite est
récupérable en appuyant sur le bouton
d’annulation situé sur la barre d’outils Standard de
votre application active, ou a l'aide du raccourci
clavier Ctrl+Z.

Pour insérer des caractéres dans une zone de
texte, commencez par y placer le point d'insertion,
puis :

—En mode Insertion, l'entrée des nouveaux
caractéres repousse la suite du texte vers la
droite d'une largeur correspondant au nombre
de caractéres inséreés.

— En mode Refrappe, les nouveaux caractéres
entrés remplacent les anciens caractéres situés
a droite du point d'insertion.

Le basculement entre les modes Insertion et
Refrappe se fait simplement en appuyant sur la
touche INS du clavier.

Pour remplacer une zone de texte, sélectionnez
le texte a remplacer, puis entrez directement au
clavier le texte de remplacement.

Caracteres étendus du clavier

Caract. Alt Caract. Alt

A 181 3 160
A 143 3 134
A 182 5 131
A 183 3 133
A 199 4 198
A 142 3 132
’ 239 4 146
= 145 C 128
C 135 . 247
¢ 189 ! 254

250 @ 184
! 178 @ 243
N 246 i 213
E 144 & 130
E 210 & 136
E 212 & 138
E 21 & 137
- 196 8 208
B 209 a 166
i 225 v 230
% 171 240
b 231 = 232
o 207 i 173
! 125

Pour obtenir la frappe de tels caractéres :

1. Appuyer sur la touche Alt et la maintenir
enfoncée.

2. Entrer au clavier numérique le code
correspondant au caractére souhaité.

3. Une fois le code entré, relachez la touche Alt.
Le caractére spécial apparait au point
d’'insertion dans le texte.

Le code numérique doit étre obligatoirement entré a
partir du clavier numérique qui s'active ou se
désactive en appuyant sur la touche Num Lock.
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Caract. Alt Caract. Alt
i 1685 " 174
° 167 % 158
i 165 fi 164
O 224 0 162
O 226 i 147
O 227 o 149
(7 157 & 185
O 229 N 228
g 1563 i 148
1 244 + 241
£ 156 A 172
® 163 " 175
& 245 - 170
N 233 ¥ 163
Y 234 i 180
¥ 235 ¥ 151
¥ 154 il 129
" 249 % 243

237 W 236
i 152 ¥ 190
1 251 2 253
e 252 @ 64
£ [AItGH] I 123
+[E]

2.2. La souris

La souris comporte plusieurs boutons, chacun
d'eux doté dune fonction différente selon
I'application active. Lorsqu’on déplace la souris en
la faisant glisser sur la surface du bureau, le
pointeur subit un déplacement analogue a I'écran.

La souris remplit trois fonctions essentielles :

1. Elle permet de sélectionner les objets sur
lesquels on souhaite agir en lancant une
commande. La sélection permet d’indiquer au
programme [|'élément sur lequel il doit agir.

2. Elle permet de lancer les commandes qui
doivent s’appliquer a I'’élément sélectionné.

3. Elle permet de copier ou déplacer des objets
d’'un endroit & un autre d’'un méme document
ou entre des documents de méme type
affichés simultanément, sans devoir recourir
au presse-papiers de Windows.

La souris contrle sur I'écran un pointeur, le
curseur souris, parfois identiqgue au curseur texte,
mais pouvant étre différent (croix, carré, double
fleche...). La forme prise par le pointeur lorsqu'il
est posé sur un objet indique 'action qui peut étre
entreprise a I'aide de la souris sur cet objet.

Les différentes manipulations de base possibles
avec la souris sont les suivantes :

— Déplacer la souris : consiste a déplacer son
pointeur a la surface de I'écran en trainant
simplement la souris sur la table.

— Pointer: consiste a poser, sans cliquer, le
pointeur de la souris sur un objet. Cette
opération ne sélectionne pas l'objet sur lequel le
pointeur est placé, elle ne fait que "le montrer
du doigt" et révéler, par la forme que prend le
pointeur a cet endroit, lI'action qui peut étre
entreprise.

— Cliquer un bouton : consiste a appuyer sur l'un
des boutons de la souris puis a le relacher. Si
on appuie de la sorte sur le bouton gauche
lorsque le curseur de la souris se trouve sur du
texte, on définit Il'endroit ou le prochain
caractere tapé au clavier sera inséré.

— Double cliquer : consiste a cliquer deux fois trés
rapidement sur le bouton gauche de la souris.
Le double clic sur certains objets permet de
lancer des commandes. Par exemple, un double
clic sur l'icbne représentant un document dans
une boite d'ouverture de fichiers provoque le
chargement du document correspondant.

— Cliquer-glisser : consiste a tenir enfoncé le

bouton gauche de la souris et a trainer celle-ci

sur la table jusqu'a la position finale avant de
relacher le bouton. Cette technique est utilisée
pour déplacer des objets ou les redimensionner.

2.3. Déplacer le point
d'insertion

Pour travailler avec efficacité dans un document, il

faut pouvoir accéder rapidement aux endroits ou

des modifications doivent étre effectuées et y
transporter le point d'insertion (curseur texte).
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De tels déplacements sont généralement
effectués a l'aide des barres de défilement de la
fenétre du programme utilisé, puis en cliquant a
I'endroit souhaité pour y placer le curseur texte.

Mais ces déplacements sont également possibles
a l'aide des touches fléchées de navigation du
clavier :

— Fléche gauche : déplace le curseur texte (point
d'insertion) d'un caractére vers la gauche.

- Fléche droite : déplace le curseur texte d'un
caractére vers la droite.

— Fléche haut : permet de monter le curseur texte
d'une ligne.

— Fléeche bas: permet de descendre le curseur
texte d'une ligne.

— Home : déplace le curseur texte au début de la
ligne courante.

— End : déplace le curseur texte a la fin de la ligne
courante.

2.4. Sélectionner du texte

Pour agir sur un bloc de texte, il faut d'abord le
sélectionner avant de lancer la commande a lui
appliquer. Cette sélection consiste a dilater le
curseur texte sur la zone a sélectionner. Celle-ci
apparait alors en surbrillance.

A l'aide de la souris
Trois grandes méthodes sont possibles.

Méthode du Cliquer glisser

Positionner le curseur de la souris juste devant le
premier caractére de la zone a sélectionner, puis
appuyer sur le bouton gauche de la souris et, tout
en le maintenant enfoncé, faire glisser la souris
sur son tapis de maniére a ce que le curseur texte
recouvre toute la zone de texte a sélectionner.
Une fois la zone sélectionnée, relacher le bouton

gauche de la souris.

La sélection de plusieurs lignes s'obtient en
combinant un mouvement de déplacement de la
souris en diagonale et vers le bas.

Pour dé-sélectionner un bloc de texte, cliquer en
dehors de lui.

Méthode par fixation des limites

1. Placer le curseur texte au début de la zone a
sélectionner, puis cliquer sur le bouton gauche.

2. Appuyer sur la touche Shift et la maintenir
enfoncée.

3. Placer le curseur a la fin de la zone a
sélectionner, puis cliquer sur le bouton gauche
de la souris.

4. Relacher la touche Shift.

Cette méthode est particulierement efficace pour
sélectionner des longs passages de textes.

Sélection selon des critéres

— Un caractére :
sur le caractere.

— Un mot : double-clic sur le mot.

— Une phrase : positionner le curseur souris a
l'intérieur de la phrase, puis triple cliquer sur le
bouton gauche de la souris.

A l'aide du clavier

Placer le curseur texte au début de la zone, puis
utiliser 'une des méthodes suivantes :

par extension du curseur texte

—En maintenant la touche Shift enfoncée,
appuyer sur les fleches de navigation de
maniére a recouvrir complétement la zone a
sélectionner. Lorsque la sélection est compléte,
relacher la touche Shift.

- Shift+tHome : sélectionne la portion de ligne
depuis le point d'insertion jusqu'au début de
ligne.

- Shift+End : sélectionne la portion de ligne
depuis le point d'insertion jusqu'a la fin de ligne.

2.5. Regles de typographie
francaise

Dans la rédaction d’'un document en francais, il
est dusage de respecter les conventions
suivantes.

Les parentheses

Les parenthéses doivent étre collées au texte
gu’elles entourent, sans espace de séparation.
Par contre, il faut bien sdr mettre un espace avant
la parenthése ouvrante et un aprés la parenthése
fermante.
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2.Clavier et souris

Les nombres

La virgule est utilisée comme séparateur entre la
partie entiére et décimale des nombres, on écrira
donc, par exemple, 25,50 CHF.

On utilise un espace insécable pour séparer les
tranches de mille : 25 256,50 CHF.

Les espaces

Pour le signe ... Ajouter un espace
. paint apres

,virgule apres

. point wirgule awant et aprés
- deux points avant et aprés
¢ paint dinterrogation avant et aprés
| point d'exclamation awant et aprés
"apostrophe aucun

g avant et aprés
unités (monétaires, physiques, etc.) awant et aprés
quillemets typographiques et tiret avant et aprés

Les espaces qui entourent les signes de
ponctuation, guillemets, tirets et unités monétaires
ou du systéme métrique doivent étre insécables.

Autres conventions

A I'exception des locutions francisées comme, par
exemple, cf. ou critérium, les locutions latines
sont mises en italique dans le texte : in vitro.

— En régle générale, on ne met pas de point entre
les lettres des sigles : cff, sncb, etc.

— Les majuscules doivent étre accentuées.

— Les titres commencent par une majuscule, mais
ne se terminent jamais par un caractere de
ponctuation (a I'exception des  points
d'exclamation et d'interrogation).

— Dans les énumérations simples (une phrase par
élément), on peut commencer chaque élément
par une minuscule et le terminer par un point
virgule (sauf le dernier).
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OpenOffice est un intégré bureautique, c'est a
dire une application unique composée de

modules permettant la création de différents types
de documents et non une suite d'applications
dédiées fonctionnant de maniére autonome.

L'un des résultats visibles de cette intégration se
situe au niveau de I'environnement de travail des
differents modules. Celui-ci présente une
organisation générale similaire, mais avec un
espace de travail et des commandes spécifiques
aux différents modules.

3.1. Centre de démarrage

C'est I'écran d'accueil qui apparait lorsqu'on lance
OpenOffice depuis le bouton Démarrer, un
raccourci de lancement sur le bureau de Windows
ou une clé USB (comme application portable).

Le Centre de démarrage permet de démarrer, en
cliguant simplement sur leur icbne, tous les
modules intégrés, avec a chaque fois la création
d'un nouveau document vide basé sur les options
par défaut du programme.

AOO, OOoLight et 0O0o04Kids disposent de leur
propre Centre de démarrage, mais leur
fonctionnement est identique.

Le Centre de démarrage de AOO dispose toutefois
de plus de fonctionnalités.

Centre de démarrage de AOO

‘-f‘v - ™

Apache OpenOffice 3 e
E Texte Dessin
Classeur @ Base de données
Présentation Formule
E Quvrir... v B Modéles...

En plus des boutons de lancement des différents
modules, on y trouve encore :

— Bouton Ouvrir ... : pour ouvrir un document
existant et pouvoir le consulter ou le modifier.

— Bouton Modéles : pour accéder directement a
la boite de dialogue Modéles et documents et
pouvoir choisir un modele pour créer un
nouveau document.
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Au bas du Centre de démarrage, 3 boutons
conduisent a des adresses Internet importantes
permettant de :

1. télécharger des modeéles supplémentaires ;

2. ajouter de nouvelles fonctionnalités sous forme
d'extensions ;

3. se connecter au site officiel, par exemple pour
télécharger une nouvelle version.

Centre de démarrage de
OOolLight

Bienvenue dans

OOolight

Quvrir un document

Plus simple que son homologue AQOQ, il intégre
les commandes suivantes :

1. Créer un texte avec Writer : crée un nouveau
document vide basé sur le modéle par défaut
du programme.

2. Dessiner avec Draw
feuille de dessin vierge.

3. Créer une présentation avec Impress : crée
une nouvelle présentation vide.

4. Créer un tableau avec Calc crée un
nouveau classeur vide comprenant deux
feuilles de calcul.

5. Ouvrir un document : affiche la boite de
dialogue Ouvrir pour charger un document
existant et I'ouvrir dans le module qui permet
de l'afficher et de le modifier.

Centre de démarrage de
00o04Kids

Identique en fonctionnalités & celui de OOoLight,
mais avec un design adapté aux 7-12 ans.

crée une nouvelle

Le bouton Créer un tableau avec Calc affiche
dans ce cas un nouveau classeur vide, mais avec
une seule feuille de calcul.

Bienvenue dans

3.2. Interface de AOO

L'interface de tous les modules d'OpenOffice

présente des éléments communs qui se
manipulent de la méme maniére. Ces éléments
sont illustrés dans la copie d'écran ci-dessous, qui
représente l'environnement de travail de AOO
Writer, le traitement de texte.

Mi=1E3

Fichier Edition Affichage Insertion Format Tableau Oukils SmartCloud  Fenétre 2.4

B L'environnement de travail.odt - OpenOffice.org Writer
P-EH= R BEa Ry 3

|AOO_C0rpsdetexte V| |DejaVuSans 4 v| |10
E 5 -'-1-'-2-'-3-'-4-'-5-'-6-'-?-'-8|I_ﬁ|

E‘g »

6 1 L'environnement de-travail de-Witer............
1.1 Démarrer&3 0 Writer

M

ipache Openoffice:Writer est:lemodule-de:
traitement detexte de-la suite-bureautique-
“pache-Openoffice (A00) éditée-parla:
fondation-Apache. 1l vous-permettra- de créer
toutes sortes de-documents, de la:simple- L
lettre-d'une-page-a des-documents plus: B
importants intégrant-tableaux,-illustrations, (@
6
|

etcq
< 1 | 8 b

Pagel 2 |AOO_PageCOI0nnes |Frangais (France) |INS |STD |* |9 |

Ony trouve, de haut en bas :

Barre de titre.

Barre de menus.

Barre d'outils Standard

Barre d'outils Formatage.

Regles horizontale et verticale

Zone de travail (propre a chaque module)
Barre de défilement verticale

Barre de défilement horizontale

© ©o NGk wwDdRE

Barre d'état.
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Barre de titre

53 Tntroduction a AQGO et OOolig

On y trouve, de gauche a droite :

—Un bouton déroulant un menu avec des
commandes de gestion de la fenétre du
programme : réduire I'application dans la barre
des taches de Windows, réduire ou restaurer la
taille de la fenétre, fermer la fenétre (quitter
I'application).

— L'indication du nom du document actif, suivi de
celui de I'application en cours (Writer dans notre
cas).

— Dans la partie droite, les 3 boutons classiques
pour réduire l'application dans la barre des
taches de Windows, réduire ou restaurer la taille
de la fenétre, ou la fermer (marqué d'un X).

Zone de commandes

Fichier ~Edition Affichage Insertion Format Tableau Outils Fenétre Aide
‘- FRar SE - & F [ renema]d J
|Corps de texte E" |ArimD | |10 ‘ 6 I :

Située en haut de I'écran, sous la barre de titre,
elle se compose de la barre des menus et des
différentes barres d'outils dans lesquelles se
trouvent également les commandes les plus
importantes du programme.

Cette zone est celle ou viennent s'ancrer par
défaut les barres d'outils contextuelles
apparaissant automatiquement lorsqu'on
sélectionne un objet (tableau, image, lien, dessin,
etc).

OpenOffice a conservé, dans tous ses modules, une
disposition classique des commandes en menus et
barres d'outils. Cet agencement est celui qui
prévaut encore dans de nombreux autres logiciels et
c'est également celui qu'on retrouvait dans les
différents modules de la suite MS Office avant la
version 2007, qui introduisit une nouvelle
disposition des commandes sous forme de ruban.

Barre des menus

Comme le montre la copie d'écran ci-dessous,
représentant la barre des menus de AOO Writer,
cette barre non déplacable regroupe I'ensemble
des commandes du module, réparties en
catégories (les différents menus). Ces menus
fournissent un acces total et complet a toutes les
commandes disponibles.

Fichisr Edition Affichage  Insertion Format Tableau Outis Fenétre  Aide

En cliquant sur un menu, on déroule I'ensemble
de ses commandes connexes. Certaines sont des
commandes simples, d'autres des commandes
complexes affichant une liste de sous
commandes ou conduisant a l'ouverture d'une
boite de dialogue pour permettre a l'utilisateur de
paramétrer leur exécution.

En dehors d'un ou deux menus spécifiques a
certains modules, on trouve toujours dans cette
barre la liste des menus suivants :

- Fichier : renferme toutes les commandes pour
la création, [l'ouverture, limpression et
I'enregistrement des documents, ainsi que des
commandes de gestion des modéles et
d'exportation vers d'autres formats.

- Edition : fournit toutes les fonctions d'édition
classiques (copier, couper, coller, annuler,
refaire), en plus de fonctions d'édition
spécifiques a chaque module.

— Affichage : renferme les options contrélant
I'apparence de l'interface, comme la taille et les
modes d'affichage, les éléments visibles (régles,
barres d'outils, etc.).

— Insertion : renferme les commandes d'insertion
de divers éléments: images, vidéos, cadres,
caracteres spéciaux, tableaux, liens,
champs,etc. A cb6té de ces commandes
d'insertion communes, on en trouve également
qui sont spécifigues au module utilisé, comme
celles affectant la mise en page d'un document
Writer (en-téte, pied de page, sections, notes
etc.).

— Format : ce menu est trés contextuel, une partie
de ses de ses commandes est fortement
dépendante du module utilisé ou de la sélection
active. On y trouve également la commande
d'affichage du Styliste, qui permet de gérer et
d'appliquer des styles de formatage aux
différents éléments composant le document.

—Outils: ce menu renferme, en plus de
commandes spécifiques a chaque module,
diverses commandes de  configuration
générales, en plus de celles permettant a
l'utilisateur de personnaliser les menus et barres
d'outils de son programme. On y trouve encore
des commandes d'accés a la Gallery, au lecteur

multimédia interne, au gestionnaire des
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extensions et a la vérification orthographique et
grammaticale du document.

N

— Fenétre : a c6té d'une commande permettant
d'afficher le document actif dans une nouvelle
fenétre, ce menu affiche également la liste des
documents ouverts.

— Aide: ce menu renferme les commandes
d'accés a l'aide en ligne ou contextuelle, ainsi
gue des informations sur la version installée,
avec possibilité de la mettre a jour.

Barre d'outils Standard

Comme le montre la copie d'écran ci-dessous,
représentant, sous forme de fenétre flottante, la
barre d'outils du module AOO Writer, cette barre
regroupe les commandes de base communes aux
différents modules, avec quelques commandes
supplémentaires spécifigues a certains d'entre
eux. Elle se présente donc de facon assez
similaire dans les différents modules.

standard v X
2-0DE2d BER [
KB ¢ B - @ |v
#H2o@eva @

Les commandes figurant dans cette barre sont une
sélection des commandes les plus utilisées de la
barre des menus, a I'exception des commandes de
mise en forme qui sont regroupées dans une barre
d'outils séparée.

Barre d'outils Formatage

Elle est plus compléte dans les modules Writer et
Calc, ou elle regroupe les principales commandes
de mise en forme directement applicables aux
éléments intégrés dans le document actif.

Ci-dessous des copies d'écran de cette barre
dans Writer et Calc (sous forme flottante).
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Dans les modules Impress et Draw, c'est la barre
contextuelle Ligne et Remplissage qui apparait
comme barre Formatage par défaut.

Elle permet de formater les lignes et les formes, qui
sont les objets que ces logiciels manipulent
principalement.

Lorsque du texte se trouve sélectionné dans une
forme, une barre contextuelle de formatage de texte
apparait.

Les barres d'outils contextuelles

Ce sont des barres plus spécialisées qui ne
s'affichent que lors de la sélection de certains
objets (images, tableaux, etc.), puis disparaissent
lorsqu'on quitte la sélection de ces objets.

En dehors de ces situations, on peut forcer leur
affichage en les cochant dans la liste des barres
d'outils de la commande Affichage > Barres
d'outils.

Appartiennent a cette catégorie les barres d'outils
Ligne et remplissage, Tableau, Image, Hyperlien,
Puces et numérotation, etc.

Ainsi, par exemple, si une image bitmap se trouve
sélectionnée dans un document, la barre d'outils
contextuelle Image apparait avec les outils de
correction nécessaires a sa retouche. Si par
contre, on sélectionne un texte situé a l'intérieur
de l'image, alors c'est la barre d'outils Formatage
de texte qui apparait, avec des outils de mise en
forme de texte.

Espace de travail

L'espace de travail correspond a la zone centrale
de la fenétre ou s’affiche le document. On peut s'y
déplacer (on dit aussi naviguer) pour le consulter,
y placer le point d'insertion a l'endroit ou on
souhaite le compléter, ou encore y sélectionner
une zone pour pouvoir agir dessus a l'aide d'une
commande.

Dans les modules Writer, Impress et Draw, cet
espace est délimité par des regles horizontale et
verticale et des barres de défilement qui
permettent d'accéder aux parties du document qui
ne peuvent étre affichées a I'écran.
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Dans le module Calc, cet espace est délimité par les
lignes d'en-tétes de colonnes et de lignes de la
feuille active et par les barres de défilement
horizontale et verticale.

Les regles

Dans tous les modules disposant de réegles, c'est
la commande Affichage > Régle qui controle leur
affichage depuis linterface. Lorsque la case
précédent la commande est cochée, l'affichage
des regles se fait conformément a ce qui a été
défini dans la boite de configuration Afficher du
module actif. Dans le cas contraire, aucune régle
ne s'affiche.

L'unité de mesure utilisée pour la graduation des
regles est définie dans la boite de configuration des
modules Writer, Impress et Draw.

Les barres de défilement

Lorsque le document ne peut étre affiché en
entier dans l'espace de travail, des barres de
défilement horizontale et verticale apparaissent
pour permettre d'accéder aux parties non visibles.

Chaqgue barre de défilement se compose de trois
curseurs : un a chaque extrémité, représenté par
une fleche, permettant un défilement au coup par
coup, et un situé entre les fleches, appelé
ascenseur, pour obtenir un défilement continu.

La dimension de I'ascenseur dépend de I'importance
du document. Plus ce dernier est grand, plus
|'ascenseur est petit

Les modes d'affichage

Pour faciliter certains travaux (relecture, controle
général de mise en page, etc.) les différents
modules proposent, dans leur menu Affichage, un
choix de vues (modes d'affichage) pour le
document affiché dans I'espace de travalil.

Ces modes d'affichage sont différents d'un module a
I'autre, ils seront donc abordés en détails dans le
manuel de chaque module.

Dans tous les cas, le mode Normal est celui
proposé par défaut, car c'est le plus général.

L'affichage en plein écran

Lorsque ce mode d'affichage est actif (commande
Affichage > Plein écran), le document occupe
tout I'espace disponible de I'écran.

Dans ce cas, les menus et barres d'outils ne sont
plus accessibles et toute intervention sur le
document ne peut se faire gqu'en recourant aux
menus contextuels ou aux raccourcis clavier. Pour
quitter ce mode, cliqguez simplement sur le bouton
Plein écran ou appuyez sur la touche Escape.

Le zoom
Pour zoomer, vous pouvez, au choix :

— utiliser la commande Affichage > Zoom ... pour
afficher la boite de dialogue Zoom & Disposition
des pages ;

— utiliser Il'outil zoom disponible dans la partie
droite de la barre d'état du programme.

Menus contextuels

Lorsque vous travaillez sur vos documents,
chacun des éléments qui le compose (texte,
image, tableau, cadre, etc.) peut étre
complétement traité, lorsqu'il est sélectionné, par
le biais de menus contextuels disposant de la liste
des commandes qui peuvent lui étre appliquées.
C'est pour cela que ces commandes sont
appelées contextuelles. Une telle approche
apporte un réel confort d'utilisation, car elle évite
de devoir systématiquement passer par la zone
de commandes pour manipuler une sélection
active.

L'accés au menu contextuel d'une sélection se fait
en cliquant dessus avec le bouton droit de la
souris.

Les menus contextuels ne sont pas configurables
par I'utilisateur. Vous ne pouvez pas les modifier.
Des menus contextuels sont également disponibles
lorsque vous cliguez avec le bouton droit de la
souris sur des éléments de l'interface, comme les
barres d'outils, par exemple.

Barre d'outils Dessin

Par défaut, elle se place au bas de I'écran, juste
au-dessus de la barre d'état, et permet de tracer
des formes de bases, fleches, zones de texte,
bannieres, connecteurs, etc. dans tout type de
document. Beaucoup de ces boutons proposent

des listes de variantes, sélectionnables a la
souris, dans des palettes détachables.

Elle dispose également d'un bouton de lancement
de l'outil de titrage FontWork ainsi qu'un bouton
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commandant l'ouverture de la boite d'insertion
d'images.
Palettes détachables

Ce sont les petites palettes d'outils associées a
certains boutons, et auxquelles on accéde en
cliguant sur le bouton fléché situé juste a droite du
bouton concerné. Dans la barre d'outils Dessin,
ces palettes renferment des outils permettant la
création de formes de base, fleches pleines,
légendes, étoiles, etc.

Hee @
HVee dv
v EFASS
XSAVED

@S o @
=
WP % & B®l% |y

En prenant ces palettes par le bouton situé a leur
base, on peut les "décrocher" et les déplacer
dans l'espace de travail sous forme de barres
d'outils flottantes comme montré dans la copie
d'écran ci-dessous.

Organigramme ¥ X
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Qv EFES®S
XQSAVED
QE @@

Ces palettes détachables peuvent également
s'ancrer a un bord de I'écran

Barre d'état

Située au bas de la fenétre de chaque module,
juste sous la barre de défilement horizontale, elle
se compose d'une série de zones affichant des
informations sur le travail en cours, le document
actif et son état d'enregistrement, etc.

La barre d'état varie d'un module a l'autre et
certaines de ses zones permettent parfois
d'accéder directement a certaines fonctionnalités
du programme lorsqu'on double clique dessus. A
I'extrémité droite de cette barre, deux outils Zoom
permettent d'agir sur le facteur d'agrandissement
de I'espace de travail.

Bouton de démarrage rapide

Pour accélérer le démarrage de AOO lorsqu'on en
a besoin au cours d'une séance de travail, en
évitant de le garder complétement en mémoire
lorsqu'on ne l'utilise pas, il est possible d'effectuer
un chargement partiel de la suite au démarrage
de Windows.

Cette fonctionnalité n'existe que dans AOO.

Elle permet de démarrer plus vite AOO sur des
machines un peu limitées en mémoire vive.

Utiliser le démarrage rapide

Le chargement partiel de AOO au démarrage de
Windows se traduit par l'apparition d'une icone
dans la traybar (sur la droite de la barre d'état de
Windows). On peut alors démarrer la suite plus
rapidement depuis cette icbne, sur demande.

L'icbne de démarrage rapide posseéde un menu
contextuel (accessible d'un clic droit avec la
souris) comprenant une commande de création
de nouveau document pour chacun des modules
de la suite, ainsi qu'une commande d'ouverture
de fichier.

Ce menu fournit également un accés direct a la
boite de dialogue Modéles et documents pour
pouvoir créer un nouveau document basé sur un
modele personnalisé (la boite s'ouvre également
si on double clique sur licbne de démarrage
rapide).

% Texte

) Classeur

17 Présentation

£ Dessin

§8| Base de données

E Formule

4 A partir d'un modéle...

Ju Ouvrir un document...

v Charger OpenOffice.org au démarrage du systéme

Quitter le démarrage rapide
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Quitter, désactiver ouréactiver le
démarrage rapide

Lorsqu'on termine une séance de travail avec
AOO, le démarrage rapide reste actif et permet
un redémarrage accéléré ultérieur.

— Pour quitter le démarrage rapide, cliqguez a
droite sur son icone dans la barre d'état et
choisissez la commande Quitter le démarrage
rapide. Au prochain redémarrage de votre
ordinateur, le démarrage rapide sera de
nouveau actif.

— Pour empécher le chargement d'AOO au
démarrage de Windows, désélectionnez la
commande Charger OpenOffice au
démarrage du systéeme. Pour activer de
nouveau le chargement d'AOO au démarrage
de Windows, cochez a nouveau I'option
Chargement de OpenOffice.org au démarrage
du systeme dans la boite de configuration du
programme (commande Outils > Options >
OpenOffice.org > Mémoire vive).

Fenétres ancrables

OpenOffice dispose de 3 fenétres ancrables
spéciales : le Navigateur, le Styliste et la Gallery.

Vous pouvez ancrer plusieurs fenétres a un méme
bord de I'écran en les empilant ou en les
juxtaposant.

Coté espace de travail, chaque fenétre ancrée
comporte un bouton rectangulaire permettant, d'un
clic de souris, de I'afficher ou de la masquer (sans la
refermer).

La Gallery

C'est I'endroit de stockage idéal pour les images
et fichiers multimédias utilisés fréquemment,
comme les logos, cliparts, etc.

La Gallery s'affiche sous forme de fenétre ancrée
ou flottante, avec ses contenus classés en
différents thémes couvrant les domaines les plus
variés. Elle dispose de tous les outils nécessaires
a la gestion de ses contenus et a leur
organisation en bibliothéques.

Cette fenétre se présente et s'utilise de maniére
identique dans tous les modules de la suite et
permet l'insertion d'images dans tout type de
document par un simple Cliquer glisser a l'aide de
la souris.

Le Styliste

La commande Format > Styles et formatage
(F11) ouvre la fenétre du Styliste, I'outil central de
gestion des styles.

Cette fenétre (flottante ou ancrée) est
contextuelle et affiche, pour chaque module de la
suite, la liste des styles disponibles pour les
différents types d'élément qui composent le
document.

Depuis cette fenétre, il est possible d'appliquer, de
modifier et de créer de nouveaux styles pour
chaque catégorie d'éléments contenus dans le
document.

Le formatage a l'aide de styles plutét que par
formatage direct conduit a un gain de temps
considérable et garantit la cohérence de
présentation de vos documents.

Le Navigateur

La commande Affichage > Navigateur ouvre la
fenétre du Navigateur d’OpenOffice.org. Il s'agit d'
un explorateur de document qui affiche la liste
des différents types d’éléments contenus dans le
document, comme par exemple sous Writer, les
titres de différents niveaux, les tableaux, cadres
de texte, images, objets OLE, sections,
hyperliens, notes, dessins, etc.

S o-BE s 3
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EEH Tableaux
Cadres de texte
= ﬁ Images

ilh Chijets OLE
Repéres de texte
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REéférences

i= Index

g Commentaires
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Le navigateur permet non seulement d'accéder
trés rapidement a tous les éléments contenus
dans un document, mais également de les
recopier ailleurs, a l'intérieur du méme document
ou entre deux documents ouverts.
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Le navigateur est contextuel, car les éléments
listés sont différents d'un type de document a
lautre. La copie d'écran ci-dessous montre
comment se présente le navigateur dans Calc.

Colonne B B L E
Ligne =

® A

B Moms de plage Mode Glisser
@ Plages de base de données o
r' Flages liges B
ﬁ Images T
% tihjets CLE —
Cammentaires =
ﬁ Dbijets de dessin %

Dans tous les cas, le Mode glisser permet de
réaliser des copies des différents éléments dans
le document actif. Trois modalités d'insertion sont
possibles :

- Insérer comme hyperlien : un glisser-déposer
d'un élément du navigateur dans le document,
crée un hyperlien cliquable pointant vers
I'élément en question. Cela peut étre utile pour
créer une référence a une autre partie du
document.

- Insérer comme lien : avec un glisser-déposer,
une section sera créée contenant une copie de
'élément en question. Cette copie peut étre
mise a jour a chaque chargement du document,
ou lors de la mise a jour des liens.

—Insérer comme copie avec un (lisser-
déposer, une copie de I'élément est créée.
Cependant, contrairement au mode lien, cette
copie ne sera pas mise a jour.

Une explication détaillée du navigateur et de ses
fonctionnalités figure dans le manuel d'utilisation
des différents modules.

3.3. La barre latérale (Sidebar)

La barre latérale est une nouvelle fonctionnalité
introduite dans la version 4.0 de AOO. Elle n'est
donc pas disponible dans OOoLight et OO04Kids.

Elle permet d'exploiter I'espace libre laissé sur la
droite de l'espace de travail par les écrans larges
pour regrouper un maximum de fonctionnalités
dans cette zone non utilisée de I'écran. Elle offre

en grande partie la possibilité de se passer de
l'utilisation des barres d'outils et des boites de
dialogues et simplifie ainsi l'utilisation du logiciel.

Cette section décrit ['utilisation générale de cette
nouvelle fonctionnalité. L'utilisation de cette barre
sera abordée de maniere plus détaillée dans le
manuel des différents modules.

Eléments de la barre latérale

La barre latérale se compose d'une série de
volets dédiés a la réalisation de certaines taches.
A l'exception de celui qui affiche la Gallery, ces
volets different bien sOr d'un module a l'autre
puisque les documents manipulés sont différents.

Il n'est pas possible d’afficher deux volets
simultanément dans la barre latérale.

L'affichage de la barre latérale est controlé par la
commande Affichage > Barre latérale et celui de
ses volets par une barre d'onglets.

La barre donglets, sur la droite de la barre
latérale, permet d'afficher et de basculer entre les
4 volets suivants : Propriétés, Liste des styles
(Styliste), Gallery et Navigateur. Le tout premier
bouton de la barre = déroule un menu

permettant de choisir le volet a afficher ou encore
de personnaliser la barre des onglets en décidant
quels volets doivent y figurer.

Volet Propriétés

Affiché par défaut dans tous les modules lorsque
la barre latérale est visible, il est complétement
contextuel et se compose a tout moment de
panneaux regroupant les commandes applicables
a la sélection courante. Dans chaque panneau,
les commandes principales sont disponibles sous
forme de boutons ou de listes déroulantes, et un
un lanceur de boite de dialogue donne acces a la
boite de dialogue renfermant lintégralité des
commandes du panneau.

Les boutons suivis d’une fleche orientée vers le bas
affichent une palette d’options.

Le titre de chaque volet est précédé d'une petite
icbne + ou - selon que le panneau correspondant
ets replié ou déployé.

Ci-dessous les différents panneaux composant le
volet Propriétés de la barre latérale de Draw
lorsqu'une forme est sélectionnée.
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1. Barre d'onglets permettant de basculer d'un

volet a l'autre. Le premier bouton ™ ouvre un
menu avec des commandes de configuration
du contenu de la barre d'onglet, ainsi que des
commandes permettant d'afficher la barre
latérale comme fenétre flottante ou de I'ancrer
si elle était flottante.

2. Barre de titre du volet Propriétés, avec a sa
droite le bouton de fermeture du volet
Propriétés.

3. Barre de titre du panneau Texte, avec a sa
gauche le bouton commandant le déploiement
ou la fermeture du panneau et a sa droite le
lanceur de boite de dialogue ouvrant la boite
de dialogue de formatage des caracteres.

4. Barre de titre du panneau Paragraphes,
avec a sa gauche le bouton commandant le
déploiement ou la fermeture du panneau et a
sa droite le lanceur de boite de dialogue
ouvrant la boite de dialogue de formatage des
paragraphes.

5. Lanceur de boite de dialogue du panneau
Ligne.

Volet Liste des styles

Affiche le Styliste du module actif. La liste de
styles varie d'un module a l'autre. Le volet affiche
la liste de tous les styles disponibles et permet
leur application et leur gestion. Dans ce volet, la
liste des styles de chaque type est classée de

maniére  alphabétique, sans prévisualisation
possible.
Volet Gallery

Affiche la fenétre de la Gallery telle qu'elle
apparait lorsqu'on l'ancre a Il'un des bords
latéraux de I'écran. A noter que ce volet est le seul
qui ne montre aucune différence d'un module a
lautre. La Gallery est une collection d'objets
dessins, images ou multimédias qui peuvent étre
insérés dans un document.

Volet Navigateur

Affiche la fenétre du Navigateur correspondant au
module actif, telle qu'elle apparait lorsqu'on
I'ancre a I'un des bords latéraux de I'écran.

Manipuler la barre latérale

Vous pouvez ancrer la barre latérale au bord
gauche ou droit de votre écran et méme la
déplacer dans I'espace de travail sous forme de
fenétre flottante.

Déplacer la barre latérale

On peut déplacer la barre et la déposer sous
forme de fenétre flottante, dans l'espace de
travail, en la prenant par sa barre de titre ou en
double cliquant dessus en maintenant la touche
Ctrl enfoncée (commande bascule). On peut
également I'ancrer a l'autre bord latéral de I'écran,
par exemple, au bord gauche, si elle est ancrée
au bord droit.

Masquer la barre latérale

Un bouton rectangulaire situé au milieu de la
bordure gauche de la barre latérale permet a tout
moment de la masquer pour récupérer de
I'espace d'affichage. Un second clic de souris sur
ce bouton l'affiche & nouveau. A noter que la barre
d'onglets reste visible, mais vous pouvez la
masquer a son tour de la méme maniere.
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Refermer un volet

Les volets posseédent tous, sur la droite de leur
barre de titre, un bouton de fermeture marqué
d'un X. Lorsqu'on referme un volet, la barre
d'onglets reste visible afin de permettre de
réafficher I'un des volets de la barre latérale.

Lorsque vous avez refermé un volet, deule la barre
d'onglets reste visibble mais vous pouvez également
la masquer de la méme maniere que pour n'importe
quelle fenétre ancrée (bouton rectangulaire au
milieu de sa bordure).

Modifier la largeur de la barre

On peut modifier la largeur de la barre latérale,
par un simple cliquer glisser sur la bordure qui la
sépare de l'espace de travail, pour pouvoir
accéder a I'ensemble des commandes de I'un de
ses volets. Par exemple, un tel élargissement est
indispensable pour accéder a toutes les
commandes de la barre d'outils du Navigateur

dans Writer.

3.4. Interface de O004Kids et

OOolLight

0O0o04Kids et OOoLight disposent tous deux, dans
l'onglet Général de leur boite de configuration
(commande Outils > Options ...) d'une option
permettant d'adapter la complexité de leur
interface au niveau de l'utilisateur. Trois niveaux
sont possibles : Débutant, Moyen et Expert.

Les éléments rencontrés dans leur interface sont,
a peu de choses prés, identiques a ceux de
l'interface de AOO, et ils se manipulent de la
méme maniere. Ainsi, la barre des menus contient
la méme liste de menus que AOO, mais avec
moins de commandes. Par contre seule une barre
d'outils s'affiche par défaut, avec des icbnes de
grande taille, ce qui peut étre modifié dans les

options de configuration du programme.

Ci-dessous une copie d'écran de linterface de
0OO04Kids Writer de niveau Débutant. Vous pouvez
constater que la barre d'outils Débutant est trés
dépouillée.

& Introduction.odt - 00o4Kids Writer
Echier Edtion Affichage Inserton Format Outls Fenstre Aide
v
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= .
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. L.Introduction
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® - Capures ('écran 1 0004Kids ¢
. Log 1
@ [T 1.2 Conventions d'écriture 1
i Les commandes. 1
@ |, Les et les options 2
Page 1/2 2 colonnes | Frangais (France) [INS | §TD Numérotation du plan ; Niveau 1 [le]

Les interfaces d'OOoLight et celui d'OO04Kids ne
sont donc pas fondamentalement différents de
celui de AOO : barres d'outils contextuelles, barre
de dessin, fenétres de la Gallery, du Navigateur et
du Styliste, etc. sont présentes. C'est
principalement le nombre de commandes
disponibles qui a été réduit aux commandes les
plus fondamentales, par souci de simplification.

3.5. Organiser I'environnement

Vous pouvez organiser votre espace de travail a
votre convenance, en déplacant les barres
d'outils, les fenétres de la Gallery, du Navigateur
et du Styliste.

Vous pouvez ainsi:

— déposer vos barres d'outils sous forme de
fenétres flottantes, a l'endroit de votre choix
dans l'espace de travalil ;

— décider de les ancrer a I'un des bords de votre
écran.

Dans tous les cas, la derniére position occupée
par vos barres et vos fenétres est mémorisée
dans votre dossier de profil pour vous permettre
de retrouver a tout moment votre environnement
tel que vous l'aviez quitté.

Barres d'outils ancrées et
flottantes

Par défaut, les barres sont ancrées et disposées
en lignes dans la zone de commandes, sous la
barre des menus. Seule exception, la barre
Dessin, qui apparait en bas de I'écran, juste au-
dessus de la barre d'état du programme.
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C'est la disposition classique, mais il est possible
de les ancrer a gauche, a droite, ou en-dessous
de l'espace de travail.

Lorsqu'une barre est ancrée, on peut la
déplacer par un Cliquer-glisser, en la prenant par

la poignée pour la poser dans l'espace de
travail, sous forme de fenétre flottante comme
montré ci-dessous avec la barre d'outils Image.

Image [<E>
® - B 9(w =) &b &

Lorsqu'une barre est flottante, comme la barre
d'outils Image représentée ci-dessus :

—un simple clic sur le petit bouton de fermeture
marqué d'un X situé dans son coin supérieur
droit la fait disparaitre,

- le bouton fléché situé sur la droite de sa barre
de titre ouvre un menu contextuel permettant,
entre autres, de la personnaliser ou de gérer
l'affichage des boutons qui la composent
(commande Boutons visibles),

— on peut la déplacer en la "prenant” par sa barre
de titre,

— on peut remodeler sa forme a l'aide de la souris,

Y

—on peut la renvoyer a sa derniére position
d'ancrage par un double clic dans sa barre de
titre, ou l'ancrer a I'un quelconque des bords de
I'écran en la déplacant en direction du bord
choisi par un Cliquer-glisser dans sa barre de
titre.

Fenétres ancrées et flottantes

Les fenétres du Navigateur F5, la fenétre Styles
et formatage F11, ou celle de la Gallery peuvent
également étre déplacées dans I'espace de travail
sous forme de fenétres flottantes.

Pour détacher une fenétre ancrée, utilisez l'une
des procédures suivantes :

— Maintenez la touche Ctrl enfoncée et double-
cliquez sur une partie vide de la fenétre ancrée
(dans sa zone de boutons).

— Cliqguez dans une partie vide de la fenétre
ancrée (dans sa zone de boutons) puis faites la
glisser dans l'espace de travail.

Pour ancrer une fenétre flottante a l'un des
bords de I'écran, utilisez l'une des procédures
suivantes :

— Cliquez dans la barre de titre de la fenétre
flottante et déplacez-la de c6té dans I'espace de
travail, en direction de I'un des bords de I'écran,
jusqu'a ce que l'esquisse d'un cadre apparaisse.
A ce moment, relachez la souris.

- En maintenant la touche Ctrl enfoncée,
effectuez un double-clic sur une partie vide de la
fenétre flottante, dans sa zone de boutons, pour
lui faire retrouver sa derniere position d'ancrage.

Lorsqu'une fenétre est ancrée :

— On peut la masquer ou l'afficher de nouveau en
cliguant sur le bouton de masquage situé au
centre de la ligne qui la sépare de l'espace de
travail.

— On peut ajuster sa largeur a la souris.

Fenétres ancrées superposées

o-WE) | e-
2w e FEE =

EEH Tableaux
[O] Cadres de texte
ﬁ Images
ilh Chijets OLE
Repéres de texte
% Sections “
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i

Introduction & ACC et OdoLight ackif) w

ElciEEE & 3 -

Contenu de liste
Conkenu de kableau

Er-téte

Fin de liste

Index

Mote de bas de page

Comme montré dans la copie d'écran ci-dessus, il
est possible dancrer 2 fenétres (ici celles du
Navigateur et du Styliste) I'une a la suite de l'autre
en réduisant leur hauteur par un Cliquer glisser
sur le marqueur central figurant sur leur ligne de
séparation.
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3.6. Configurer AOO

Vous pouvez paramétrer le fonctionnement de
OpenOffice a deux niveaux :

—de maniere globale, & l'aide d'options qui
affectent le fonctionnement de tous les modules,
ce sont ces options globales qui seront décrites
ici ;

- plus finement en paramétrant le fonctionnement
individuel des différents modules eux-mémes.
Cette deuxieme catégorie de paramétrages sera
abordée dans le manuel d'utilisation de chaque
module.

Pour accéder aux boites de paramétrage des
options globales, utilisez la commande :

Outils > Options > OpenOffice.

Dans la fenétre qui s'ouvre, cliquez sur le signe +
situé juste devant l'entrée OpenOffice, dans le
volet gauche de la boite. Une liste de sous-
sections apparait. Chaque sous-section
correspond & une boite de configuration qui
s'affiche dans le volet droit de la boite Options.

La configuration des différents modules fonctionne
sur le méme principe que celui évoqué ci-dessus.

Les options de personnalisation décrites ci-
dessous sont générales et applicables a tous les
modules de la suite. Toutes ces configurations
sont mémorisées dans un dossier profil qui
subsiste méme aprés la désinstallation du
programme et est réutilisé lors de [linstallation
d'une nouvelle version.

A c6té de ce profil utilisateur, il existe également un
sous répertoire du répertoire d'installation principal
qui renferme la configuration partagée par tous les
utilisateurs.

Sous Windows XP le chemin qui conduit a ce
répertoire est C:\Program Files\OpenOffice.org
3\share

Données d'identité

Il s'agit d'un formulaire que I'utilisateur doit remplir
avec ses données personnelles : nom, initiales,
titre, adresse postale, émail, etc.

Ces informations seront exploitées par les outils
de révision pour identifier I'auteur de modifications
apportées a un document et seront également
récupérées dans vos documents lorsque vous y
insérez des champs de type Documents. Ce sont

également ces informations qui apparaissent
dans la boite des propriétés de fichier.

Options générales

Infobulles

Cochez cette option pour afficher dans une bulle
le nom des icones de linterface sur lesquelles
VOus pointez avec la souris.

Si vous activez I'option Infoballon, un texte d'aide
s'affiche lorsque vous pointez sur une icone, une
commande de menu ou un contrble de boite de
dialogue.

Assistant

S'il est activé, il intervient automatiquement dans
certaines situations pour vous apporter de l'aide.
Si vous renoncez a ses services et le refermez a
3 reprises alors qu'il vous propose son aide dans
une situation donnée, il ne s'affichera plus dans
cette situation car celle-ci sera retirée de sa liste.
Le bouton Rétablir I'assistant permet de
restaurer la liste par défaut des situations dans
lesquelles l'assistant s'affiche.

Formatage de l'aide

Permet de choisir, dans une liste déroulante, le
niveau de contraste souhaité pour l'affichage de
l'aide.

Boites Ouvrir/Enregistrer

Permet de choisir le type de boite de dialogue a
utiliser pour l'ouverture et l'enregistrement de
fichiers (celles du systéme d'exploitation ou celles
d'OpenOffice).

Statut du document

Permet de considérer ou pas limpression du
document comme une modification de celui-ci a
enregistrer comme telle dans les propriétés du
document. Si cette option est sélectionnée, lors la
prochaine impression et quand vous fermerez le
document, il vous sera demandé si vous voulez
gue les changements soient sauvegardés.

Année a deux chiffres

Spécifiez ici de quelle maniére le programme doit
interpréter les années représentées par deux
chiffres.
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2023

L'option par défaut
interprétée comme suit :

— Si vous entrez dans votre document la date du
1/1/30 ou une date postérieure, celle-ci est
interprétée comme étant le 1/1/1930 ou une
date plus tardive

— Si vous entrez une date antérieure, elle est
considérée comme appartenant au siécle
suivant. Ainsi, 03/04/07 sera interprété comme
03/04/2007.

Mémoire vive

Annuler

Indiquez ici le nombre maximum d'opérations
pouvant étre annulées que vous souhaitez
conserver en mémoire pendant la séance de
travail.

Cache pour les images

Permet de spécifier I'espace mémoire alloué au
cache pour les images. Lorsque des images y
sont stockées, le défilement des pages qui les
contiennent s'en trouve accéléré.

Il est encore possible dexclure du cache des
images dont la taille est supérieure a une taille
donnée et de spécifier pendant combien de temps

une image placée en cache peut y rester.

Cache pour les objets insérés

Spécifiez ici le nombre maximum d'objets OLE
pouvant figurer dans le cache dédié aux objets.

Démarrage rapide de OpenOffice

Cette option permet d'activer ou pas le démarrage
rapide de OpenOffice au lancement de votre
systeme.

Options d’affichage

Les options proposées dans cette boite
conditionnent l'apparence de la fenétre du
programme.

Echelle

On peut choisir ici un facteur d'échelle pour le
texte de l'aide, celui des menus et des étiquettes
des icOnes.

Taille et style des icbnes

Permet de choisir la taille des icbnes dans les
barres d'outils, ainsi que leur style.

Utiliser la police systeme pour l'interface
utilisateur

Permet d'utiliser la police systéme pour l'interface
utilisateur.

Menu

Icbnes dans les menus : permet d'afficher ou de
masquer les icdnes dans les menus.

Listes des polices

— Afficher I'apercu des polices : affiche un apercu
en regard de chaque police dans la liste Nom
de police de la barre d'outils Formatage

— Afficher l'historique des polices : classe, en haut
de la liste Nom de police (barre d'outils
Formatage), les cinq derniéres polices utilisées
dans le document actif.

Sortie graphique

— Utiliser l'accélération matérielle
I'affichage a I'écran.

— Utiliser le lissage
images.

améliore

améliore l'affichage des

Souris

Ces options permettent de choisir la position du
pointeur de la souris lors de [l'ouverture de
nouvelles boites de dialogue, ainsi que la fonction
attribuée au bouton central de la souris.

Sélection

Si l'option Transparence est active, les sélections
dans Writer et Calc s'afficheront en couleur, avec
une transparence réglable. Si on désactive cette
option, les sélections s'afficheront avec des
couleurs inversées.

Options d’impression

Configurez les options d'impression pour les
adapter aux performances de votre imprimante
par défaut et a votre mode d’'impression le plus
fréquent. Vous pouvez changer ces réglages a
tout moment. Ces options seront valables pour
tous les modules de la suite OpenOffice.
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Réduire les données d'impression

Ces options s'appliquent pour une impression
directe ou une impression dans un fichier. En
réduisant la taille des fichiers d'impression, elles
accélerent la vitesse d'impression et économisent
les cartouches si, par exemple, on décide
d'imprimer les images bitmaps en qualité réduite
ou de convertir leurs couleurs en niveaux de gris.

Réduire la transparence

Si l'option est active, les objets transparents sont
imprimés comme des objets non transparents
normaux.

Réduire les bitmaps

Imprime les bitmaps en qualité réduite. La qualité
d'impression  optimale correspond & une
résolution de 300 dpi. La qualité standard
correspond a une résolution de 200 dpi.

L'option Inclure les objets transparents applique
également la réduction de la qualité d'impression
aux zones transparentes des objets.

Réduire les dégradés

Réduit la qualité d'impression des dégradés, en
diminuant le nombre de bandes de dégradés, ou
en les imprimant dans une couleur intermédiaire
unique.

Convertir les couleurs en niveaux de gris

Demande l'impression des textes en couleurs et
des graphismes en niveaux de gris.

Avertissements d'impression

Cette rubrique permet de spécifier les
avertissements a afficher avant le début de
l'impression lorsque la taille de papier et
l'orientation des pages choisies pour le document
ne correspondent pas a la configuration
d'impression  par  défaut. Un  message
d'avertissement peut également s'afficher si le
document a imprimer contient des objets
transparents.

De tels avertissements peuvent s'avérer utiles si
vous travaillez sur des documents produits par des
personnes situées dans des pays ou les tailles
standards de papier différent des votres.

Chemins

Cette boite indique les chemins d'accés par
défaut aux dossiers importants de OpenOffice,
comme, par exemple, les chemins vers le dossier
de sauvegarde par défaut des documents, celui
des modeles, de la galerie d'images, etc.

Pour éditer I'un de ces chemins, sélectionnez-le
dans la liste puis cliquez sur le bouton Editer ...
et redéfinissez le chemin souhaité dans la boite
qui s'ouvre.

Le bouton intitulé Par défaut permet de retrouver
le chemin par défaut d'origine des entrées
sélectionnées.

Sous Windows, cette boite permet de redéfinir
I'endroit de stockage par défaut des documents.
Vous remarquerez que parfois certains dossiers ont
deux chemins listés : I'un vers un répertoire partagé
(qui peut étre sur un réseau) et l'autre vers un
répertoire spécifique a I'utilisateur (généralement
sur son ordinateur personnel).

Couleurs

Cette boite permet de sélectionner une couleur
dans une palette, de modifier ou de supprimer
une couleur existante ou d'en définir de nouvelles.

Les couleurs définies ou modifiées ici sont
disponibles dans tous les modules.

La maniéere la plus simple de créer une nouvelle
couleur consiste a choisir une couleur existante
avant de cliquer sur le bouton Editer ... pour la
moadifier. Une fois la bonne couleur obtenue :

— Cliquer sur le bouton Ajouter pour la définir
comme nouvelle couleur en lui attribuant un
nom.

— Cliquer sur le bouton Modifier pour simplement
modifier la couleur sélectionnée au départ.

Polices

Permet d'indiquer au programme les polices de
remplacement a utiliser s'il rencontre dans une
document des polices non installées sur le
systeme.

Il suffit de taper dans le champ Police le nom de
la police figurant dans le document et dans le
champ Remplacer celui de la police de
substitution puis de cliquer sur le bouton
Appliquer pour valider.
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La nouvelle paire Police - Police de substitution
apparait dans la table de remplacement et il ne
reste plus qu'a cocher la case Toujours pour que
le remplacement se fasse de maniére
systématique.

Vous pouvez également choisir ici les polices a
utiliser par défaut dans des sources HTML, Basic
et SQL.

Sécurité
Permet de définir des options de sécurité et
d'avertissement relatives a l'enregistrement des

documents, les connexions Web et |'ouverture de
documents contenant des macros.

Apparence

Permet de définir les jeux de couleurs utilisés
pour les éléments de l'interface.

Accessibilité

Cette boite renferme wune série d'options
d’affichage facilitant I'utilisation du produit par des
personnes souffrant d’'un handicap (de la vue, par
exemple).

Les principales options disponibles sont les
suivantes :

— Utiliser le curseur de sélection dans les textes
en lecture seule : affiche le curseur dans les
documents en lecture seule.

— Autoriser les images animées : affiche des
images animées, comme des images GIF.

— Autoriser le texte animé : affiche le texte animé,
clignotant ou défilant, par exemple.

— Disparition des infobulles aprés : masque les
infobulles aprés le nombre de secondes
spécifié. Si cette case n'est pas cochée, les
infobulles restent visibles tant que vous
n‘appuyez pas sur la touche Escape ou ne
déplacez pas le curseur.

— Options pour le contraste élevé : ces options
permettent de décider de quelle maniéere
OpenOffice utilisera les paramétres de contraste
élevé du systéme d'exploitation.

Le contraste élevé est un paramétre du systéme
d'exploitation capable de modifier le jeu de couleur

afin d'améliorer la lisibilité.

Mise a jour en ligne

Cette boite renferme des options de mise a jour
en ligne et permet d'activer une vérification
automatique des mises a jours disponibles au
bout d'une période donnée.

Chargement et enregistrement
Cette boite permet de définir :

- le format de sauvegarde par défaut (ODF, ou
MS Office, RTF, etc.) ;

—le délai aprés lequel une sauvegarde
automatique  des fichiers ouverts est
systématiquement réalisée par le programme ;

- si on souhaite le chargement des paramétres
utilisateurs ou ceux de limprimante avec le
document.

Lorsque vous sauvegardez un document, certains
réglages sont sauvegardés avec lui. Ainsi, si vous
décidez de charger les parametres utilisateurs a
I'ouverture du document, ce sont les réglages de
|'utilisateur qui ouvre le document qui seront
prioritaires sur ceux enregistrés avec le document.

Parametres linguistiques

Langues

Cette boite permet de choisir la langue de
l'interface, celle utilisée pour les parametres
régionaux (séparateur de décimales et monnaie)
et celle utilisée par défaut pour les documents.

Langue pour
Inberface utiisateur 1
Paramétre Inguistiqus 2 Frangais (Suisse
[dentigue 8 paramétre kngustique ()

Tauche séparatewr de déonmales 3

Mornaie par défaut 4 THF sFr. Frangais (Suisse)
Langues par defaut pour les documents

Occidental 5 # Par défaut - Frangais (Suisse)

riquement pour ke document actif

(1) L'option Par défaut spécifie la langue utilisée
pour le systeme d'exploitation et donc celle qui
sera utilisée pour linterface du programme
(menus, aide, boites de dialogues).

(2) Choisir ici la langue a utiliser pour les
parametres linguistiques (séparateur décimal,
monnaie et unités de mesure).
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3.Environnement et configuration

(3) Permet d'utiliser le séparateur associé a la
langue choisie pour les paramétres linguistiques
lorsqu'on appuie sur la touche correspondant au
séparateur décimal du clavier numérique. Dans le
cas contraire, c'est le caractere fourni par le
logiciel du pilote clavier qui est pris en compte.

(4) La monnaie par défaut correspond a celle de
la langue choisie en (2). La liste permet toutefois
d'en choisir une autre, si nécessaire, et
d'appliquer directement la modification a tous les
documents ouverts.

(5) Permet de choisir la langue utilisée pour la
vérification orthographique des documents dans
les alphabets occidentaux.

Linguistique

Cette boite permet de gérer les modules de
langues installés et de paramétrer le
fonctionnement de la vérification orthographique,
du dictionnaire des synonymes et de la coupure
de mots.

Modules de langues disponibles

Affiche la liste des modules de langues installés.
Ces modules peuvent comporter jusqu'a trois

sous-modules Vérification orthographique,
Coupure des mots et Dictionnaire des
synonymes. Le bouton Editer permet

d'activer/désactiver séparément certains sous-
modules d'un module sélectionné.

Linguistique:

Modules de langue disponibles

Hunspell SpellChecker
Libhyphen Hyphenator
OpenCffice.org New Thesaurus
Dictionnaires de ['utilisateur
T ———
| soffice [Toutes]
| TgnaredlList [Toukes]

Supprimer

Opkions

‘erifier l'orthographe au cours de la frappe
W weérifier la grammaire au cours de la frappe

Wwérifier les mots en majuscules

Weérifier les mots comportant des chiffres
v Weérifier la casse
N N

Editer..,

[l

L2

Dictionnaires de l'utilisateur

Affiche la liste des dictionnaires utilisateurs
disponibles (extension .DIC). Ces dictionnaires
peuvent étre édités et on peut en créer de
nouveaux ou en supprimer a l'aide des boutons
situés a droite de la liste.

Il est possible de limiter ['utilisation de ces
dictionnaires a la langue active ou de permettre leur
utilisation pour toutes les langues.

Options

Cette rubrique affiche une liste d'options pour la
vérification orthographique et la coupure de mots.

3.7. Configurer OOoLight et

00o04Kids

La commande Outils > Options ... ouvre la boite
Options — OOoLight qui renferme les options de
configuration communes a tous les modules de la
suite.

Ces options sont trés similaires a celles de AOO
et nous ne détaillerons ici que les particularités
litces a linterface adaptable au niveau de
l'utilisateur qui se trouvent dans la boite Général.

Comme OOolLight et 00o04Kids fonctionnent sans
Java, les applications, extensions et Applets basés
sur la technologie Java ne peuvent étre exécutées.

Miveau Utilisateur

® Débutant O Meryen O Expert

Protection des préférences utilisateur
[ activer le mot de passe Changer

Boites de dialogue ouvrirfenregistrer
[ utiliser les baites de dialogue OOaLight

— Niveau utilisateur : permet de choisir entre 3
niveaux : Débutant, Moyen, ou Expert. Selon le
choix effectué, linterface des modules
apparaitra plus ou moins simplifié. Cependant,
toutes les fonctionnalités restent accessibles,
certaines sont simplement masquées et peuvent
étre affichées a nouveau.

— Protection des préférences utilisateur : cette
option permet de protéger les préférences par
un mot de passe (par défaut, prof) pour éviter
leur modification accidentelle si plusieurs
personnes ont accés au programme. |l est
possible de redéfinir le mot de passe proposé
par défaut en cliquant sur Changer.

L'état de la protection des préférences est renseigné
par un cadenas fermé ou ouvert selon que I'option
Activer le mot de passe est cochée ou pas.

— Boites de dialogue Ouvrir | Enregistrer
permet de décider d'utiliser des boites OOoLight
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3.Environnement et configuration

plutdt que celle prévues par défaut dans le
systéme.

3.8. Le profil utilisateur

Le profil utilisateur est un dossier qui renferme
entre autres, dans un sous dossier user :

- les préférences que vous avez définies dans la
commande Outils > Options ...,

—les modéles que vous avez installés et sur
lesquels vous basez la création de vos
documents,

— les extensions que vous avez installées,
- les autotextes que vous avez définis,
— vos cliparts, vos dictionnaires utilisateur, etc.

Sous Windows XP, ce dossier a pour chemin :
C:\Documents and Settings\Nom de ['utilisateur
\Application Data\OpenOffice.org\3

Pour trouver le chemin de votre dossier de profil,
utilisez la commande Outils > Options >
OpenOffice-Chemins.

Comme ce dossier renferme également des
données sujettes a des modifications fréquentes,
comme les dimensions et positions des fenétres
ou barres d'outils de l'interface, il est soumis a de
fréquents enregistrements susceptibles de causer
des erreurs d'écritures préjudiciables au bon
fonctionnement du programme.

On peut donc parfois étre contraint de le purger
pour retrouver un profil initial "propre" tel qu'l
existait aprés l'installation du programme.

La solution la plus slre consiste dans ce cas, a
renommer ce dossier profil afin que le programme
ne puisse plus y accéder et soit obligé d'en
reconstruire un nouveau exempt d'erreurs.

Pour ce faire :

— Quittez proprement OpenOffice (y compris le
démarrage rapide).

— Ouvrez I'Explorateur Windows et demandez
I'affichage des fichiers et dossiers cachés.

— Accédez a votre dossier de profil par pointage,
ou, plus simplement, en tapant %appdata
%\OpenOffice.org dans le champ de saisie des
chemins de votre Explorateur Windows.

— La fenétre qui s'ouvre affiche un dossier nommé
"3" qui contient votre profil pour la version 3 de
OpenOffice. En renommant simplement le
dossier OpenOffice.org en Old_OpenOffice.org,

vous le rendez invisible au programme et
I'obligez a en créer un neuf.

Veillez a conserver votre ancien profil pour pouvoir y
récupérer certains éléments et les transférer dans le
nouveau.

3.9. L'aide

OpenOffice dispose dun systeme daide
fonctionnant de maniéere identique dans tous les
modules.

Aide en ligne

Le raccourci F1 ou la commande Aide > Aide de
OpenOffice affichent, dans une fenétre
indépendante, le manuel d'utilisation du module
actif.

Aide contextuelle

Vous pouvez demander [l'affichage de bulles
d'aide ou de messages étendus (infoballons), ou
encore l'aide d'un Assistant dans certaines
situations, en cochant les options
correspondantes dans la boite ouverte par la
commande :

Outils > Options > OpenOffice > Général.

Les infobulles

Si vous avez demandé l'activation des infobulles,
le simple fait de pointer (sans cliquer) sur l'une
des icbnes de linterface vous affiche son nom
dans une petite boite, appelée infobulle.

Les infoballons

Si vous avez demandé l'affichage des infoballons,
vous obtiendrez une explication succincte sur
I'élément ou la commande de menu sur laquelle
Vous pointez avec la souris.

Commande : Aide > Qu'est-ce que c'est ?

Si vous n'avez pas configuré laffichage des
infoballons, vous pouvez obtenir leur affichage a
la demande par la commande Aide > Qu'est-ce
que c'est? ou en utilisant le raccourci Shift+F1.

Le pointeur de votre souris se transforme alors en
un point d'interrogation qu'il suffit de poser (sans
cliquer) sur un bouton commande pour obtenir
une information plus détaillée a son sujet.
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3.Environnement et configuration

La commande Aide > Qu'est-e que c'est ? est
moins compléte que I'activation des infoballons. Elle
ne permet pas l'affichage d'un message d'aide sur
les commandes des menus.

Pour désactiver cette fonction, cliqguez simplement
quelque part dans la fenétre du module actif, le
pointeur de la souris retrouve alors son aspect
normal.

Bouton "Aide" des boites de dialogue

Les boites de dialogue possédent un bouton Aide
conduisant directement a la rubrique de l'aide en
ligne qui décrit la boite.

L'assistant

Lorsqu'en cours de travail vous effectuez
certaines actions, un assistant peut apparaitre
sous forme d'une petite fenétre en bas a droite de
votre écran.

Si vous cliguez dessus, une fenétre d'aide en
rapport avec l'opération en cours apparait avec
une durée d'affichage de quelques secondes.

Si vous ignorez cet assistant a plusieurs reprises
pour une méme action, ou si vous le fermer au
lieu de cliquer dessus, il n'apparaitra plus pour
I'action concernée.

Vous pouvez a tout moment restaurer l'assistant
avec ses paramétres d'origine dans l'onglet
Général de la boite de configuration ouverte par
la commande Outils > Options > OpenOffice.

Aide par mots-clés

La recherche par mots-clés permet d'afficher des
rubriques contenant un texte précis entré comme
critere de recherche dans un champ de recherche
(zone Rechercher).

Cette méthode est trés efficace, mais nécessite
une certaine connaissance de la terminologie
utilisée dans le programme.

Le résultat d'une recherche par mot-clé aboutit a
I'affichage d'une liste de rubriques correspondant
aux mots-clés saisis. En cliqguant sur le lien

correspondant a la rubrique souhaitée, son
contenu s'affiche.

© 2012 - 2013 G. Waterval Version : 26/04/13 Apache licence, Version 2.0

0004Kids - Apache OpenOffice - OOoLight

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

29/102



http://wiki.ooolight.org/index.php/Main_Page/fr
http://openoffice.apache.org/
http://wiki.ooo4kids.org/index.php/Main_Page/fr
http://www.apache.org/licenses/LICENSE-2.0

4.Les commandes

4. Les commandes

4.Les commaNdES........ccuvveeeeieeeeeeeeieiiiriveneeeeeen 30
4.1.Commandes des menus...........ccccceeeennnn.. 30
Types de commandes............ccccccceeeeerennnn. 30
Personnaliser les menus..........ccccceeeeeeeenns 31
4.2.Gérer les barres d'outils...........cccvvvvveeeene. 32
Modifier la taille des icones....................... 32
Modifier I'affichage des icbnes ................. 32
Personnaliser les barres d'outils............... 32
4.3.Les raccourcis-Clavier........cccoovevvvvieieennnn. 33
Gérer les raccourcis clavier..........ccccce..... 33
Définir des raccourcis clavier.................... 33
Utiliser un fichier de configuration clavier. 34
4.4.Les commandes de base......................... 34
Créer un nouveau document.................... 34
Ouvrir un document existant..................... 35
Enregistrer un document.............ccccoeevnnee 36
Imprimer un document............cccceeeeveeeenee. 37
Boite d'impression de AOO........ccc...cceeee 37
Imprimer une brochure..............ccccevvvreen. 38
Boite d'impression de OOolLight............... 39
Envoyer un document par Email............... 40
Exporter vers d'autres formats.................. 40
Exporter au format PDF...........cccccceeieieeee. 40
Couper - Copier - Coller.......ccccceevvveeennnnns 44
Défaire et Refaire.......cccccccoeevevccciieenienenn, 45
Appliquer le format............ccccccvviiininnneennn. 45

Dans tous les modules d'OpenOffice, les
commandes sont placées a différents endroits :
barre des menus, barres d'outils, menus
contextuels, fenétres déplacables.

4.1. Commandes des menus

La barre des menus fournit un accés total et
complet a toutes les fonctionnalités disponibles
dans un module.

On y trouve des commandes simples et des
commandes complexes.

Types de commandes

Selon que leur exécution se fait de maniéere
directe ou pas, on distingue les commandes
simples, qui s'exécutent directement, et les
commandes complexes, qui ne peuvent
s'exécuter qu'aprés un paramétrage dans une
boite de dialogue.

Commandes simples

Elles ont un effet immédiat : les sélectionner lance
immédiatement leur exécution. Elles ont souvent
un comportement “interrupteur”, parfois appelé
aussi comportement "& bascule" ou encore "flip
flop", c'est-a-dire qu'elles sont activées ou
désactivées par la méme sollicitation. Ainsi, si
Vous mettez en gras un passage de texte avec le
bouton de graissage figurant dans une barre
d'outils de formatage de texte, un premier appui
sur le bouton graisse les caractéres sélectionnés
et la répétition de la commande retire le
graissage.

Souvent, a l'intérieur des menus, ces commandes
sont précédées d'une coche pour signaler quand
elles sont actives. Lorsquelles se trouvent
intégrées a des barres d'outils, elles sont actives
guand leur bouton apparait enfoncé et inactives
guand le bouton est ressorti.

Commandes complexes

Ce sont celles dont le nom est suivi de trois points
de suspension, pour signaler qu'elles ouvrent une
boite de dialogue pour permettre a l'utilisateur de
paramétrer leur exécution, c'est a dire de préciser
de quelle maniére elles doivent s'exécuter.

Boites de dialogue

Ce sont des fenétres spéciales qui peuvent
comporter plusieurs onglets regroupant un certain
type d'options.

Lorsqu'une commande débouche sur I'ouverture
d'une boite de dialogue, les options actives dans la
boite sont celles qui sont appliquées a la sélection
courante ou encore celles prévues par défaut. A
|'utilisateur de décider alors de les modifier pour
obtenir ce qu'il souhaite.

Dans une boite de dialogue :

— Les options disponibles peuvent revétir les
formes suivantes boutons radio, cases a
cocher, listes déroulantes et champs éditables.

— L'annulation d'une commande peut se faire, au
choix, en cliquant sur le bouton poussoir
Annuler ou sur le bouton de fermeture situé en
haut a droite de la fenétre de dialogue, ce qui
permet de renoncer a la commande et de
retourner au document.

—Le choix du bouton OK ou la frappe de la
touche Enter au clavier, conduisent tous deux a
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I'exécution de la commande avec application
des options définies a la sélection courante.

— La navigation entre les différentes rubriques et
les boutons affichés dans une boite peut se
faire au clavier en appuyant sur la touche Tab.
Si une rubrique offre plusieurs possibilités, la
navigation entre ses différentes options se fait a
l'aide des fleches de navigation du clavier et la
sélection ou la désélection de cases a cocher
s'obtient en appuyant sur la barre
d'espacement.

Personnaliser les menus

La composition des commandes des différents
menus est personnalisable par la commande

Outils > Personnaliser ... - Menus, qui ouvre la
boite de dialogue Personnaliser dont l'onglet

Menus est dédié a cette tache.

Les menus
personnalisables.

contextuels ne sont pa

[0}

La boite permet :

— de créer un nouveau menu;

— de modifier un menu existant en lui ajoutant,
supprimant ou renommant des commandes ou
en modifiant leur ordre dans le menu.

Menus |Clavier ” Barres d'outils H Evénements |

Menus OOoLight Impress

1
3 Menu -
Contenu du menu
Entrées E rouveau 4  Ajouter...
#& Ounrr...
Derniers documents utilisés 5 Macifier -
€ Fermer N |+ 6
& Erregistrer
& Ervegistrer sous... 7 =

Tout enregistrer

a Exporter... ~

Enregistrer dans ‘OODLight Impress v ‘ 8

Description
Crée un nouveau document OCoLight.

E o] ” Annuler ][ Aide H Rétabli }

1. Permet de choisir le menu a personnaliser.

2. Démarre la création d'un nouveau menu. Une
boite de dialogue s'ouvre pour permettre de le
nommer et de définir sa position dans la barre
des menus.

3. Permet de positionner un menu différemment
dans la barre des menus. S'il s'agit d'un menu
personnalisé, des commandes permettent
encore de le renommer ou de le supprimer.

4. Ouvre la boite de dialogue Ajouter des
commandes, pour ajouter des commandes au
menu & modifier ou & un nouveau menu.

5. Permet de retoucher la structure d'un menu en
créant un sous menu ou de débuter un groupe
par une ligne de séparation. La commande
permet également de renommer ou de
supprimer toute entrée sélectionnée dans la
partie centrale de la boite qui affiche en
permanence la liste des commandes
composant le menu en cours de
personnalisation.

6. Permet de remonter ou de descendre une
entrée dans la liste des commandes du menu.

7. Liste les commandes qui seront intégrées dans
le menu en cours de personnalisation ou de
création.

8. Choisissez ici si vos modifications doivent étre
enregistrées uniguement avec le document
actif, ou dans le module actif et dans ce cas, la
barre modifiée ou créée sera enregistrée dans
le profil utilisateur.

9. Décrit la
sélectionnée.

Ajouter des commandes ‘Z\

Pour ajouter une commande 3 un menu, selectionnez la catégorie,
puiis la commande. Yous avez egalement la possibiite de faire glisser la
commande vers |3 liste correspondante de l'onglet Menus de la boite
de dialogue Personnaliser.

fonction de la commande

Categorie Commandes
Application L IR e e format] A Ajouter
Modéles il Champs il
Affichage Callage spécial
o Col\e? D = Fermner
Options = -
EReiC | Do 4
Insérer < Couper
Docurments L _ Dupliguer
Format ) Hyperlien
Contrdles Hyperlisn
g;\;g:ler & Impossible d'annuler
Modifier 3 “¥ Impossible de restaurer 3

Description

Tout d'abord, sélectionnez du texte ou un objet, plus cliquez sur licéne. Ensuite,
cliguez ou glissez 4 travers un autre texte ou encore cliquez sur un ohiet pour
appliquer le méme formatage.

Une fois les modifications effectuées cliquez sur
OK pour les enregistrer, Annuler pour y renoncer,
ou Rétablir pour rétablir la configuration d'origine
du menu.
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4.2. Gérer les barres d'outils

Les barres d'outils se composent de boutons
poussoirs permettant d'exécuter, sur simple
pression, des commandes spécifiques qui
peuvent étre simples ou complexes. Ces
commandes correspondent aux fonctions les plus
utiles et/ou les plus utilisées.

Les boutons apparaissent enfoncés lorsque les
commandes sont actives et relachés lorsqu'elles
ne le sont pas. Ceux qui sont suivis d'une pointe
de fléche orientée vers le bas affichent des sous-
menus, des barres d'outils détachables, ou des
palettes de commandes supplémentaires.

Lorsqu'on pointe simplement (sans cliquer) sur les
boutons d'une barre, une bulle informative
(infobulle) apparait. Les barres possédent
également un menu contextuel qui permet de les
personnaliser.

Pour afficher ou masquer les barres d'outils,
utiisez la commande Affichage > Barres
d'outils, puis cliquez sur le nhom des barres a
afficher dans la liste. Lorsqu'une barre est
affichée, une coche apparait en regard de son
nom.

Vous pouvez modifier I'affichage et la taille des
icbnes qui représentent les commandes situées
dans vos barres d'outils.

Prenons un exemple, la barre d'outils Image telle
gu'elle se présente lorsqu'elle est ancrée dans la
zone de commandes. On y trouve, de gauche a
droite :

woNc |F'*d§ﬂl1 | Qoxn & S -i'.lg

— la poignée par laquelle il faudra la saisir avec la
souris pour la déplacer et la transformer en
fenétre flottante dans I'espace de travail ;

—les icdnes représentant les commandes qui la
composent ;

— tout a droite, un bouton fléché donnant acces a
un menu comprenant les commandes qui
permettent de la modifier. Ce menu est
€également accessible sous forme de menu
contextuel lorsqu'on clique a droite sur la barre.
Si certaines commandes situées dans la barre
ne peuvent s'afficher parce que la largeur de la
fenétre ne le permet pas, un bouton >> apparait
a l'extrémité droite de la barre pour le signaler.

En cliguant dessus, vous obtenez [affichage
des commandes qui n'étaient pas visibles.

Modifier la taille des icOnes

Vous pouvez modifier la taille et le style des
icobnes présentes dans une barre par la
commande Outils > Options ... > OpenOffice >
Afficher - Taille et style des ic6nes.

Modifier I'affichage des icones

La commande Boutons visibles située dans le
menu contextuel d'une barre d'outils permet de
choisir, d'un simple clic dans sa liste de
commandes, celles qui seront affichées dans la
barre (encadrement gris) et celles qui ne le seront
pas.

La modification de la liste des commandes d'une
barre (composition, noms, icones, ordre de
succession des boutons, etc.) n'est possible qu'en la
personnalisant a l'aide de sa commande
contextuelle Personnaliser la barre d'outils ...

Personnaliser les barres
d'outils
Vous pouvez modifier la liste des commandes

d'une barre, les renommer, réorganiser leur ordre
de succession et méme changer leurs icones.

De telles modifications sont possibles par la

commande Outils > Personnaliser ... - Barres
1 -
d'outils.
Personnaliser \X|
Werus || Clavier |Barres d'outils |Evénements |
Barres d'outils OQoLight Impress
Barre d'outils  q standardbar
3  Barre doutils ~
Contenu de la barre d'outils
Commandes W £ charger 'URL [ 4 Ajouter,.,
¥ Mouveau =
N 3 Moifier -
[l Mouveau docurnent 3 partir — 5
& Ourir,.. 6
& Enregistrer 7
O E Enregistrer sous...
i;a Document par e-mail...
__________________________________
A Editer le fichier
= hd
£ I ] ¥
Enregistrer dans |OOULight Impress e ‘ 8
Description
harge un document specifie par la saisie d'un URL. Yous pouvez saisic un nouvel URL ou en
selectionner un dans |a liste, OOoLight convertit automatiquernent les chemins de fichier en
notation URL.
L O J [ Annuler ] [ Aide } [ Rétablir J
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La boite qui s'ouvre permet de :

— Créer une nouvelle barre d'outils personnalisée
pour y placer les commandes de son choix.

— Recomposer et organiser la succession des
commandes d'une barre existante.

Dans les deux cas, on peut décider d'enregistrer
les modifications uniquement avec le document
en cours ou dans le profil utilisateur.

1. Permet de choisir la barre a personnaliser.

2. Démarre la création d'une nouvelle barre. Une
boite de dialogue s'ouvre pour permettre de la
nommer et de l'enregistrer dans le module
(dans le profil utilisateur) ou seulement pour le
document actif.

3. Déroule un menu permettant de choisir la
représentation des commandes dans la barre
(Icbne, Texte, Icbne et texte). Des commandes
permettent également de renommer la barre
ou de la supprimer, mais uniqguement s'il s'agit
d'une barre personnalisée.

4. Ouvre la boite de dialogue Ajouter des
commandes, pour ajouter des commandes.

5. Déroule un menu avec des commandes
permettant de retoucher la structure de la
barre, en créant des groupes séparés, ou en
renommant ou supprimant des commandes. Il
existe également la possibilité de choisir une
autre icobne pour une commande ou de rétablir
son icbne par défaut.

6. Grace a ces deux boutons, vous pouvez
remonter ou descendre une commande dans
la liste et ainsi modifier I'ordre de succession
des icbnes dans la barre.

7. Affiche la liste des commandes de la barre en
cours de personnalisation ou de création. Les
icbnes précédées d'une coche sont celles
intégrées a la barre.

8. Choisissez ici si vos modifications doivent étre
enregistrées dans l'application en cours ou
uniguement avec le document actif.

9. Affiche une description de la commande
sélectionnée dans la zone (7)

Une fois les modifications effectuées cliquez sur
OK pour les enregistrer, Annuler pour y renoncer,
ou Rétablir pour rétablir la configuration d'origine
de la barre.

4.3. Les raccourcis-clavier

Les raccourcis clavier sont des combinaisons de
touches qui permettent de lancer des commandes
au clavier.

En cas de conflit, les raccourcis clavier du systeme
d'exploitation sont toujours prioritaires sur ceux
d'OpenOffice.

Gérer les raccourcis clavier

La commande Outils > Personnaliser ... -
Clavier ouvre une boite offrant la possibilité
d'assigner des raccourcis personnalisés a de
nombreuses fonctions standards de OpenOffice,
et méme a des styles ou a des macros.

La boite affiche la liste des raccourcis déja
affectés par défaut et permet de repérer ceux qui
sont encore “disponibles” pour d'autres
associations.

I n'est pas recommandé de réassigner des
raccourcis par défaut du programme.

Définir des raccourcis clavier

Personnaliser \5
Merus |Clavier | Barres d'outis | Evénements |
o~
Raccourcis clavier —3 © oooLight
Al { navigateur d'slement B
Ctrhedsl+Mai+i .Uno:AnimationMode 2| ©mpress
CtriAl+Maj+B
CtrhAlt+Ma+C Mocifier
Cirhealt+Mai+D
Ctrhealt+Maj+F
Cirhealt+Mai+G Digzocier
Ctrhal+Maj+H
Ctrheast+Mai+] 3|
CtrhAlt+Maj+K Fractionner B
Ctrheat+Maj+L 3|
P ) &) ——
< I | Bl Rétablir
Fonctions

Catégorie Fonction 2 Touches 4

Application PAIMlDes activer le navigateur d' Sy M-+ Alt-+Mai+S)

Modeles || [#baisser d'un niveau =]

afficher la grile b

Edition =|[| | afficher les reperes

Options Afficher les sous-paragraphes

BASIC | [Agrandir le zoom

Inzérer Aligner aux repéres

Documents Aligner sur la grile

Farmat Barre d'état

Cantréles Barre d'hwberlien &

Maviguer (1= Jlf ]

L Ok J [ Annuler ] [ Aide ] [ Rétablir ]

1. Permet de rendre le raccourci disponible dans
I'application en cours uniquement ou pour tous
les modules de la suite si on choisit
OpenOffice.

2. Utilisez les listes Catégorie et Fonction pour
accéder a la fonction a laquelle vous souhaitez
associer un raccourci clavier.
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3. Sélectionnez dans cette liste un raccourci (non
déja affecté), puis cliqguez sur le bouton
Modifier pour [laffecter a Ila fonction
sélectionnée au point précédent. Pour assigner
un raccourci déja utilisé, vous devez d'abord
cliguer sur le bouton Supprimer avant de le
réassigner a la fonction choisie au point
précédent en cliquant sur le bouton Modifier.
Cliquez sur OK pour accepter les
modifications. Le raccourci clavier exécutera
maintenant la fonction choisie a I'étape 2 ci-
dessus chaque fois qu'il sera sollicité.

4. Montre le raccourci associé a chaque fonction

sélectionnée. Si la fonction n'est associée a

aucun raccourci le contenu de cette zone est

vide.

Les raccourcis clavier apparaissant grisés dans la

liste de la boite de dialogue Personnaliser-Clavier,
tels que F1 et F10, ne peuvent pas étre réassignés.
Le bouton Rétablir situé en bas a droite de la boite
Personnaliser-Clavier permet de réinitialiser
instantanément, sans message d'avertissement,
tous les raccourcis claviers a leurs valeurs d'origine.

Utiliser un fichier de
configuration clavier

Dans la boite Outils > Personnaliser ... -Clavier, le
bouton  Enregistrer sauvegarde les
modifications de raccourcis dans un fichier de
configuration. Cette fonctionnalité est utile pour
créer différentes configurations adaptées a des
besoins spécifiques.

Pour enregistrer les raccourcis dans un fichier :

1. Une fois les raccourcis définis, cliquez sur le
bouton Enregistrer pour ouvrir la boite
Charger la configuration du clavier.

2. Dans la liste Type, sélectionnez Tous les

fichiers, puis entrez le nom du nouveau fichier

de configuration dans le champ Nom du fichier.

Cliquez sur le bouton Enregistrer.

4. Par la suite, le bouton Charger ... dans l'onglet

Clavier, vous permettra a tout moment de
remplacer votre configuration clavier active par
celle enregistrée dans I'un de vos fichiers de
configuration clavier, en le sélectionnant, puis

en cliquant sur le bouton Ouvrir.

4.4. Les commandes de base

Ce sont essentiellement les commandes de
création, d'ouverture, d'enregistrement,

w

d'impression, de fermeture, d'exportation et
d'envoi. Quelques commandes d'édition (Copier
- Couper — Coller), ainsi que la commande de
reproduction de format font également partie de
cette liste de commandes communes a tous les
modules.

Créer un nouveau document
Deux méthodes sont possibles :

— On peut créer un document vierge basé sur le
modele par défaut du programme : on obtient
alors un document vide dans I'espace de travail.

— On peut créer un document basé sur un modéle
et dans ce cas, le nouveau document créé
correspond a une copie du modele choisi, avec
déja les éléments prédéfinis qui existaient dans
le modele et qu'on peut alors personnaliser.

Un nouveau document vierge

Pour créer un nouveau document vierge, utilisez
l'une des méthodes suivantes :

— Depuis le Centre de démarrage, cliquez sur le
bouton correspondant au module a utiliser pour
créer le nouveau document.

— Si OpenOffice n'est pas déja lancé, démarrez
directement le module & utiliser depuis le menu
Démarrer de Windows. Vous obtenez un
document vide basé sur le modéle par défaut.

—Si OpenOffice est déja lancé, utilisez la
commande Fichier > Nouveau ou cliquez sur le
bouton Nouveau dans la barre d'outils
Standard. Il reste alors a choisir le type de
document a créer (texte, classeur, présentation,
dessin).

Un nouveau document basé sur un
modeéle personnalisé

Depuis linterface du programme, lancez la
commande Fichier > Nouveau > Modéles et
documents.

Cette commande ouvre la boite de dialogue
Modéles et documents, dans laquelle vous
pouvez choisir, parmi vos modeéles personnalisés,
celui qui vous semble le plus adapté au type de
document & créer.

Le document qui s'ouvre est une copie du modele
choisi. Il n'y a donc aucun risque d'altérer votre
modéele original.

Vous pouvez également créer un nouveau document
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vide ou un document basé sur I'un de vos modeles
en procédant depuis le menu contextuel du bouton
de démarrage rapide situé dans la traybar.

Modeles el documents - Documents

[A7 Facture

g

] rI),.rl rI_'u.rl
EI_I_
534

L=}

Miag documents

Ouvrir un document existant

Pour ouvrir un document existant, utilisez l'une
des procédures suivantes:

— Cliquez sur Fichier > Ouvrir ... depuis la barre
de menu ou utilisez le raccourci clavier Ctrl+0O.

— Cliquer sur le bouton Ouvrir dans la barre
d'outils Standard.

Si vous avez choisi d'utiliser la boite d'ouverture
de fichiers de OpenOffice, la boite ci-dessous
apparait.

Pour les boites d'ouverture et d'enregistrement de
fichier, vous avez le choix d'utiliser les boites de
dialogues spécifiques de OpenOffice ou d'utiliser
celles de votre systeme d'exploitation (option par
défaut).

Ce choix s'effectue dans la boite de configuration
Général de la commande Outils > Options ... -
OpenOffice.

Ouvrir |5|
. 1 2 m
Ci\Dacuments and SettingsigwiBureau E
|Titre S ‘Typa |Ta\|\e ‘Data de modffication ‘
[ ARCHIVES Dassier 03,11.2012, 10030444

[ Etiquettes et flaconnage Diossier 20.08.201%, 090 EE

3 Exemples_word Diossier 11.06.2012, 17:5353:4;
[T Exemples_\wWriter Dossier 26,11,2012, 17:35:17
[ Extensions Dossier 02,12.2012, 2004720
[ Hymnes et drapeaux Dossier 15.09.2012, 0653145
[ Opendffice.org 3.4.1 (Fr) Inst: Dossier 22.12.2012, 22:05: 4%

Norn de Fichier : “ 4 “ | L Quvrir J
b | Annuler
]

ersion ¢ ‘ g

Tvpe de fichier : ‘Tuus les Fichiers (¥.%) &

7

[ En lecture seule

1. Indique le chemin du répertoire actif dont le
contenu est affiché dans la fenétre.

2. Série de boutons permettant respectivement de
remonter d'un niveau dans l'arborescence?, de
créer un nouveau dossier dans le dossier courant
ou d'afficher le contenu du répertoire utilisateur
par défaut Mes documents.

3. La zone centrale de la boite affiche les icones
des fichiers et dossiers présents dans le dossier
sélectionné. Un double clic sur licébne d'un
dossier affiche son contenu dans la zone centrale
de la boite. Pour ouvrir un fichier double cliquer
dessus ou le sélectionner puis cliquer sur le
bouton Ouvrir. Pour en ouvrir plusieurs, les
sélectionner a la souris en combinaison avec la
touche Ctrl, puis cliquer sur Ouvrir.

Vous pouvez encore :

— Cliquer sur I'en-téte de colonne Titre pour trier
les fichiers et dossiers par ordre alphabétique
croissant ou décroissant.

— Supprimer un fichier ou le renommer depuis son
son menu contextuel.

4. Vous pouvez saisir directement dans ce champ
le nom ou le chemin du fichier a ouvrir.
L'utilisation de caractéres génériques dans un
nom de fichier est possible pour filtrer la liste
affichée. Le bouton fléché a droite du champ
permet de faire défiler le contenu des sous
répertoires et les fichiers présents dans le
répertoire courant.

5. S'il existe plusieurs versions de votre
document, elles se trouvent répertoriées dans
cette liste déroulante et vous pouvez choisir celle
gue vous souhaitez ouvrir.

Vous pouvez créer et gérer les versions du
document actif a I'aide de la commande Fichier >
Versions. Les différentes versions d'un document
sont ouvertes en lecture seule.

6. Cette liste déroulante restreint la recherche a
un type de fichier. Par exemple, si vous
choisissez des documents texte comme type de
fichier, vous ne verrez apparaitre dans la liste que
des documents que AOO Writer peut ouvrir (c'est-
a-dire des fichiers d'extensions suivantes : *. odlt,
*, doc, *. txt).

7. La case a cocher En Lecture seule ouvre le
fichier choisi pour une simple consultation, sans
possibilité de modification.

1 Un clic prolongé permet de visualiser les
répertoires situés plus haut dans la hiérarchie.
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Une fois le fichier trouvé, double cliquez dessus
ou cliquez sur le bouton Ouvrir, pour le faire
apparaitre dans I'espace de travail.

Vous pouvez également ouvrir un fichier depuis
|'explorateur de fichiers de votre OS.

La commande Fichier > Derniers documents
utilisés montre la liste des 10 derniers documents
sur lesquels vous avez travaillé en vous permettant
de rouvrir rapidement I'un d'entre eux.

Enregistrer un document

Le format de sauvegarde par défaut pour les
documents est le format ODF (OpenDocument)
qui porte I'extension .odt.

Ce format de fichier est un fichier compressé de
type zip contenant des fichiers au format xml,
accompagnés des fichiers images, sons, etc. insérés
dans le document.

Lors d'un enregistrement, 3 cas sont a envisager :

—on veut enregistrer un nouveau document qui
vient d'étre créé ;

—on a d'actualisé un document existant et on
souhaite remplacer l'ancienne version par la
nouvelle ;

- on vient d'actualiser un document mais on veut
sauvegarder la nouvelle version dans un fichier
séparé, sans écraser l'ancienne.

Enregistrer un nouveau document
Procédez de l'une des maniéres suivantes :

1. Utilisez le raccourci Ctrl+S ou la commande
Fichier > Enregistrer, puis spécifiez le nom et
le type du fichier dans la boite de dialogue qui
s'ouvre.

2. Cliquez sur le bouton Enregistrer &= dans la
barre d'outils Standard. Il ne devient actif que
si des maodifications n'ont pas encore été
sauvegardées.

3. Utilisez la commande Fichier > Enregistrer
sous, puis spécifiez le nom et le type du fichier
dans la boite de dialogue qui s'ouvre.

Dans tous les cas, la boite de dialogue Enregistrer
sous apparait pour permettre la saisie d'un nom, le
choix d'un format et d'un répertoire de destination
pour le fichier a sauvegarder.

Actualiser un document modifié

Pour actualiser un document existant qu'on vient
de modifier, les 2 premiéres méthodes vues au
point précédent peuvent étre utilisées. Elles
aboutissent toutes deux au remplacement du
dernier enregistrement du fichier par sa nouvelle
version.

Créer une nouvelle version d'un
document existant

Pour sauvegarder un document existant modifié
sans écraser sa version d'origine, utilisez la
commande Fichier > Enregistrer sous ... . Dans
la la boite Enregistrer sous, indiquez un nom de
sauvegarde, un format d'enregistrement et un
endroit de stockage pour la nouvelle version de
votre fichier.

La boite de dialogue Enregistrer sous posséde une
option d'enregistrement avec mot de passe, mais
cette fonction n'est applicable qu'aux fichiers
sauvegardés dans les formats OpenDocument ou les
anciens formats OpenOffice.org 1.x. Elle limite
I'acces au document qu'aux utilisateurs capables de
fournir le mot de passe utilisé lors de son
enregistrement.

Fermer un document

La commande Fichier > Fermer referme le
document en cours (sans pour autant fermer le
programme), avec un message d'avertissement si
certaines modifications n'ont pas encore été
enregistrées.

- B =X

Le document 'Les commandes.odt’ a &té modifié.
Souhaitez-vous enregistrer les modifications apportées ?

OpenQOffice.org 34.1
B3

[EI_EnregistrerEH Ignorer H Annuler l

— Enregistrer : le document est sauvegardé avant
d'étre referme.

— Ignorer: le document est refermé et toutes les
modifications entreprises depuis sa derniére
sauvegarde sont perdues.

— Annuler: la commande de fermeture est
annulée et on retourne au document.

La fermeture de documents peut également se
faire en cliquant sur le bouton de fermeture
marqué d'un X situé a l'extrémité droite de la
barre de titre du programme. Si plusieurs
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documents sont ouverts en méme temps, ce
bouton permet de les refermer un a un.

Lorsquiil ne reste plus qu'un seul document
ouvert, un petit bouton de fermeture X apparait a
droite de la barre des menus, sous le bouton de
fermeture du programme évoqué précédemment,
afin de permettre de refermer le dernier document
et de revenir au Centre de démarrage.

Pour quitter le programme, on peut alors, au
choix, utiliser la commande Fichier > Quitter ou
le bouton de fermeture situé a I'extrémité droite de
la barre de titre de la fenétre du programme.

Imprimer un document

OpenOffice
d'impression :

dispose de deux commandes

— Le bouton Impression rapide = situé dans la
barre d'outils Standard imprime directement le
document dans son intégralité, avec les options
d'impression par défaut.

— La commande Fichier > Imprimer ... ouvre la
boite de dialogue Imprimer qui permet de
redéfinir certaines options, mais uniqguement
pour l'impression du document actif.

* Avant de lancer une commande d'impression, il
est vivement conseillé de contrbler le document
en l'affichant en mode Apercu avant impression.

* Pour imprimer avec les options d'impression
enregistrées avec le document, il faut que
I'option Charger les paramétres de I'imprimante
avec le document soit cochée dans la commande
Outils > Options >
Chargement/Enregistrement > Général.

Boite d'impression de AOO

Cette boite affiche, par défaut, les options
d'impression telles que définies dans les
préférences du programme, mais permet de les
modifier pour le document en cours.

La boite se compose de trois parties :

1. une fenétre d'apercu avec des boutons de
navigation pour afficher les pages du
document en réduction,

2. un volet central a plusieurs onglets avec des
éléments de contrble spécifiques,

3. dans la partie inférieure, les boutons Imprimer,
Annuler et Aide.

Cette boite est assez similaire dans les modules
Writer, Impress, Calc et Draw. Aussi, nous ne la
décrirons en détails que pour le module Writer.

Les options choisies dans la boite d'impression
ne sont valables que pour le document en cours
et sont enregistrées avec lui. Elles seront de ce
fait proposées a nouveau lors de toute ouverture
ultérieure du document, tant qu'on ne les modifie
pas.

Pour définir les options d'impression par défaut qui
seront actives lors de la création de tout nouveau
document, il faut recourir a la commande
Outils > Options ... > 00.org - Imprimer

Onglet "Général"

Général | Openoffice.org writer || Mise en page | options |

Imprimante

Brother HL-1430 series

@ oeras

Plage et exemplaires
(® Toutes les pages

'

Mombre d'exemplaires

O Pages |1—8

Séleckion Aszemblar ﬁ
[ imprimer dans l'ordre inverse
Imprirner

=
52

Commentaires |F'.u-:un (docurnent seul) |

Cet onglet permet de choisir:

a

— L'imprimante a utiliser et ses options (bouton
Propriétés...). Les options  disponibles
dépendent de l'imprimante choisie, mais on
trouve systématiquement celles permettant de
définir le format du papier a utiliser, sa qualité,
et l'orientation a donner aux pages d'impression
(Portrait ou Paysage).

— Une impression partielle du document pouvant
correspondre a une sélection, ou a un certain
nombre de pages. Dans ce cas, on utilise le tiret
pour définir les séries de pages a imprimer et
des virgules ou points virgules pour séparer les
séries entre elles, par exemple: 1, 5, 11-14, 34—
40.

— Une impression en ordre inversé, c'est a dire
depuis la derniére page vers la premiére.

—La maniere avec laquelle les commentaires
seront imprimés, s'il y en a. On peut décider de
les imprimer en fin de document, a la suite du
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texte, ou sur une nouvelle page ajoutée

automatiguement a la suite de toute page
contenant des commentaires.

— Le nombre d'exemplaires a imprimer ainsi que
les options de tri. L'option Assembler conserve
I'ordre des pages du document d'origine.

Onglet "OpenOffice Writer"

Cet onglet permet de définir les contenus a
imprimer. On peut, par exemple, renoncer a
imprimer certains éléments, comme les
graphismes ou les fonds de page dans des drafts,
afin d'économiser les cartouches.

L'option Imprimer le texte en noir imprime en noir
le texte des documents en couleurs et les images
en niveaux de gris lorsqu'il s'agit de drafts ou de
documents destinés a étre photocopiés en noir et
blanc.

izénéral |OpenOffice.org Writer | Mise en page " COptions |

Cankenu

arrigre-plan de page

Images et autres objets graphiques
[ Texte masqué

[ ] substituants de kexke

Contrdles de Farmulaire

Couleur

|:| Imprimer |e texte en noir

Pages

Imprimer autormatiquemnent les pages blanches insérées

Les options proposées par cet onglet sont propres
au module utilisé. Cet onglet présente donc des
différences dans sa liste d'options en fonction du
module utilisé.

Onglet Mise en page
Cet onglet renferme les options pour :
— Imprimer plusieurs pages en réduction sur une

méme feuille d'impression, avec possibilité de
définir un ordre de placement.

— Imprimer un document sous forme de brochure.

|Généra| || Cpendffice, org Wriker |MiSE en page | Cptions |

Mise en page

(&) Pages par Feuils |1 w |

Ordre |de gauche 4 droite, puis en bas | % | 1

[ pessiner une bordure autour de chaque page

() Brochure
Cités de page

Inglure |Toutes les pages b |

Onglet "Options"

Cet onglet permet d'imprimer dans un fichier PRN
plutét que sur l'imprimante installée pour rendre
possible l'impression sur autre imprimante que
celle disponible sur le systéeme (imprimante plus
performante, par exemple).

Un fichier PRN (contraction de PRIiNt) est un fichier
d'impression, c'est-a-dire un fichier contenant les
données Dbinaires telles qu'elles doivent étre
envoyées a une imprimante.

Pour imprimer un fichier PRN, il suffit d'utiliser un
logiciel tel que Prinfile.

[Général " OpenOffice, org Wriker || Mise en page |Dptiuns |

Options

[ imprimer, dans un fichier:
[ créer des taches dimpression uniques pour les sorties assemblées
] Utiliser I bac de papisr suivant les préférences de limprimante

L'option Créer des tdches d'impression uniques
pour les sorties assemblées permet d'accélérer
I'impression de copies assemblées en envoyant le
travail d'impression en une fois a I'imprimante.

L'option Utiliser le bac de papier suivant les
préférences de I'imprimante donne la priorité aux
réglages définis dans les préférences de
I'imprimante sur ceux définis dans OpenOffice.

Imprimer une brochure

Il est possible d'imprimer un document recto verso
sous forme de livret (brochure) au format A6 avec
deux pages sur chaque face des feuilles
d'impression.

Une impression sous cette forme suppose que les
valeurs des marges et la taille des caractéres ont
été choisies de telle sorte qu'une impression en
taille réduite de moitié fournisse un document lisible
avec une mise en page équilibrée.
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Pour imprimer une brochure :

1. Depuis la boite d'impression, commencez par
vérifier les réglages de votre imprimante
(I'orientation des pages d'impression doit étre
réglée en Paysage). Pour cela, cliquez sur le
bouton Propriétés... dans l'onglet Général de
la boite.

2. Dans l'onglet Mise en page activez I'option
Brochure.

3. Si votre imprimante est capable d'imprimer en
recto verso, choisissez, dans la liste Inclure,
l'option Toutes les pages. Si ce n'est pas le
cas, procédez en deux temps. Commencez
par imprimer les pages de gauche en
choisissant cette option dans la liste Inclure,
puis replacez les pages imprimées dans le bac
de l'imprimante en les orientant correctement
de maniere a pouvoir imprimer leurs faces
recto en choisissant cette option dans la liste
déroulante Inclure.

Boite d'impression de OOoLight

Nous prendrons comme exemple, la boite
d'impression de Writer. Les boites d'impression
des autres modules sont trés similaires et vous ne
devriez pas éprouver de difficulté & comprendre
leurs options spécifiques.

Impression |.-)(
Imprimante

Nom 1 |Brother HL-1430 series v | [ propnstés... |
Etat Imprimante par défaut; Disponible

Type Brother HL-1430 series

Emplacement UsBoo1

‘Comerent sire

[l tmprimer dans un fichier 2

Zone dimpression Exemplares

@Tm;lspw_ 3 Nombre dexemplares | [ 3l 4

OPages s EN
i 213 _1]51] [+ assembler

[_gptons... ] 3 L J[ oo [ a0 ]

Cette boite permet de choisir:

1. L'imprimante a utiliser et avec quelles options
(bouton Propriétés...). Les options disponibles
dépendent de I'imprimante choisie, mais on trouve
systématiquement celles permettant de définir le
format du papier a utiliser, sa qualité, et

l'orientation a donner aux pages (Portrait ou
Paysage).

2. Permet d'opter pour une impression dans un
fichier plutét que sur une imprimante. Dans ce

cas, il faudra spécifier I'endroit de la sauvegarde.
Cette option offre la possibilité d'utiliser le fichier
Créé pour imprimer sur une autre imprimante que
celle disponible sur le systéeme (imprimante plus
performante, par exemple).

3. On peut se limiter a n'imprimer qu'une partie
sélectionnée dans le document ou seulement un
certain nombre de pages. Utilisez le tiret pour
définir les séries de pages a imprimer et des
virgules ou points virgules pour séparer les séries
entre elles; par exemple: 1, 5, 11-14, 34-40.

4. Indiquez ici le nombre d'exemplaires a imprimer
ainsi que les options de tri. L'option Assembler
conserve l'ordre des pages du document
d'origine.
5. Spécifiez ici les objets contenus dans le
document que vous souhaitez imprimer (Bouton
Options ...) ou encore le type de pages a
imprimer (pages de gauche ou de droite). Un
mode d'impression sous forme de Prospectus
(brochure) est également possible.
Options diimpression
Conten Pages Commentaires
[“] 1mages [¥] Pages de gauche = aucunie)
[¥] Tableaus [“] Pages de droite

[¥] Degsins [[] ordre inyersé
[“] Champs de contréle [ Brockure U Fin de la page

‘ Annuler |

) Commentaires seuls
 Fin du dacument P
[ s |
[4] Arrigre-plan
[T tmprimer en noir
[] Texte masqué
[ substituant de texte
Autres
[“] Imprimer automatiquement les pages blanches insérées
[ Tragaux d'impression individuels
[C1D'aprés les paramétres de lmprimante

Fay “Aucunie)s

Imprimer en noir et blanc sur une
imprimante couleur

Ce type d'impression est recommandé pour les

drafts ou les documents destinés a étre
photocopiés en noir et blanc.

Pour Imprimer un document en noir et blanc ou
en niveau de gris :

1. Lancer la commande Fichier > Imprimer ... .

2. Ouvrir la boite des propriétés de l'imprimante
utilisée en cliquant sur le bouton Propriétés....

3. Dans les options dimpression en couleurs,
choisir entre Noir et blanc et Niveaux de gris
(conseillé si le document renferme des
graphismes).
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4. Cliquez sur OK pour confirmer les choix
effectués et revenir & la boite d'impression,
puis cliqguez a nouveau sur OK pour imprimer
le document.

Imprimer sous forme de prospectus
(brochure)

Il est possible d'imprimer un document recto verso
sous forme de livret (brochure) avec deux pages
sur chaque face des feuilles d'impression,
arrangées de telle sorte qu'au final le nombre de
pages est réduit de moitié.

Pour imprimer une brochure sur une imprimante
qui ne peut imprimer recto verso:

1. Planifiez votre document de telle sorte qu'une
impression en taille réduite de moitié reste
lisible et adaptez vos valeurs de marges et de
taille de caractéres en conséquence.

2. Cliquez sur Fichier > Imprimer, puis cliquez
sur le bouton Propriétés ... dans la boite de
dialogue et vérifiez les réglages de votre
imprimante (orientation des pages
d'impression en Paysage).

3. Cliquez sur le bouton Options...dans la boite
Imprimer. Dans la rubrique Pages de la boite
des options d'impression, choisissez
Prospectus et Pages de gauche. Cliquez sur
OK deux fois pour procéder a l'impression de
la face verso de chaque page d'impression.

4. Remettre les pages imprimées dans le bac de
l'imprimante en les orientant correctement de
maniére a pouvoir imprimer les faces recto
(cela peut nécessiter quelques essais pour
trouver l'orientation correcte des pages dans le
bac de I'imprimante).

5. Relancez la commande Fichier > Imprimer et
cliguez une nouvelle fois sur le bouton
Options... pour choisir, dans la rubrique
Prospectus l'option Pages de droite. Cliquez
deux fois successivement sur le bouton OK
pour imprimer le recto de vos pages.

Si votre imprimante peut imprimer en recto verso, il
suffit de sélectionner a la fois les options Pages de
gauche, Pages de droite et Brochure pour réaliser
I'impression sous forme de brochure en une seule

opération.

Envoyer un document par Email

OpenOffice dispose de la commande Fichier >
Envoyer... pour réaliser I'envoi d'un document par
Email sous forme de fichier attaché dans I'un des
trois formats .ODT (format par défaut
d'OpenOffice), PDF, ou aux formats de MS Office.

Au lancement de la commande d'envoi, le
programme commence par convertir le fichier au
format désiré puis ouvre le programme de
messagerie par défaut et attache le document a
un nouveau message.

I ne reste alors qu'a entrer l'adresse du
destinataire, un sujet et le texte a ajouter comme
commentaire a I'envoi, puis a envoyer le courriel.

Exporter vers d'autres formats

OpenOffice utilise le terme “exportation” pour
gualifier des opérations sur les fichiers au cours
desquelles ceux-ci sont enregistrés dans d'autres
formats afin d'étre accessibles a d'autres
programmes.

C'est dans la boite de dialogue Enregistrer sous,
dans la liste Type, que vous trouverez les

différents formats d'exportation disponibles
(.doc, .html, et.).

Exporter au format PDF

OpenOffice  peut exporter ses différents

documents au format PDF (Portable Document
Format) pour les rendre accessibles en lecture
sur tout systeme disposant d’un lecteur de fichiers
PDF. Deux commandes permettent de réaliser
cette exportation :

— Le bouton [% Export direct au format PDF,
situé dans la barre d'outils Standard réalise
I'exportation directe avec les options par défaut.
Une boite d'enregistrement s'ouvre pour vous
permettre de choisir un nom et un répertoire de
sauvegarde pour votre fichier.

— La commande Fichier > Exporter au format
PDF ... ou la commande Fichier > Exporter...
ouvrent toutes deux la boite de dialogue
Options PDF, dont les 5 onglets permettent de
paramétrer le contenu et la qualité du fichier
PDF créé. Ce sont les options d'exportation
disponibles dans cette boite qui sont décrites
dans cette section. Une fois le paramétrage de
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I'exportation réalisé, il suffit de cliquer sur le
bouton Exporter, puis d’indiquer un nom et un
endroit de sauvegarde pour le fichier PDF créé.

Si vous installez I'extension pdfimport.oxt, vous
trouverez, au bas de l'onglet Général de la boite,
une option d'exportation supplémentaire, intitulée
Créer un fichier hybride. Un tel fichier s'ouvrira
normalement dans un lecteur PDF, mais il sera
éditable si vous I'ouvrez dans OpenOffice.

Onglet "Général"

Il permet de choisir les pages a inclure dans le
PDF, le type de compression des images, ainsi
que d'autres options.

Général ‘Vue initiale | Interface utilisateur |Liens |Sécurité |

Plage

© Pages

H

Sélection

Images
© Compression sans perte

Compression JPEG

Qualité 90% E
[EI Réduire la résolution des images 300 DPL EI

Général
PDF/A-1a

PDF marqué

Créer un formulaire PDF

<]

Format d'envoi FDF
Autoriser les doublons de noms de champ

Exporter les repéres de texte

Exporter les commentaires

Exporter les pages vides insérées automatiquement

[ElIncorporer les polices standards

Plage

Permet d'exporter lintégralité du document, un
certain nombre de pages, ou la sélection
courante.

Pour définir une série de pages, utiliser le format
3-6 (pages 3 a 6). Pour exporter des pages
isolées, utilisez le format 7;9;11 (pages 7, 9, et
11).

I est également possible d'exporter une
combinaison de séries de pages et de pages

individuelles en utilisant un format du type 3-
6;8;10;12, le point virgule servant de séparateur
entre les différents éléments (pages individuelles
ou groupes de pages).

Images

Les images peuvent étre exportées, sans perte de
qualité, ou au format JPEG avec différents
niveaux de qualité (un réglage a 90% donne
généralement de bons résultats).

Avec l'option Réduire la résolution des images, la
gualité sera moins bonne mais parfois suffisante.

Pour un affichage sur un écran d'ordinateur, une
résolution de 72 dpi (points par pouce) est
suffisante, mais pour une impression, il vaut mieux
utiliser la plus haute valeur de dpi possible, méme si
cela conduit a une taille de fichier plus importante.

Général

— PDF/A-1a est un standard 1SO créé en 2005
destiné a garantir une reproduction fidéle des
documents sur le long terme. Pour obtenir un tel
résultat, ce format embarque tous les éléments
nécessaires (comme les fontes utilisées dans le
document) en évitant de reprendre ceux
pouvant poser probléeme, comme certains
formats ou éléments liés a la sécurité
(encryption). Un document exporté dans ce
format restera accessible méme si la machine
qui le lit ne dispose pas des polices utilisées par
l'auteur du document.

— PDF marqué : convertit les balises spéciales
(comme les tables des matiéres, les liens
hypertexte et les contrbles), en balises PDF
correspondantes. Cela peut augmenter
considérablement la taille des fichiers.

— Créer un formulaire PDF : choisissez cette
option pour créer un formulaire PDF que vous
pourrez envoyer a vos destinataires dans l'un
des formats suivants : PDF, FDF, HTML ou
XML. Si I'option Autoriser les doublons de noms
de champ est cochée, l'utilisation d’'un méme
nom de champ pour des champs multiples dans
le fichier PDF généré est permise. Si I'option est
désactivée, les noms de champ seront exportés
en utilisant des noms générés uniques.

— Exporter les repéres de texte permet

d’exporter les marque-pages d'un document
Writer comme marque-pages PDF. Les marque-
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pages sont créés pour tous les titres de
paragraphe (Commande Outils >
Numérotation des chapitres) et pour toutes
les entrées de table des matiéres pour
lesquelles on a assigné des hyperliens dans le
document source.

— Exporter les commentaires exporte les
commentaires définis dans les documents
Writer et Calc sous forme de notes au format
PDF.

— Exporter les  pages vides  insérées
automatiquement lorsque cette option est
sélectionnée, les pages blanches du document
sont également exportées au format PDF. Cette
option est recommandée lorsqu’on imprime des
PDF en recto verso. Par exemple, les livres ont
souvent des chapitres qui commencent
systématiquement sur une page paire (page de
droite). Lorsque le chapitre précédent se
termine sur une page de droite, le programme
insére une page blanche entre les deux pages
de droite. Cette option permet d’'indiquer si la
page blanche insérée est exportée en PDF.

— Incorporer les polices standard : permet de
demander l'incorporation des polices standards
du format PDF pour améliorer la lisibilité du PDF
généré.

— Créer un fichier hybride : permet de demander
la création d'un PDF éditable dans OpenOffice.
Ce type d'option n'est disponible que si on a
installé I'extension Oracle-pdfimport.

Onglet "Vue initiale"

Général |Vue initiale |Inten‘ace utilisateur |Lien5 |Sécurité|

Volets

© Repéres de texte et page

© Miniatures et page

Ouvrir a la page

!

Agrandissement
Par défaut

© Adapter a la fenétre
© Adapter a la largeur
© Adapter au visible

© Facteur de zoom

100% :

Mise en page
® Par défaut
© Une page
© Continue

© Orientation continue

Cet onglet renferme des options qui permettent
de choisir la maniére dont le PDF s’ouvrira dans
le lecteur PDF.

Volets

— Page uniquement : génére un fichier PDF qui
affichera uniquement le contenu des pages.

— Repéres de texte et page : le fichier PDF
affichera une palette de repéres ainsi que le
contenu des pages.

— Miniatures et page : cette option génére un
fichier PDF qui montrera une palette de
miniatures ainsi que le contenu des pages.

— Ouvrir a la page : indiquer le numéro de la page
a laquelle on accédera automatiquement a
I'ouverture du fichier dans le lecteur.

Agrandissement

— Par défaut : génére un fichier PDF qui affichera
le contenu des pages sans zoom. Si le logiciel
de lecture utilise un facteur de zoom par défaut,
la page s’affiche avec ce facteur.

— Adapter a la fenétre : génere un fichier PDF qui
s’affichera avec un facteur de zoom adapté a la
fenétre de lecture.
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— Adapter a la largeur : génére un fichier PDF qui
s'affichera avec un facteur de zoom adapté a la
largeur de la fenétre de lecture.

— Adapter au visible : le texte et les images de la
page s’afficheront avec un facteur de zoom
correspondant a la largeur de la fenétre de
lecture.

- Facteur de zoom sélectionnez un facteur
d’agrandissement a appliquer lors de I'ouverture
du fichier PDF dans le lecteur.

Mise en page

— Par défaut : le fichier PDF s’affichera selon les
paramétres de mise en page du logiciel de
lecture.

— Une page :
fois.

— Continue : le PDF affichera toutes ses pages de
facon continue sur une seule colonne.

— Orientation continue : le PDF affichera toutes
ses pages de fagon continue sur deux colonnes.
Si le document contient plus de deux pages, la
premiére page s'affiche a droite.

le PDF s'affichera une page a la

Onglet "Interface utilisateur"

Cet onglet permet de choisir des options qui
détermineront comment le lecteur PDF affichera
le fichier. Certains de ces choix sont utiles pour
créer un PDF destiné a étre utilisé comme
présentation.

Options de fenétre

- Redimensionner la fenétre selon la page
initiale : la fenétre du lecteur se redimensionne
pour s’'adapter aux dimensions de la premiéere
page du PDF.

— Centrer la fenétre sur I'écran : centre la fenétre
du lecteur sur I'écran du computer.

— Ouvrir en mode plein écran : fenétre en plein
écran.

— Afficher le titre du document le titre du
document s’affiche dans la barre de titre du
lecteur.

Interfaoe utilisateur |Liens |Sécurité

Options de fenétre

[EIRedimensionner Ia fenétre selon [a page initiale:

Centrer la fenétre sur I'écran
Ouvrir en mode plein écran

Afficher le titre du document

Options d'interface utilisateur

Masquer la barre de menu
Masquer la barre d'outils

Masqguer les contréles de la fenétre

Transitions

[7] Utiliser les effets de transition

Repéres de texte

Tous les niveaux de repéres de texte

© Niveaux de repéres de texte visibles

Options d’interface utilisateur
— Masquer la barre de menu : masque la barre de
menu du lecteur.

— Masquer la barre d'outils
d’outils du lecteur.

— Masquer les contréles de la fenétre : le lecteur
n'affiche pas les outils de contr6le de la fenétre.

masque la barre

Repeéres de texte

— Tous les niveaux de repéres de texte : tous les
niveaux de titre sont affichés comme repeéres de
texte, si l'option Exporter les repéres de texte
est sélectionnée dans l'onglet Général.

- Niveaux de repéres de texte visibles
sélectionnez le nombre de niveaux de titre a
afficher comme repéeres de texte, si l'option
Exporter les repéres de texte est sélectionnée
dans l'onglet Général.

Onglet "Liens"

‘Général |Vue initialel Interface utilisateur |Liens |Sécurité|

[T Exporter les repéres de texte comme destinations nommées:

Convertir les références de document en cibles PDF

Exporter les URL relatifs au systéme de fichiers

Liens entre documents
@ Mode par défaut

@ Quvrir avec un lecteur de PDF

@ Quvrir avec un navigateur Internet
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Cet onglet permet de définir comment les liens
présents dans le document seront exportés au
format PDF.

— Exporter les repéres de texte (signets) comme
destinations nommées : si des liens ont été
créés dans le document texte, cette option
permet de les exporter comme “noms de
destinations” vers lesquelles des pages Web ou
des documents PDF peuvent pointer.

— Convertir les références de document en cibles
PDF : si vous avez défini des liens vers d’autres
documents aux formats OpenDocument
(extensions telles que .ODT, .ODS, and .ODP)
cette option convertit les noms de fichiers en
.PDF dans le document PDF exporté (les
extensions .odt, .odp, .odg et .odm sont
converties en extensions .pdf).

— Exporter les URLs relatives au systéme de
fichiers : si des liens relatifs se trouvent dans un
document, cette option permet leur exportation
au format PDF.

— Liens entre documents : vous pouvez régler ici
le comportement des liens PDF pointant vers
d’autres  fichiers. Choisissez l'une des
alternatives suivantes :

* Mode par défaut : les liens PDF sont
utilisés comme spécifié dans le systéeme
d'exploitation.

e Ouvrir avec un lecteur de PDF : permet
d'utiliser le lecteur PDF pour afficher le
document PDF et les autres PDF liés.

e Ouvrir avec un navigateur Internet
demande d'utiliser le navigateur par défaut
pour afficher les documents PDF liés.

Onglet "Sécurité"

La fonction d'exportation au format PDF
comprend des options permettant d’encrypter le
PDF créé, de maniere a assurer sa protection par
un mot de passe et appliquer certains droits
digitaux (DRM).

— Avec un mot de passe d’ouverture : I'ouverture
du fichier nécessite un mot de passe. Par
contre, une fois le fichier ouvert, il n’y a plus
aucune restriction quant a l'utilisation de son
contenu.

— Avec un mot de passe d'autorisation : le PDF
peut étre ouvert par tout le monde, mais on peut
restreindre I'utilisation de son contenu. Lorsque

vous définissez un mot de passe d’autorisation,
un certain nombre d’'options de 'onglet Sécurité
deviennent accessibles.

Général |Vue initiale | Interface utilisateur ||Jens Sécurité

Cryptage et permission du fichier

Pas de mot de passe d'ouverture défini
Le document PDF ne sera pas chiffré

Pas de mot de passe d'autorisation défini
Le document PDF n'aura pas de restrictions

Impression
@ Non autorisée
© Faible résolution (150 dpi)

@ Haute résolution

Modifications
© Non autorisées
© Insertion, suppression et rotation de pages

@ Remplissage de champs de formulaire

- Insertion de commentaires, remplissage de champs de
~ formulaire

@ Tout sauf extraire les pages
Autoriser la copie de contenu

Autoriser I'acces au texte des outils d'accessibilité

Couper - Copier - Coller

Ces commandes d'édition se retrouvent dans tous
les logiciels et permettent de déplacer ou de
dupliquer des éléments, que ce soient des
sélections de texte ou des objets, a l'intérieur d'un
méme document, ou entre des documents
différents.

Il est possible d'utiliser les commandes de la
barre d'outils Standard ci-dessous ou les
commandes Couper (Ctrl+X), Copier (Ctrl+C),
Coller (Ctrl+V) du menu Edition pour réaliser ces
opérations sur n'importe quel type d'élément d'un
document une fois qu'on I'a sélectionné.

o Bz B -

Le bouton Coller est suivi d'un bouton figurant
une pointe de fleche orientée vers le bas
déroulant un menu contextuel, avec des options
de collage qui dépendent de I'objet a coller et du
module dans lequel le collage spécial doit
s'effectuer.
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La fonction Couper - Coller

a

Elle consiste & supprimer un élément d'un
emplacement pour le coller ailleurs. Elle
correspond donc a un déplacement d'élément
d'un endroit a un autre dans un méme document
ou d'un document vers un autre.

La procédure est la suivante :

1. On coupe I'élément a déplacer. Celui-ci se
retrouve dans le presse-papiers de Windows.

2. On se positionne a l'endroit de destination.

3. On colle le contenu du presse-papiers (c'est a
dire I'élément coupé au cours de la premiére
étape).

La fonction Copier - Coller

Elle permet de dupliquer un élément situé a un
emplacement, en le copiant dabord dans le
presse-papiers, avant de le coller a I'endroit de
destination, situé dans le méme document ou
dans un autre.

Défaire et Refaire

Ces commandes sont présentes dans la le menu
Edition et la barre d'outils Standard de tous les
modules. Elles permettent, respectivement
d'annuler les dernieres actions réalisées ou de
restaurer celles que I'on a annulées.

Dans la barre d'outils Standard, ces commandes
sont suivies d'un bouton figurant une pointe de
fleche orientée vers le bas qui déroule la liste des
derniéres actions pouvant étre annulées ou
refaites.

B-@-

Le nombre maximum d'entrées figurant dans ces
listes est une configuration générale de
OpenOffice située dans l'onglet Mémoire vive de
la boite de configuration.

Appliquer le format

Cette commande se trouve sous forme de bouton

@ dans la barre d'outils Standard de tous les
modules.

Elle permet de recopier la mise en forme d'un
élément sélectionné a un ou plusieurs autres
éléments du méme type. Son fonctionnement est
le suivant :

1. Commencez par sélectionner I'élément dont
vous voulez recopier la mise en forme.

2. Cliquez une seule fois sur licone du pinceau,
dans la barre d'outils Standard, pour appliquer
les propriétés de ['élément sélectionné au
départ a un autre élément au moment méme
ou vous le sélectionnez.

3. Double cliquez sur le pinceau pour appliquer le
format de la sélection courante a d'autres
éléments, en les sélectionnant
successivement, et ce, aussi longtemps que
vous ne désactivez pas l'outil en cliguant une
nouvelle fois sur son icone.

Vous pouvez également utiliser la touche Escape au

clavier pour désactiver la fonction de recopie de
format.
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Regles de typographie
francaise

Un certain nombre conventions typographiques
doivent étre respectées lors de la saisie de texte
en francais. Elles sont décrites succinctement
dans le chapitre Clavier et souris de ce manuel.

Saisir le texte "au kilometre"

Le texte doit étre saisi "au kilométre", le
programme gérant lui-méme les ruptures de
lignes a I'approche de la marge droite de la page,
de la limite droite d'une boite de texte, d'une
cellule de tableau ou d'une forme.

Saisir du texte dans une forme

Dans une forme dessinée a l'aide de la barre d'outils
Dessin, en mode édition apres un double clic, le
texte déborde et les lignes doivent étre coupées
manuellement pour le disposer sur plusieurs lignes
a l'intérieur de la forme.

Pour obtenir un retour a la ligne automatique a
I'approche de la limite droite de la forme, utilisez la
commande contextuelle Texte ... puis, dans l'onglet
Texte de la boite qui s'ouvre, activer I'option Ajuster
au contour.

ellement

Saisir du texte dans une feuille de calcul

Dans une cellule de feuille de calcul, le texte s'étend
sur une seule ligne et déborde sur les cellules
situées sur sa droite tant qu'elles sont vides.

Pour obtenir des ruptures de lignes automatiques, il
faut formater la cellule avec l'option Renvoi a la
ligne automatique dans la commande Format >
Cellule ... > Alignement.

La saisie de plusieurs paragraphes de texte a
I'intérieur d'une cellule de FC n'est pas possible. Par
contre, cela est possible a l'intérieur d'une cellule
d'un tableau Writer.

Structurer le texte en
paragraphes

Pour marquer la fin d’'un paragraphe et le début
du suivant, appuyez simplement sur la touche
Enter de votre clavier. Lors de la saisie de texte,
cette touche ne doit étre utilisée que pour
introduire un nouveau paragraphe et jamais pour
réaliser une simple rupture de ligne.

Si vous souhaitez effectuer un saut de ligne a
I'intérieur d'un paragraphe, sans en créer un
nouveau, appuyez simplement sur la combinaison
de touches Shift+Enter.

Le texte saisi de la sorte se présente comme une
suite de paragraphes qu'on peut scinder ou
regrouper.

— Pour regrouper deux paragraphes, effacer
simplement la marque de fin du premier, comme
un caracteére ordinaire.

— Pour scinder un paragraphe, placer le point
d'insertion a l'endroit souhaité puis appuyer sur
Enter pour insérer a cet endroit une marque de
fin de paragraphe et réaliser la scission du
paragraphe en deux.

Controéler la rupture des lignes

Par défaut, OpenOffice gere les ruptures de
lignes comme suit :

— Au cours de la saisie d'une ligne de texte,
lorsqu'on approche de la marge droite, le
programme choisit de faire un saut de ligne
entre deux mots, a l'endroit ou se trouve
I'espace qui les sépare.

— Si un mot est trop long pour tenir en entier sur la
ligne, le programme le renvoie complétement
sur la ligne suivante, sans le couper, en
provoquant automatiqguement un saut de ligne
avant lui. Dans un texte renfermant des mots
longs, ce comportement répété peut créer des
espaces vides inesthétiques a la droite du texte.

— Si un mot composé renferme un trait d’'union
(tiret), le programme choisit de le couper a cet
endroit s'il ne peut le placer en entier sur la
ligne.

Espaces insécables

Pour éviter toute coupure de ligne au niveau de
I'espace entre deux mots, il faut que celui-ci soit
insécable, ce qui s'obtient par la commande :

Insertion > Marque de formatage > Espace
insécable (Ctrl+Shift+Espace).

En francais, des espaces insécables doivent étre
utilisés dans les cas suivants :

— avant les caractéres de ponctuation : ? ! : ; ;
(ces espaces insécables sont gérés de maniére
automatique et vous pouvez donc, dans ces cas
vous contenter de taper un espace normal).
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— lorsque l'espace est utilisée comme séparateur
de milliers dans les nombres : 2 525 000 ;

—entre un nombre et le symbole d'unité:
2 500 CHF;

—entre linitiale, le prénom et le nom
P. DURAND ;

— entre le titre et le nom ;: Madame Fragniéres ;

— entre les éléments d'une date.

Tirets conditionnels

Pour éviter le rejet sur la ligne suivante d'un mot
long, [l'utilisateur peut y insérer des tirets
conditionnels pour indiquer au programme des
points de coupures possibles lorsque le mot arrive
en fin de ligne.

De tels tirets sont saisis au cours méme de la
frappe par la commande :

Insertion > Marque de formatage > Tiret
conditionnel (Ctri+-)

Les tirets conditionnels ne sont jamais imprimés,
sauf si  une coupure de ligne intervient
effectivement a I'endroit ou ils se trouvent.

Les espaces insécables et les tirets conditionnels ne
sont visibles que dans Writer et seulement si on a
configuré leur affichage dans la section Aides au
formatage de la boite de configuration de Writer.

Tirets insécables

Pour éviter toute rupture de ligne au niveau des
tirets dans les mots composés, comme
mille-feuilles ou Villars-sur-Glane, on saisit ces
tirets comme insécables par la commande :

Insertion > Marque de formatage > Tiret
insécable (Ctrl+Shift+-).

On agirait de méme pour écrire 254-132 en évitant
une rupture de ligne au niveau de l'opérateur de
soustraction.

Les caracteres spéciaux

Lors de la saisie de texte, on est parfois amené a
insérer des caractéres spéciaux qui ne sont pas
directement accessibles au clavier, comme par
exemple, ©% e ¢fid @ C, etc...

On dispose de deux possibilités pour le faire :

— La boite des caracteres spéciaux.

— Les caractéres étendus du clavier (voir a ce
sujet le chapitre Clavier et souris).

La boite des caractéres spéciaux s'ouvre au
lancement de la commande Insertion >
Caractéres spéciaux Elle affiche tous les
caracteres spéciaux existant pour la police choisie
dans la liste déroulante Police, qui correspond, a
'ouverture de la boite, a la police utilisée dans le
document.

Caractéres spéciaux

Police Time:s Newe Roman || Sous-ensamble  |Latin ds base v oK
| [ #s|nla o=+, R
0123455789.:«=>?—'
a@alale|c|pl|e|F|alu|1|1|r|L[M[rw]o
PlQ|R|s|T|U|(Vv|W|X|Y|Z|[]|v]|1]|"]_ [iw|
"lalblec|d]le|flg|h]1|i]|k|]l|m|n]|e
plalr|s|t|u|v|wla|lv|z|(|]])]~
ilelelals] i s] Jel=]«][-]-T&]"]°

sl fpl9]- ‘D}J%Vz%ﬂ)‘ll T
Coractéres :

Pour sélectionner un caractere, cliquez dessus,
puis cliquez sur le bouton OK pour l'insérer dans
le document et refermer la boite.

Si vous ne trouvez pas le caractere recherché dans
la police de votre document, essayez de le trouver
dans une autre police.

Majuscules accentuées

On dispose de 4 méthodes pour obtenir les
majuscules accentuées :

— Les insérer depuis la boite des Caractéres
Sspéciaux.

— Les taper en minuscules, puis les sélectionner
et leur appliquer la commande de changement
de casse Format > Modifier la casse >
bASCULER LA CASSE.

— Les définir comme corrections automatiques.

— Utiliser les caractéres étendus du clavier.

Le recours aux caracteres étendus du clavier est

la méthode la plus simple. Il suffit de :

1. Maintenir la touche Alt enfoncée.

2. Taper, sur le clavier numérique, le code
correspondant au caractére souhaité.

3. Relacher la touche Alt. La majuscule
accentuée apparait au point d'insertion dans le
texte.

Le code numérique doit étre obligatoirement tapé a
partir du clavier numérique et celui-ci doit étre
activé (touche NumLock).
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Ci-dessous un tableau avec les codes pour
I'insertion des majuscules accentuées.

Majuscule accentuée Raccourci
A ALT+182
A ALT+183
E ALT+144
E ALT+210
E ALT+212
0 ALT+226

5.2. La correction automatique

OpenOffice intégre une fonctionnalité qui permet
de corriger, au moment méme de leur saisie, des
mots mal orthographiés ou de remplacer des
abréviations par leur expression compléte.

Le remplacement s’effectue dés qu’on appuie sur
la barre d’espacement a la fin de la saisie du mot
ou de l'expression. Il est possible dannuler
immédiatement toute correction automatique qui
ne convient pas a 'aide du raccourci Ctrl+Z.

Dans Writer uniquement, on peut renoncer a
|'application des options d'autocorrection en
décochant la commande Format >
AutoCorrection > Pendant la frappe.

Intérét de cette fonctionnalitée

Cette fonctionnalité facilite I'écriture de termes
techniques compliqués, en permettant leur saisie
sous forme abrégée, le remplacement par le
terme complet s’effectuant lorsqu’on appuie sur la
barre d’espacement.

Il faut étre prudent dans le choix des abréviations
utilisées et bien s'assurer qu’elles ne constituent
pas des mots du langage ou des unités du systéme
métrique, par exemple.

On peut également recourir a cette fonctionnalité
pour insérer des majuscules accentuées ou des
caractéres spéciaux fréquemment utilisés. Par
exemple, on peut remplacer (c) par ©, aa par A,
etc.

Créer une correction
automatique

Lancer la commande Outils >
d'AutoCorrection ... - Remplacer.

La boite AutoCorrection s'ouvre, comme montré
ci-dessous.

Options

AutoCorrection

Remplacements et exceptions pour la langue Francais (Suisse)

Remplacer |Exceptions Options | Options linguistiques Inserkion aukornatiqus

Remplacer Par : Texte seulement

|cqfd | |ce qu'il Fallait démontrer |

3emplace
L'onglet Remplacer affiche la liste compléete de

tous les mots ou abréviations automatiquement
remplacés.

Pour créer une nouvelle entrée dans la liste :

e gquliil Fallait démontrer

— Saisissez le mot ou l'abréviation a remplacer
dans le champ Remplacer.

— Saisissez le mot ou [I'expression de
remplacement dans le champ Par.

— Cliquez sur le bouton Remplacer pour ajouter
votre nouvelle correction a la liste.

— Validez la création de votre nouvelle correction
par OK (ne pas oublier, faute de quoi votre
nouvelle correction n'est pas enregistrée).

Si un mot ou expression se trouvait sélectionné dans
votre texte avant le lancement de la commande, il
apparaitra automatiquement dans le champ Par.
C'est le seul moyen pour obtenir un texte de
remplacement formaté. Par contre, si I'option Texte
seulement est cochée, alors le texte de
remplacement contenu dans le champ Par sera
inséré sans son formatage d’origine et adoptera
celui du texte dans lequel il est inséré.

Supprimer une correction
automatique

Pour retirer une entrée de la liste, la sélectionner
puis appuyer sur le bouton Supprimer.
Exercice

Vous pouvez utiliser le tableau ci-dessous pour
définir des corrections automatiques pour les
principales majuscules accentuées.
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Femplacer Far Remplacer Far
a4 A 66 O
a8 A Y E
éé E i) U
ol C 48 A

Définir des options fixes

L'outii de correction automatique dispose
également d’options fixes, comme la suppression
ou non de la deuxiéeme majuscule d'un mot, la
mise en majuscule systématique de la premiére
lettre d'un paragraphe, le choix du type de
guillemets a utiliser, etc...

Ces options sont a activer/désactiver dans la
boite ouverte par la commande Outils > Options
d'AutoCorrection ... - Options

On peut choisir de les activer/désactiver dans
deux listes :

— liste [S] : concerne les reégles a appliquer lors de
la saisie ;

- liste [R] : concerne les régles a appliquer lors de
la relecture.

Les exceptions

L'application de certaines des options fixes
définies dans 'onglet Options peut étre modulée
par deux listes d’exceptions définies dans l'onglet
Exceptions.

Cette boite permet de spécifier dans deux listes :

— Les abréviations suivies d'un point dont la
premiére lettre du mot qui suit ne doit pas étre
mise en majuscule.

— Les mots ou abréviations qui commencent par
deux lettres majuscules et qu'on ne souhaite
pas pas voir modifiés par le programme en une
seule lettre majuscule. Par exemple, vous
devrez saisir PC dans la liste d'exceptions pour
empécher OpenOffice de modifier PC en Pc.

Une fois les exceptions créées, cliguez sur le
bouton OK pour les valider et refermer la boite de
dialogue.

Les guillemets

L'onglet Options linguistiques permet de décider
si les guillemets simples et doubles définis par

défaut doivent étre remplacés par des guillemets
typographiques ou pas. En cochant les options
Remplacer, ils le seront. Dans le cas contraire, ce
sont les guillemets choisis par défaut qui seront
appliqués.

5.3. Principales fonctions
d'édition

Les principales fonctions d'édition de texte

appartiennent toutes au menu Edition, mais sont

€galement reprises comme boutons dans la barre
d'outils Standard.

Effacer du texte

Pour supprimer un passage de texte, le
sélectionner puis appuyer sur la touche Delete au
clavier.

Pour supprimer des caractéres au clavier, utiliser
la touche Delete pour effacer le caractére situé a
droite du point d'insertion et sur la touche
Backspace pour effacer celui placé a gauche du
point d'insertion. Répéter I'opération pour effacer
plusieurs caracteres.

Pour supprimer rapidement plusieurs caracteres,
maintenir enfoncée la touche Delete ou la touche
Backspace.

Annuler des actions

Si vous avez effectué une action non désirée
(commande d'édition ou de mise en forme), vous
pouvez toujours l'annuler par la commande
Edition > Annuler (Ctrl+Z) ou le bouton Défaire
dans la barre d'outils Standard.

Vous pouvez rétablir une action annulée par la
commande Edition > Rétablir (Ctrl+Y) ou le
bouton Rétablir dans la barre d'outils Standard.

Copier ou déplacer du texte

La copie et le déplacement de texte sont des
opérations courantes lors de ['édition ou la
révision d'un document. Elles peuvent étre
réalisées a lintérieur d'un méme document ou
entre des documents ouverts.

— Déplacer un passage de texte consiste a le
supprimer de I'endroit ou il se trouve pour le
placer ailleurs dans le document, précisément a
I'endroit ou se trouve le point d'insertion.
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— Recopier un passage de texte consiste a en
insérer un duplicata au point d'insertion, sans
supprimer le texte d'origine.

OpenOffice dispose de deux méthodes pour
réaliser de telles opérations :

—une méthode utilisant le presse-papiers de
Windows ;

—une autre méthode par Cliquer-glisser a l'aide
de la souris.

A l'aide du presse-papiers de Windows

Cette méthode est particulierement recommandée
lorsque l'endroit de destination de Ia
copie/déplacement se trouve éloigné de I'endroit
d'origine.

La méthode consiste a sélectionner I'objet a
déplacer, puis a le découper de I'endroit ou il se
trouve par la commande Edition > Couper
(Ctrl+X) ou simplement le copier par la
commande Edition > Copier (Ctrl+C) pour le
coller & un autre endroit du méme document ou
d'un autre document ouvert par Edition > Coller
(Ctrl+V).

Le presse-papiers de Windows est un outil de
stockage temporaire permettant la conservation de
données destinées a étre transférées d'un endroit a
un autre, a l'intérieur d'un méme document ou entre
deux documents différents, méme s'ils sont générés
par des applications différentes.

A l'aide de la souris

Cette méthode s'avere trés utile lorsqu'on
souhaite conserver un moment intact le contenu
du presse-papiers en évitant de I'écraser au cours
d'opérations de copies ou de déplacements, ou
dans tous les cas ou la copie ou le déplacement
se font a proximité de I'endroit d'origine.

Le Glisser-déposer direct a l'intérieur d'un méme
document aboutit & un déplacement, a moins que
l'opération ne soit réalisée en maintenant la
touche Ctrl enfoncée. Dans ce dernier cas, le
pointeur affiche un signe + signifiant que le
résultat de l'opération sera une copie et non un
déplacement. Une fois I'opération terminée,
relacher d'abord la touche Ctrl, ensuite le bouton
de la souris.

5.4. Propriétés des caracteres

Les propriétés (attributs) de caractéres sont
appliqués a l'ensemble des caractéres
sélectionnés, ou a partir du point d'insertion, pour
les futurs caracteres entrés au clavier (s'il s'agit
de saisir un bloc de caracteres formatés a la
frappe).

On désigne sous le terme de propriétés ou
d'attributs de caracteres tout ce qui peut modifier
leur apparence : police, taille, style, couleur,
ombrage, soulignement, etc.

En ce qui concerne la taille des caractéres,
signalons qu'un caractére peut étre petit, moyen ou
grand. La taille d'un caractére (c'est a dire sa
hauteur) s'exprime en points typographiques, un
point typographique représentant 1/72 de pouce, soit
environ 0.35 mm. La taille usuelle est de 12 points.

Voici quelques attributs qui peuvent étre
appligués aux caracteres d'une sélection de texte.

Un passage de texte peut étre mis en gras,
italique, souligné, baré, et ses caractéres
peuvent étre mis en La taille des

caractéres peut étre agrandie ou réduite. Il est
encore possible de mettre du texte en ou en

indice
exposant d'ombrer ses caractéeres,
daugmenter ou de réduire leur
espacement. On peut également modifier la
casse de la sélection et mettre, par exemple, tous
ses caracteres en MAJUSCULES. Une couleur
d'arriere-plan peut étre appliguée pour donner

I'apparence de texte surligné.

Pour annuler une mise en forme manuelle,
sélectionner le texte puis lancer la commande
contextuelle Formatage par défaut, la commande
de menu Edition > Annuler ou utiliser le raccourci
clavier Ctrl + Z.

Ou trouver les commandes ?

Les options de mises en forme des caractéres
sont accessibles :

— partiellement dans les listes et boutons présents
dans la barre d'outils Formatage ;

—dans le menu contextuel d'une sélection de
texte ;

—intégralement dans la boite de dialogue
Caractére (commande Format > Caracteére...)
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La commande Format > Modifier la casse fournit
une série de commandes permettant de convertir
des caractéres tapés en minuscules en
caracteres majuscules et réciproquement. On
commence par sélectionner le texte a modifier,
puis on lance la commande en choisissant dans
son sous-menu la modification a effectuer.

En informatique, la casse désigne le fait de
distinguer les lettres majuscules des lettres
minuscules.

La boite de dialogue Caractere

Son utilisation est assez intuitive et nous ne
décrirons que ses fonctionnalités qui sont
communes a tous les modules. Ainsi, les onglets
Hyperlien et Arriere-plan, uniquement disponibles
sous Writer, ne seront pas abordés ici.

Onglet "Police"
Police | Effets de caractéres | Position

Police Style Taille
10

- 7 -
Arial Black g [talique 3 E
Arimo Gras 9
Batang Gras Italique

BatangChe 10.5
Browallia New 11
BrowalliaUPC - 12 -

Langue

"% Frangais (Suisse) E|

Permet de choisir une police, un style et une taille
de caractere.

Onglet "Effets de caractéeres"

Police |Effets de caractéres ‘Position ‘

Couleur de police Surlignage
|| Automatique ZH |(Sans)
Barré

(Sans) D

Relief Soulignage
(Sans) B| |(Sans)

Couleur de surlignage

E‘ “:| Automatique E|

Couleur de soulignage

B‘ “:l Automatique E|

Contour [ Mot par mot

Ombre

Les options présentes dans cet onglet concernent
essentiellement la couleur de police, la casse
(majuscules, minuscules, etc.) le type de mise en
relief, I'application d'un contour, d'une ombre, le
soulignement, le surlignage etc.

Onglet "Position"

On trouve dans cet onglet toutes les options qui
permettent de définir la position des caractéres
sur la ligne d'écriture (exposant, indice), ainsi que
leur espacement (standard, étendu ou condensé).
Une option de Crénage est également disponible.

La ligne d'écriture (ou ligne de base) est une ligne
horizontale imaginaire située directement sous une
ligne de texte.

‘Police | Effets de caractéres |Positicm |

Paosition

© Exposant

[¥] Automatique
@ Normal Taille de police relative  [100%

© Indice

Elever/gbaisser de

Echelle

Echelle de largeur 100% El
Espacement
‘Par défaut B‘ de ‘0,0,31 = Paire de crénage

— Exposant/indice : saisir ici le pourcentage dont
on veut élever ou abaisser le texte sélectionné
par rapport a la ligne d'écriture. La taille de la
police utilisée correspond a la valeur 100%.

- Taille de police relative : saisir ici le pourcentage
de réduction de la taille de police pour le texte
mis en indice ou exposant.

— Automatique définit automatiquement une
valeur d'élévation ou d'abaissement du texte en
exposant ou indice par rapport a la ligne de
base.

— Echelle de largeur : permet d'appliquer un taux
de compression ou d'étirement du texte en
largeur.

— Espacement : permet de choisir I'espacement a
ménager entre les caracteres. Celui-ci peut étre
normal, condensé ou étendu d'une certaine
valeur en pt entrée dans la zone de. L'activation
de l'option Paire de crénage permet, lorsque la
taille des caracteres est grande (> 18 points), de
réduire automatiquement l'espace entre certains
caracteres. En effet, malgré I'espacement
proportionnel de la plupart des polices, certains
caractéres, comme le "a" et le"W" ou encore le
"T" et le "e", lorsque leur taille est grande,
peuvent apparaitre trop éloignés l'un de l'autre
lorsqu'ils sont céte a céte. Pour que l'espace qui
les sépare semble identique aux autres, il faut
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les resserrer un peu, et c’est ce que fait cette
fonction de Crénage.

5.5. Propriétés des

paragraphes

Un paragraphe est une zone rectangulaire de la
page qui se termine par une marque de fin de
paragraphe (symbole ). Un paragraphe contient
du texte, mais il peut également étre vide si son
contenu se limite au seul caractére de fin de
paragraphe généré par la frappe sur la touche
Enter.

Dans un document Writer, un paragraphe peut
également contenir une image ou un dessin.

Chaque paragraphe est doté de propriétés
(attributs) qui régissent :

—son positionnement par rapport aux marges
latérales de la page ou aux limites latérales de
I'objet qui le contient (retraits),

—I'écart qui le sépare du paragraphe qui le
précéde ou le suit (espacements),

—la maniére dont son contenu s'y dispose
(alignement et interligne).

Les regles généralement admises pour les
paragraphes de texte sont les suivantes :

— Espacement entre les paragraphes : valeur
correspondant a un double interligne. On utilise
le simple interligne dans les sommaires des
chapitres, dans les citations en retrait, les notes
de bas de page, la bibliographie ainsi que dans
l'index.

- Premiere ligne de chaque paragraphe
alignement avec le corps du paragraphe ou en
retrait de 1.2 cm.

La mise en forme appliquée a un paragraphe est
mémorisée dans la marque générée par la frappe
sur la touche Enter qui marque la fin du
paragraphe et le début du suivant.

Le nouveau paragraphe hérite, par défaut des
mises en formes appliquées au paragraphe qui le
précéde. Si ce n'est pas ce que vous voulez,
appelez immédiatement le menu contextuel de
votre nouveau paragraphe pour y choisir la
commande Formatage par défaut avant de saisir
les premiers caracteres de son texte.

Pour sélectionner un paragraphe a formater, il suffit
généralement d'y placer le point d'insertion, mais on
peut aussi le sélectionner complétement a la souris.
Dans Writer, le jeu de propriétés affecté a un
paragraphe peut étre enregistré dans un style qui
peut s'utiliser pour formater d'autres paragraphes
du méme type dans le document. Cette fagon de
faire évite les erreurs et garantit une homogénéité
dans la mise en forme.

Les propriétés de paragraphe sont accessibles a
plusieurs endroits .

— Barre d'outils Formatage (dans Writer et Calc)

— Barre d'outils contextuelle Formatage de texte,
apparaissant dans Calc, Impress et Draw
lorsgu'un objet de texte est sélectionné.

— Boite de dialogue Paragraphe ouverte par la

commande de menu Format > Paragraphe ou
la commande contextuelle Paragraphe ...

Dans Writer il est possible de recourir a la Régle
horizontale pour réaliser des retraits de paragraphes
et poser des tabulations.

Barre Formatage (de texte)

Les attributs de paragraphe les plus courants
peuvent étre directement appliqués depuis la
barre d'outils Formatage de Writer ou la barre
d'outils contextuelle Formatage de texte (Calc,
Impress, Draw). La figure ci-dessous montre les

principales commandes de formatage de
paragraphe retrouvées sur ces barres.
T OoTextBody v E§’I§|_-';_ a laEE R
1 2 3456 7 89 1011121314
q|Accés & la boite Styles et 5 Aligné & droite 10 Numérotation On/Off
formatage (Styliste) 6 Justifié 11 Puces OnfOff

2 Appliquer ke stie (styles T Interligne: 1 12 Reéduira le retrait
de paragraphes
uniguament)
3 Aligner a gauche 8 Interligne: 1.5 13 Augmenter le retrait
4 Centré g Interligne: 2 14 Boite Paragraphe

Les quatre boutons | | permettent
de gérer l'alignement du texte entre les bords
latéraux du paragraphe : a gauche, a droite, au
centre, ou justifié.

Les boutons interrupteurs (Dés)activer la
I=
o=

numeérotation et (Dés)activer les puces
permettent de présenter une suite de
paragraphes sous forme de liste numérotée ou a

puces. Pour créer une liste a l'aide de ces
boutons, procédez comme suit :
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— Sélectionnez les paragraphes a inclure dans la
liste.

—Cliguez sur le bouton (Dés)activer la
numérotation ou (Dés)activer les puces. Ces
boutons appliquent systématiquement le dernier
format de numéros ou de puces utilisé.

— Modifiez, si vous le souhaitez, les options de
formatage par défaut en ouvrant la boite de
dialogue Format > Puces et numérotation....

Les boutons Réduire ou Augmenter le retrait
permettent d'augmenter ou de réduire le retrait
gauche dun  paragraphe dun  espace

€= &=

correspondant & une tabulation

Le bouton Couleur d'arriére-plan A - permet
d'appliguer un fond coloré au paragraphe
sélectionné.

Boite Paragraphe

Cette boite renferme, dans différents onglets,
I'intégralité des options disponibles pour la mise
en forme des paragraphes.On y accede par la
commande Format > Paragraphe ou en double
cliguant dans la régle horizontale, lorsqu'elle est
disponible.

Nous ne décrirons ici que les options de la boite qui
sont communes a tous les modules. Dans la
pratique, cela se limite aux onglets : Retraits et
espacement, Alignement et Tabulations.

Les options spécifiques aux documents Writer seront
abordées dans le manuel d'utilisation de Writer.

Onglet Retraits et espacement

Retraits et espacement | alignement | Tabulations |
Retrait
Awant le bexte Y, 00cm =
Aprés le texte
Premiére ligne 0.00om (& ]
|
]
Espacemnent
Au-dessus du paragraphe
En dessous du paragraphe
Interligne
. —

Les retraits correspondent aux écarts existant
entre les marges latérales de la page et les bords
latéraux du paragraphe, ou entre les limites
latérales d'un objet contenant du texte et les
bords latéraux du paragraphe.

Mettre un paragraphe en retrait revient donc a en
modifier la largeur. Par défaut, en l'absence de
retraits, les bords latéraux du paragraphe se
superposent aux marges latérales de la page ou
aux limites latérales de I'objet qui le contient.

— Avec des valeurs de retrait positives, le
paragraphe se réduit en largeur et s'écarte ainsi
des la marges latérales, vers lintérieur de la
page.

— Avec des valeurs négatives, il s'élargit vers
I'extérieur et pénétre dans les marges.

Dans un objet de texte ou une cellule de tableau, le
comportement est le méme, mais ici, ce sont les
bords latéraux de I'objet ou de la cellule qui jouent
le role de marges latérales.

Notez toutefois que dans ces cas, des retraits
négatifs ne sont pas possibles.

Le retrait de premiére ligne (alinéa) correspond
au retrait appliqué a la premiéere ligne d'un
paragraphe par rapport a sa propre marge
gauche. Une valeur négative fait déborder la
premiére ligne sur la gauche de la marge gauche
du paragraphe.

Les espacements correspondent aux espaces
ménagés avant ou aprés un paragraphe pour le
séparer de celui qui le précéde ou le suit. lls n'ont
rien a voir avec linterligne qui définit I'espace
entre les lignes a lintérieur dun méme
paragraphe. Les espacements permettent d'éviter
le recours a des lignes vides (paragraphes vides)
pour séparer les paragraphes entre eux, ce qu'l
ne faut jamais faire lorsqu'on travaille avec un
traitement de texte.

En régle générale, on considére qu'un point
typographique correspond a 0.35 mm. Par
conséquent, un espacement de 12 pts correspond a
environ 0.4 cm.

L'interligne est I'espace ménagé entre les lignes
de texte d'un paragraphe. En standard, une ligne
correspond a 12 pts soit environ 0.4 cm. Les
options suivantes sont disponibles :

— Simple: c'est le réglage par défaut. Il applique
une simple ligne de séparation dont la hauteur
est calculée automatiquement en fonction de la
taille de la police utilisée.

— 1,5 ligne: définit l'interligne a 1,5 lignes.

— Double: définit I'interligne a deux lignes.
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— Proportionnel ce choix active un champ
d'édition dans lequel on peut entrer une valeur
de pourcentage. 100% signifie un interligne
simple, 200% interligne double et ainsi de suite.

- Au moins cette option active un champ
d'édition dans lequel on peut saisir la valeur
minimale (dans l'unit¢é de mesure active) a
utiliser pour l'interligne.

— Typographique : définit la hauteur de I'écart
vertical inséré entre deux lignes (a partir du bas
de la police de la ligne du dessus jusqu'au haut
de la police de la ligne du dessous).

— Fixe: cette option active un champ d'édition pour
permettre la saisie de la valeur exacte de
l'interligne.

Lorsque vous utilisez différentes polices dans un
méme paragraphe, l'interligne sera inégale, méme
si le programme calcule automatiquement une
valeur optimale.

Pour obtenir des lignes régulierement espacées,
utilisez les options Fixe ou Au moins et saisissez une
valeur suffisante pour créer un espacement entre
les lignes qui tient compte de la plus grande taille
de police utilisée.

Onglet Alignement

L'alignement permet de choisir comment
disposer le contenu du paragraphe par rapport
aux limites latérales du paragraphe. On parle bien
ici des limites latérales du paragraphe et non des
marges latérales de la page.

Le contenu peut étre aligné a gauche, a droite,
centré ou justifié.

Lorsque du texte est justifié, il se trouve aligné a la
fois a gauche et a droite, ce que le programme
réalise en ajoutant de l'espace entre les mots de
toutes les lignes, a I'exception de la derniere.
Lorsque ces espaces sont trop importants au point
de devenir disgracieux, il est possible de mettre en
ceuvre l'outil de coupure de mots pour les réduire

(césure).

Les tabulations

Les tabulations sont des propriétés qui
permettent de gérer la disposition en colonnes de
textes et de chiffres a l'intérieur d'un paragraphe.

by

Elles permettent de commencer un texte a une
position précise par rapport aux marges latérales
du paragraphe pour lequel on les définit (et non

par rapport aux marges latérales de la page ni par
rapport aux limites latérales d'un objet de texte).

Lorsqu'on appuie sur la touche Tab au clavier, un
caractére de tabulation est inséré (non imprimé)
et le point d'insertion se déplace sur la ligne d'une
distance correspondant a la valeur de Ila
tabulation (par défaut 1.25 cm). Ainsi, en
appuyant deux fois sur la touche Tab, le texte
saisi commence a 2.5 cm de la marge gauche du
paragraphe. Si celui-ci n‘a pas de retrait gauche,
cela correspondra également a une distance de
2.5 cm par rapport a la marge gauche de la page,
car dans ce cas, la marge gauche du paragraphe
se superpose a la marge gauche de la page (ou
la limite gauche d'une cellule de tableau ou d'un
objet de texte).

Les tabulations ne réalisent jamais la mise en retrait
d'un paragraphe, elles ne gérent que l'alignement
de son contenu entre les limites latérales du
paragraphe.

On peut détruire un caractére de tabulation de la
méme maniére qu'un caractére normal, c'est a dire
a l'aide des touches Backspace ou Delete.

Dans un document texte Writer, |'utilisation d'un
tableau est bien plus simple et efficace pour
disposer du texte ou des chiffres en colonnes.

Taquets de tabulation de la regle
horizontale

La position des tabulations dans un paragraphe
est matérialisée sur la regle horizontale par des
reperes parfois encore appelés marques ou
taquets de tabulation. Par défaut, des taquets de
tabulation, avec alignement a gauche, sont posés
sur la régle tous les 1.25 cm a partir de la marge
gauche du paragraphe.

La position des taquets de tabulation par défaut
influence :

— la valeur des tabulations par défaut ;

—la valeur par défaut du retrait du texte d'un
paragraphe par rapport a sa marge gauche,
c'est a dire les valeurs de retraits appliquées
lorsqu'on utilise les boutons Augmenter ou

dans la barre de

Réduire le retrait
formatage de texte.

Il existe deux facons de poser des taquets de
tabulation :
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— On peut les poser directement sur la regle d'un
clic de souris. Pour retirer un taquet, le faire
simplement glisser hors de la regle horizontale.
Pour modifier la position d'un taquet, le faire
glisser vers la gauche ou la droite jusqu'a la
position souhaitée.

— On peut les poser avec plus de précision par
lintermédiaire de la boite de dialogue
Tabulations, ouverte par un double clic sur la
zone de la regle sur laquelle sont posés les
taquets de tabulation.

Les types de tabulations

Il existe quatre types de tabulations, c'est a dire 4
manieres pour le texte de se positionner par
rapport aux taquets de tabulation. Chaque type de
tabulation est représenté par un symbole différent
sur la régle.

Dans les boites de texte et les formes, seuls des
taquets de tabulation alignés a gauche peuvent étre
définis directement sur la régle horizontale.

Dans Writer, la régle posséde a son extrémité
gauche un sélecteur de type de tabulation qui
permet, lorsqu'on clique dessus, de choisir le type
de tabulation a insérer sur la régle horizontale.

— Tabulation alignée a gauche (4] . le texte s'écrit
a droite de la tabulation.

— Tabulation centrée . le texte se centre sur la
tabulation.

— Tabulation alignée a droite [v] . le texte s'étend
a gauche de la tabulation.

— Tabulation alignée sur le séparateur décimal (]
le séparateur décimal sera la virgule ou le point
selon le choix effectué dans le Panneau de
configuration de Windows. Le séparateur
s'aligne sur la tabulation, le texte ou la partie
entiere des nombres s'étendent vers la gauche
et les décimales se disposent a droite.

Boite de définition des tabulations

Les tabulations peuvent étre définies de maniere
plus précise et plus compléte dans la boite de
dialogue Paragraphe - Tabulations.

La boite permet de choisir le type de tabulation
(Gauche, A droite, Centré, ou Décimale), le

caractére utilisé comme point décimal, et le type
de caractéere de remplissage a utiliser.

Pour ce qui est des caractéres de remplissage :

- Le point est souvent utilisé comme caractére de
remplissage entre un titre et un numéro de page
dans une table des matiéres.

- Le trait de soulignement est souvent utilisé dans
les formulaires a remplir. Il permet un contréle
précis de la position et de l'alignement des
taquets de tabulation.

La création d'un nouveau taquet de tabulation se
limite a choisir sa position par rapport a la marge
de gauche, son type ainsi que le type de
caractere de remplissage, puis a cliquer sur sur le
bouton Nouveau. Les taquets de tabulation
définis apparaissent dans la liste Position, dans le
volet gauche de la boite.

Pour modifier la position d'un taquet de tabulation
depuis la boite de dialogue, il faut complétement
le recréer.

Exercice

Recopiez le texte ci-dessous dans un document
vide, puis utilisez des tabulations pour obtenir le
résultat suivant :

N° Faciire Date de commande mMontant
08/14010 30 juin 2008 Frs 23147.50
08417121 8 septernbre 2008 Frs 5149210
08/19345 22 septermbre 2008 Frs 115'9587.50
Total Frs 190'627.23

prénom Y|
Voici le texte a recopier :

08/14010 30 juin 2008 Frs 23'147.50

08/17121 8 septembre 2008 Frs 51'492.10
08/19345 22 septembre 2008 Frs 115'987.50
Total Frs 190'627.25

Nom

Prénom

5.6. Listes a puces et numéros

Les listes a puces ou numéros permettent
d'énumérer une suite de paragraphes en ajoutant
une puce ou un numéro devant chacun d'eux.
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Le formatage des listes fait partie des mises en
forme de paragraphes. Il est également possible
dans les objets de texte et les cellules d'un tableau
Writer, mais pas dans les cellules d'un tableau Calc.

Il existe des listes humérotées et des listes a
puces. Dans le cas d'informations séquentielles,
la liste numérotée est incontournable. Si l'ordre
des informations n'a pas d'importance, une liste a
puces peut s'avérer plus appropriée.

Les listes peuvent avoir un ou plusieurs niveaux :

— Liste a un niveau : tous les éléments ont la
méme position hiérarchique et donc le méme
niveau de retrait, comme dans cette liste ci.

— Liste a plusieurs niveaux (hiérarchisée), une
liste contient une autre liste (ou plusieurs).

La mise en forme d'une suite de paragraphes
sous forme de liste numérotée ou a puces peut se
faire directement a la saisie (dans Writer) ou par
conversion d'un texte existant. Par défaut, les
listes apparaissent automatiquement en retrait par
rapport a marge gauche de la page.

La commande Format > Puces et humérotation
ouvre la boite de formatage des listes.

Cette boite est sensiblement différente dans Writer.
La description qui suit concerne la boite telle qu'elle
se présente dans Impress et Draw.

Onglets Puces et Type de
numérotation

Ces 2 onglets proposent respectivement des
modeéles prédéfinis de puces et de numéros pour
les listes simples ou hiérarchisées.

Onglet Position (Impress et
Draw)

La liste Niveau permet de choisir le niveau liste a
modifier. Un champ d'apercu permet de se rendre
compte de l'effet des choix effectués.

— Retrait : correspond a l'espace a ménager entre
la marge de page gauche (ou le bord gauche de
I'objet de texte) et le bord gauche du symbole
de numérotation. Si le style paragraphe actif
utilise un retrait, la valeur saisie ici est ajoutée
au retrait. Si on coche l'option Relatif, la mise en
retrait du niveau actif se fait en fonction du
niveau précédent dans la hiérarchie de la liste.

— Largeur de la numérotation : correspond a
I'espace entre le bord gauche du symbole de
numérotation et le bord gauche du texte.

— Alignement de la numérotation : permet de
choisir le type d'alignement (a gauche, centré, a
droite) du symbole de numérotation.

Puces et numérotation

|Puces || Type de numératation || Images |Pn§itinn | Personnaliser |

Position et espacement
Miveau

1 Retrait

[ relatif

Largeur de la numérakation

Alignement de la numérotation

[T T ey

=)

Par défaut

L oK J[ Annule J[ Aide J[ Rétablir J

Onglet Images

Cet onglet propose une série de graphismes qui
peuvent étre utilisés comme puces ou insérés
sous forme de liens (option Lier les images).

Onglet Personnaliser (Impress
et Draw)

Cet onglet propose les options de formatage des
puces et numérotations. On peut y définir, par
exemple, les éléments de texte devant s'afficher
avant ou apres le numéro.

Puces et numerotation |X|

[Puces | Twpe de rumérotation || Images || Position |Persunnaliser

Farmat

Miveau

1 Mumerotation

PuCe bt

Couleur [ Automatique hd

Taille relative 45% =

Carackére
" e (]

e o O 1
=

L oK J[ Annuler _H Aide J[ Rétablir J

Ainsi, si on tape un contrat, on peut, par exemple,
indiquer Article pour le texte avant, puis un
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espace, puis le caractére : , puis directement
(sans espace aprés le deux-points), 1, 2, 3 ..
pour la numérotation.

La boite se modifie en fonction du type de
numérotation choisi dans la liste Numérotation.

— Niveau : sélectionnez ici le niveau pour lequel
vous souhaitez appliquer un style de
numeérotation choisi dans la liste Numérotation.
Le niveau sélectionné est mis en évidence dans
I'apercu.

— Numérotation : permet de choisir dans une liste
déroulante un format de numérotation prédéfini
pour le niveau sélectionné.

— Avant : saisissez un caractére ou le texte a
afficher devant le numéro dans la liste.

— Aprés : saisissez un caractére ou le texte a
afficher a la suite de la numérotation. Si vous
souhaitez créer une liste numérotée utilisant le
style "1.)", saisissez ".)" dans cette zone.

5.7. Vérifier I'orthographe

OpenOffice permet la vérification orthographique
des textes au cours méme de leur saisie
(vérification en temps réel), ou a posteriori.

Vérifier en cours de saisie
La vérification automatique du texte s'active et se
désactive en cliquant sur le bouton Vérification

ARC
automatique [: dans la barre d'outils Standard.

Elle agit & la fois sur le texte déja saisi et celui en
cours d'édition et se traduit par le soulignement
en rouge des mots mal orthographiés (ou
interprétés comme tels).

Parmi ces mots mal orthographiés, certains peuvent
|'étre réellement et d'autres pas, par exemple, s'ils
ne figurent dans le dictionnaire utilisé (noms propres
ou termes techniques particuliers, etc.).

Pour corriger un mot, ou le déclarer au
programme s'il lui est inconnu, cliquez dessus
avec le bouton droit de la souris pour accéder a
une série de commandes et une liste de
suggestions de remplacement. Vous pouvez
alors :

— remplacer le mot incorrect par I'un des mots de
remplacement suggérés dans la liste ;

—ignorer le mot pour cette fois, ou chaque fois
gu'il est rencontré dans le texte ;

— créer une correction automatique pour le mot s'il
s'agit d'une faute commise fréquemment ;

— ajouter le mot a un dictionnaire personnel ou au
dictionnaire  standard.dic pour que le
programme le reconnaisse a l'avenir ;

—la commande Définir la langue pour la
sélection ou le paragraphe permet de choisir
une langue spécifique pour un passage de texte
écrit dans une autre langue que celle du reste
du document. Il faut pour cela que le
dictionnaire de la langue choisie soit installé.

Vérifier a posteriori
Pour vérifier un texte déja saisi cliquez sur le

bouton ‘& Orthographe et grammaire (F7)
dans la barre d'outils Standard.

Dans ce mode de correction, le document ou la
sélection active est parcourue jusqu’a la premiere
faute rencontrée et le programme l'affiche dans la
boite de dialogue Orthographe. Le correcteur
s'arréte sur chaque faute et ne reprend son travail
gu'une fois la faute corrigée.

Le programme traite les erreurs rencontrées de
maniére séquentielle, dans le sens de lecture du
texte.

Orthographe : Francais (Suisse) |X|

Langue du kexke |‘§ Frangais (Suisse) “

Absent du dictionnaire

Dans ce mode de corection, le document ou la sélection active est
parcourue jusqu'd la premigre Faute rencontrée et le programme 'affiche
dans la boite de dialogue Orthographe.

Ignorer une fois
Ajouter |~

| [

Suggestions

correction

Tout modifier
AutoCorrection

Ci-dessous, une breve description des

fonctionnalités de la boite de Vérification
orthographique.

[ Aide } [ Cptions. .. ] Annuler

- Langue du texte permet de vérifier
I'orthographe d'un mot de langue étrangére en
recourant momentanément au dictionnaire de
cette langue.

— Absent du dictionnaire : affiche le texte vérifié
avec le mot supposé mal orthographié en rouge.
— Suggestions : liste de suggestions de
remplacement pour le mot mal orthographié.
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Pour appliquer I'une des corrections proposées,
la sélectionner puis cliquer sur le bouton
Modifier. Si aucune suggestion proposée ne
convient, corriger manuellement le mot
directement dans la boite puis cliquer sur le
bouton Modifier pour valider la correction et
permettre au correcteur de continuer son travail.

—Ignorer une fois : on accepte le mot sans
correction, mais pour cette fois seulement.

— Tout ignorer : on décide d’ignorer toutes les
occurrences dans le document en cours.

— Ajouter on ajoute le mot signalé au
dictionnaire utilisé, de maniere a ce gu'il ne soit
plus considéré comme mal orthographié par la
suite.

— AutoCorrection permet de créer une
correction automatique pour le mot.

— Options ouvre une boite permettant de
décider, par exemple, de contrbler ou pas les
mots en majuscules, ou les mots comportant
des chiffres. La boite permet encore de gérer
les dictionnaires personnalisés, d'ajouter ou de
supprimer des dictionnaires, d'ajouter ou
supprimer des mots dans un dictionnaire ou
encore de changer de dictionnaire pour la
vérification.

5.8. Vérifier la grammaire

OpenOffice ne dispose pas d'un correcteur
grammatical intégré. Cette fonctionnalité doit lui
étre rajoutée sous forme d'extension. Deux
solutions sont possibles pour le francais :

- Language _Tool
multilingue.

correcteur grammatical

— Grammalecte : correcteur grammatical pour la
langue francgaise uniquement.

Si vous utilisez Grammalecte, vous devez
obligatoirement assigner votre texte a la locale
Frangais (France).

Language Tool ne peut pas fonctionner sur
0004Kids et OOoLight.

Ici aussi, vous pouvez effectuez une vérification
automatique (globale et a la frappe) ou a
posteriori, sur un texte déja saisi. Les erreurs sont

soulignées d'un trait ondulé bleu.

Vérification automatique

A tout moment vous pouvez activer ou désactiver
la vérification grammaticale automatique a l'aide

du bouton I=* Vérification automatique dans la
barre d'outils Standard.

Les fautes grammaticales sont soulignées en
bleu, et un clic droit dessus affiche un menu
contextuel avec une description du probléme
rencontré et des suggestions de correction.

eaenfantaont-parns jouer

€ =lesw et wenfant e semblent pas bisn accordés en nombre

[gnorer

.é Crthographe st grammaine

Diéfinir kalamgue pour & sélection ]
[éFinir ka langue pour e paragraphe v

Vérification a posteriori

Pour lancer la vérification grammaticale d'un texte

déja saisi (vérification depuis le point d'insertion)

ou d'une sélection de texte existante), cliquez sur
R AR

le bouton Orthographe et Grammaire =2 (F7)

dans la barre d'outils Standard. La boite de
dialogue suivante s'ouvre :

Orthographe et grammaire

Lengue du texte % Frangais (Suisse)

Abset du dictionnaire:

Les enfant sont partis jouer dehars. e i EHDI'BI unie Fals! I
= Ignorer la réghs
L]

Huggedions

(aucune suggestion) baaiiie

Vérifier Ia arammare

e L owe JN e

Dans ce mode de correction, le programme
parcourt le document ou la sélection jusqu'a la
premiére faute rencontrée et ne poursuit son
travail qu'une fois la faute corrigée. Les erreurs
sont donc traitées les unes apres les autres dans
le sens de lecture du texte.

Si aucune suggestion proposée ne vous convient,
corrigez manuellement le mot directement dans la
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boite puis cliquez sur le bouton Modifier pour
valider la correction et permettre au correcteur de
poursuivre son travail.

La liste déroulante Langue du texte permet de
vérifier un mot de langue étrangére en recourant
momentanément au dictionnaire de cette langue.

Dans Writer, la langue utilisée pour la vérification
orthographique s'affiche dans la barre d'état, a coté
de la zone affichant le style de page en cours.

Vérifier la grammaire dans
OOolLight

Comme Language Tool ne peut fonctionner sur
0OO0o04Kids et OOoLight, vous devrez installer les
deux extensions suivantes :

—Une version modifiée de Grammalecte pour
0O0o04Kids et OOoLight téléchargeable a
I'adresse :http://ftp.educoo.org/home/Grammale
cte/Grammalecte-v0.2.0.0xt.

— Le dictionnaire Francais moderne version 4.6,
adapté pour OOoLight et OOo04Kids. Vous
pouvez le télécharger sous forme d'extension
ici :
http://ftp.educoo.org/home/Grammalecte/oo0-
dictionnaire-fr-moderne-v4.6.0xt.

Performance des correcteurs

Le screenshot ci-dessous montre comment
réagissent les correcteurs lorsque la vérification
automatique d'un texte a la saisie est active.

Comme Language Tool ne peut fonctionné
sur__ces deux swte, vous devirez installé les
deux extensions survantes.

Comme vous pouvez le constater :

— "Language Tool" est reconnu a tort comme faute
d'orthographe, mais c'est normal puisqu'il s'agit
d'un nom étranger a la langue francaise ;

- "fonctionné" est reconnu tres justement comme
erreur par le correcteur grammatical ;

—"sur ces": est bien détecté comme erreur, il y a
deux espaces entre les deux mots au lieu d'un ;

- "suite" : il manque le "s" marquant le pluriel

—"devrrez": il faudrait écrire "devrez" il s'agit
d'une faute d'orthographe bien reconnue

- "installé" est une erreur grammaticale non
reconnue, il faudrait écrire "installer".

Le résultat global obtenu est intéressant mais
montre qu'il ne faut pas se fier aveuglément a ces
outils : ils sont utiles mais ont aussi leurs limites.

« Comme d'habitude, les mots soulignés possédent
un menu contextuel comprenant des suggestions
de correction lorsque la vérification automatique
est active.

« La commande Orthographe et Grammaire
(F7) ouvre la boite de méme nom et démarre le
parcours du texte saisi avec affichage des fautes
au fur et a mesure que le programme les détecte.

5.9. Les synonymes

OpenOffice integre d'origine un dictionnaire de
synonymes permettant d'obtenir des alternatives
pour des mots et des phrases. Il suffit de
sélectionner le mot ou la phrase puis de lancer la
commande Outils > Langue > Dictionnaire des
synonymes .(Ctrl+F7).

Ainsi, si on sélectionne le mot “maison”, le
dictionnaire l'affiche dans la boite de dialogue et
propose plusieurs synonymes comme montré
dans la copie d'écran ci-dessous.

Dictionnaire des synonymes (Francais (Suisse)) &|

Mok actif

|maison V| [ Langue = ]

Alternatives

1. iAdEectif Nomi haraiue ~

cabane
masure
hiutte
batiment
édifice
bitisse
canstruction
immeuble
rnonurient
building
gratte-ciel
chez-soi
Fover ¥

Remplacer par

| baraque |

[ Remplacer l [ Annuler ]

Il est alors possible de :

— Cliquer sur la proposition qui convient, puis
valider le remplacement.

— Si on ne trouve rien de concluant dans la liste
des synonymes proposeée, il faut alors double-
cliquer sur la proposition qui semble la plus
proche, afin d'afficher une nouvelle liste de
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synonymes et voir si on n'y trouve pas celui qui
convient.

Le bouton Langue permet de régler le choix de la
langue directement depuis la boite de dialogue.

Le bouton Remplacer remplace la sélection
courante par le synonyme se trouvant dans le
champ Remplacer par.

5.10. Rechercher et remplacer

Cette fonctionnalité, disponible dans tous les
modules d'OpenOffice, déléegue au programme la
recherche d’occurrences en évitant a I'utilisateur
de devoir parcourir lui-méme tout le document
pour les trouver.

Par défaut, la recherche s'effectue depuis la
position courante. Lorsque la fin du document est
atteinte, une boite de dialogue demande si la
recherche doit étre poursuivie depuis le début du
document.

Pour démarrer une recherche, il suffit d'indiquer
au programme le texte recherché ou de saisir un
critere de recherche sous forme d'expression
réguliere (expression contenant des caractéres
génériques tels que ? ou * en remplacement d'un
seul ou d'un groupe de caractéres) pour que le
programme  retrouve et sélectionne les
occurrences correspondantes dans le document.

Cette fonctionnalité de recherche peut également
étre couplée a une fonction de remplacement
pour remplacer des mots ou des expressions par

d'autres.

Ces fonctionnalités de recherches et remplacements
ne sont pas limitées a du texte, il est également
possible de rechercher des formats et des styles
pour les remplacer par d'autres et ainsi modifier
rapidement des mises en forme de textes.

Pour accéder a ces options supplémentaires, cliquez
sur le bouton Plus d'options dans la boite.

Rechercher du texte

Placez le point d'insertion dans le document &
I'endroit ou doit débuter la recherche puis lancez
la commande Edition > Rechercher &

Remplacer (Ctrl+F), ou cliquez sur le bouton i
(barre d'outils Standard) pour ouvrir la boite de
recherche et remplacement.

X

Rechercher & remplacer |

Tout rechercher

Rechercher
E

ocuments w |

Remplacer par
e 2 Remplacer

| ]

Tout remplacer

[ Respecter la casse

|:| Maks entiers uniguemenk

Plus d'options + [ Aide J

Dans la zone Rechercher, tapez le mot ou
'occurrence recherchée, puis choisissez si le
texte recherché doit étre considéré comme un
mot entier (option Mot entier uniquement) ou s'il y
a lieu de respecter la combinaison de majuscules
et minuscules (option Respecter la casse).

—
—

Fermer

Laissez vide la zone Remplacer par.

Si un mot se trouve sélectionné dans le texte au
lancement de la commande de recherche, il
apparait automatiguement dans le champ
Rechercher.

L'exécution de la commande de recherche peut
se faire selon I'une des modalités suivantes :

— Bouton Rechercher : le programme recherche
les occurrences une a une, il faut appuyer a
chaque fois sur le bouton Rechercher pour
passer a la suivante.

— Bouton Tout rechercher : le programme trouve
automatiquement toutes les occurrences dans
le document et les sélectionne.

Rechercher et remplacer du
texte

La commande Rechercher & Remplacer permet
de remplacer un mot ou une occurrence par un
autre mot ou une autre occurrence dans tout le
document actif.

1. Placer le point d'insertion dans le document a
I'endroit ou doit débuter la recherche puis
lancer la commande pour ouvrir la boite de
recherche et remplacement.

2. Dans la zone Rechercher, tapez le mot ou
I'occurrence recherchée, puis choisir si le texte
recherché doit étre considéré comme un mot
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entier (option Mot entier uniquement) ou s'il y a
lieu de respecter la combinaison de
majuscules et minuscules (option Respecter la
casse). Par défaut la recherche s'effectue vers
le bas, a partir de la position courante dans le
document.

3. Dans la zone Remplacer par, taper le texte de
remplacement.

Le lancement de la commande de remplacement
peut se faire selon I'une des modalités suivantes :

— Bouton Remplacer : le programme recherche
les occurrences une a une et leur remplacement
nécessite a chaque fois un appui sur le bouton
Remplacer.

— Bouton Tout remplacer le programme
remplace automatiqguement toutes les
occurrences trouvées dans le document.

Criteres optionnels

En cliguant sur le bouton Plus d'options, situé en
bas a gauche de la boite, vous dépliez un volet
supplémentaire comprenant une série de critéres
de recherche optionnels.

Sélection active seulement .
- Attributs...

Vers le haut
Format...

Aucun format

Expressions réguliéres

il

Rechercher des similarités

Rechercher des styles
Notes

Sélection active seulement

La recherche est limitée au passage de texte
sélectionné.

Vers le haut

Vous permet de remonter vers l'occurrence qui
précéede l'occurrence trouvée.

Expressions réguliéres

La sélection de cette option permet d'utiliser des
substituants comme le caractere * en
remplacement de plusieurs caractéres, ou le point
comme substituant pour un seul caractére dans
I'écriture du critére de recherche.

Rechercher des similarités

La fonction de recherche est également capable
de retrouver des termes similaires aux termes
recherchés. Dans ce cas, vous devrez appuyer
sur le bouton E pour afficher la boite de

paramétrage ci-dessous.
P a— ——

Paramétrages
l OK

Echanger les caractéres
Ajouter des caractéres
Supprimer des caractéres |2 E| l Aide ] |

I Combiner I
I

| — —

Cette recherche se distingue de la recherche
avec caractéres génériques car elle permet la
recherche de similitudes. Ainsi, des mots peuvent
étre trouvés méme s'ils divergent du terme
recherché (plusieurs caractéres différents, en plus
ou en moins).

La boite ci-dessous permet de définir les
conditions de divergences tolérées dans la
recherche.

— Echanger des caractéres indiquez ici le
nombre de caractéres qui peuvent différer par
rapport au critéere de recherche pour qu'une
occurrence soit valide comme résultat de la
recherche. Si le nombre de caracteres est 3 et
le critere "fromage", alors "clonage" sera une
similitude valide.

— Ajouter des caractéres : cette option permet
d'indiquer le nombre de caracteres
supplémentaires que les mots peuvent avoir par
rapport au critere de recherche. Les caractéres
supplémentaires peuvent étre placés a
n'importe quel endroit du mot.

— Supprimer des caractéres : permet d'indiquer
combien de caractéres en moins par rapport au
critére sont tolérés pour qu'un mot constitue une
similitude valide.

— L'option Combiner : permet d'associer les 3
criteres de délimitation précédents.

Rechercher des styles

Cette option est particulierement utile pour
changer le style appliqué a des paragraphes de
texte, a la suite d'un changement de modéle, par
exemple.
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5.Saisir du texte et le mettre en forme

Bouton Attributs

Attributs
.

Options

@ Alignement i
[l Alignement vertical du texte

Barré

B

m

Clignotant Aide
Conserver avec le paragraphe suivant
Contour

Contréle de repérage

Couleur de police

Coupure des mots

Crénage

Echelle

Espacement

-

Ouvre une boite de dialogue dans laquelle vous
pouvez composer un critere de recherche en
cochant les attributs de texte a rechercher. Vous
pouvez alors retrouver tous les mots qui ont recu
par formatage direct (option par défaut) les
attributs composant le critere.

Si vous cochez l'option Y compris les styles dans
la boite Rechercher&Remplacer, la recherche
sera étendue aux mots ayant hérité ces attributs
par une mise en forme indirecte (a l'aide d'un
style).

Bouton Format

Ce bouton ouvre la boite de dialogue Format de
texte (Rechercher) permettant de désigner les
formats particuliers a rechercher.

Format de texte(Rechercher) g \ .‘ l >
Police | Effets de caractéres Position | Retraits et | [ Enchai [Arriere-plan |
l
| Police Style Taille
\Aharoni «| |Normal 6 o
[l \Andalus =) [Italique 7 El
| |Angsana New Gras 8
| |AngsanalUPC [ltalique gras 9
\Aparajita Pas de Gras 10 |
I IAR BERKLEY Pas de Italique 10.5 (]
| \AR BLANCA - 11 -
| Langue
. [ §
|}
|}
| (]
[
Exemple
|}
(]
[ ox ] [annuer | [ aide || retapiir] |

Pour remplacer l'attribut trouvé par un autre
procédez comme suit ;

1. Commencez par placer le curseur dans le
champ Rechercher puis appuyer sur le bouton

Format ....et définissez le format a rechercher
dans la boite de dialogue qui s'ouvre.

2. Choisissez ensuite l'attribut de remplacement
en procédant comme ci-dessus mais cette fois
avec le champ Remplacer par.

3. Démarrez la recherche et le remplacement.

Les attributs choisis s'affichent au-dessous des
champs Rechercher et Remplacer par.

Si  rien n'est spécifié comme format de
remplacement, le remplacement se fait par des
attributs par défaut.

Bouton Aucun Format

Ce bouton permet de supprimer tous les critéres
de recherche sélectionnés, y compris les attributs
et les formats.

Cliquez d'abord dans le champ pour lequel les
attributs et les formats doivent étre désactivés
(Rechercher ou Remplacer par), puis cliquez sur
le bouton Aucun attribut.

Barre d'outils Rechercher

Recherchera & ¢ # |

Son utilisation est simple :

1. On commence par saisir le critere de
recherche dans le champ éditable.

2. On clique sur l'un des deux boutons fléchés
pour mettre en surbrillance, par rapport a la
position courante, l'occurrence précédente ou
suivante qui satisfait au critére.

3. Le bouton représentant une paire de jumelles
ouvre directement la boite Rechercher &
Remplacer.

© 2012 - 2013 G. Waterval

Version : 26/04/13

Apache licence, Version 2.0

0004Kids - Apache OpenOffice - OOoLight

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

63/102



http://wiki.ooolight.org/index.php/Main_Page/fr
http://openoffice.apache.org/
http://wiki.ooo4kids.org/index.php/Main_Page/fr
http://www.apache.org/licenses/LICENSE-2.0

6.Styles et modéles

6. Styles et modeles

6.Styles et modeles........ccceeiviiiiii i, 64
6.1.Formater a l'aide de styles...................... 64
Types de Styles .......ccccccveieiviieeeieeeeein, 64
Le Styliste.....cooviiiiiiieeeeeeee e 65
Créer un nouveau style.........ccccoccvvvvvnnnnns 66
Modifier un style........cccoocieeeiiiiiiiiiiis 67
Appliquer un style......ccccceevviviccciiiiieeeeee, 67
Copier et déplacer des styles.................... 68
Importer des styles.........ccccovvcviieieiniinininns 68
6.2.LeS MOdEIES .........occcvveviiiiiiiieeieeee e, 68
Le modéle par défaut...........cccceeeeveeeennnnn, 69
Choisir un modele personnalisé................ 69
Créer un modele personnalisé.................. 70
Editer un modéle existant.......................... 70
Actualiser un document ............ccccceeernene 70
Changer de modeéle ..........cccoevvevvcieenennnns 71
Organiser les modeles................oeeeeeeeennnne 71

Les éléments qui composent un document
OpenOffice peuvent étre mis en forme de deux
maniéeres :

1. Par application directe de commandes de
formatage disponibles dans le menu Format
ou présentes sur des barres d'outils
spécifiques.

2. Par application d'un style intégrant les
attributs (propriétés) a appliquer aux éléments
qu'on a formater pour qu'ls prennent
I'apparence souhaitée.

La premiére méthode, bien que de loin la plus
utilisée, n'est pas du tout la meilleure, car elle
n'est pas pratique pour des documents censés
évoluer sur le long terme. En plus de cela, son
application ne permet pas d'exploiter pleinement
toutes les fonctionnalités du programme et
présente un risque accru d'erreurs et
d'incohérences dans la mise en forme des
documents.

La seconde, le formatage a I'aide de styles est
la méthode de choix, car elle permet d'exploiter
pleinement toutes les fonctionnalités du
programme et de lui déléguer certaines taches,
comme la création d'un index ou d'une table des
matiéres dans un document Writer, par exemple.
Elle vous apportera également un bien meilleur
confort lors de la maintenance de vos documents

et minimisera les risques d'incohérences dans
leur mise en forme.

6.1. Formater a l'aide de styles

Jusqu'a présent nous n'‘avons abordé, dans le
chapitre intitulé "Saisie et mis en forme directe de
texte", que des opérations de formatage directes,
menées au coup par coup, en appliquant
manuellement les mises en valeur souhaitées aux
éléments sélectionnés.

Mais on peut également appliquer de telles mises
en forme apres les avoir enregistrées dans un
style réutilisable a volonté. A ce moment,
formater un élément revient a lui transmettre d'un
seul coup les formatage désirés en lui appliquant
simplement le style qui les contient.

Cette facon de faire posséde un énorme
avantage, car elle permet de modifier le
formatage d'un document de fagon trés simple.
En modifiant simplement les styles appliqués, les
modifications sont instantanément répercutées a
tous les éléments du document liés aux styles
modifiés.

Tous les modules d'OpenOffice disposent, avec le
Styliste, d'un outil dédié a la création et a
I'application de styles.

Définir un style de mise en forme pour un élément
de catégorie donné, paragraphe de texte, cadre,
titre de niveau donné, etc. consiste a enregistrer un
ensemble de mises en valeur sous un nom, pour
pouvoir les appliquer d'un seul coup aux éléments
du méme type.

Types de styles

Les documents créés par les différents modules
d'OpenOffice n'étant pas tous du méme genre, les
types de styles disponibles dans les différents
modules ne sont pas identiques. Chaque module
dispose donc de sa propre liste de styles, adaptée
aux éléments rencontrés dans ses documents.

Styles dans Writer

Writer produit des document contenant surtout du
texte, mais pouvant intégrer des images et autres
objets. On y trouvera donc les types de styles
suivants :

1. Styles de paragraphe : pour mettre en forme
les niveaux de plan du document (niveaux de
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6.Styles et modéles

titre), son texte principal, ses listes a puces ou
a numeéros, etc.

2. Styles de caractére: pour assurer le
formatage de certains passages de texte
particuliers qu'on désire mettre en évidence en
leur appliquant un formatage spécifique a leurs
caractéres, comme dans le cas de définitions,
citations, exemples, etc.

3. Styles de cadre: pour gérer les modalités
d'insertion des illustrations et des objets OLE
gu'on peut rencontrer dans un document texte.

4. Styles de page : pour assurer la mise en page
adéquate des différentes pages d'un
document : page de titre, table des matiéres,
pages de gauche et de droite, pages avec ou
sans en-tétes et pieds de page, disposition
horizontale de pages renfermant des tableaux,
etc.

5. Styles de liste : pour appliquer un style de

puce ou de numérotation a des listes de
paragraphes.

Styles dans Calc

Calc permet de créer et d'appliquer deux types de
styles :

— Des styles de cellule pour mettre en forme des
cellules ou des plages de cellules. Ce seront,
par exemple, des styles permettant d'appliquer
des formats numériques particuliers, des
formats d'arriere plan, de titres de colonnes ou
de lignes, des bordures ou encore un état de
protection. aux cellules auxquelles on les
applique, etc.

- Des styles de page avec les options de mise
en page qu'on souhaite voir appliquées aux
sorties papier lorsqu'on désire imprimer les
feuilles d'un classeur.

Styles dans Impress
Impress posséde deux types de styles :

1. Styles de présentation : La plupart sont les
styles automatiques appliqués aux textes de
niveaux de plan 1 & 9 saisis dans les espaces
réservés de texte des diapositives. La liste est
fixe, on ne peut pas la modifier, mais on peut
modifier les styles qui la composent.

2. Styles d'images: ce sont les styles qui
permettent de formater les formes dessinées,
des images et des objets de texte. Ici, il est

possible d'ajouter des styles personnalisés a la
liste et de modifier les styles existants.

Styles dans Draw

Draw ne possede que le type Styles d'images
identique a son homologue dans Impress.

Le Styliste

Cette fenétre (flottante ou ancrable), est
contextuelle et affiche, pour chague module de la
suite, la liste des styles définis pour les différentes
catégories d'objets manipulées par le programme.

Styles et formatage [x]

DEC0D0E 1 A
DOaTe:

exkBiody

Q0oTextBody _ListInkro
O0oTextBodyafterList

Q00 TipMoke Caution

Pied de page

Pied de page drait 2
Pied de page gauche

Puce 1

Puce 1 début

Puce 1 fin

| Y L TN N

-

-~

(I

<

Tous les styles 3

Ces styles sont hérités du modeéle sur lequel est
basé le document.

Comme certaines catégories de styles sont
propres a certains modules et dautres
communes, la liste des styles disponibles dans la
fenétre varie d'un module & l'autre, mais la fenétre
du Styliste elle-méme se présente et se manipule
de maniére identique dans les différents modules.

De haut en bas, elle se compose des éléments
suivants : .
1. Barre d'outils.

2. Zone d'affichage des styles de la catégorie
sélectionnée. Les styles y sont filtrés selon le
critére choisi dans la liste déroulante (3)

3. Liste permettant le filtrage des styles affichés
selon différents critéres.

Barre d'outils (1)
FEoOEE at
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6.Styles et modéles

Si on prend I'exemple du Styliste de Writer, dont
la barre d'outils est représentée ci-dessus :

Les cing premiéres icdnes permettent de choisir
la catégorie de styles a afficher.

Mode "Tout remplir"& . active ou désactive
I'application du style choisi dans le Styliste aux
sélections qu'on effectue ensuite dans le
document. Une nouvelle sollicitation de la
commande annule ce mode.

Bouton de gestion des styles E c'est un
bouton multifonction donnant acces a 3
commandes pour créer un nouveau style basé
sur la sélection courante, actualiser un style
existant, en le redéfinissant avec les attributs de
mises en forme en vigueur dans la sélection
courante, charger des styles en provenance d'un
document externe.

Zone d'affichage (2)

Zone d'affichage des styles de la catégorie
sélectionnée. Les styles y sont filtrés selon le
critére choisi dans la liste déroulante (3).

Chaque style possede un menu contextuel
contenant les commandes suivantes :

— Nouveau ... : permet de créer un nouveau style
a partir de la boite de définition des styles. Cette
boite permet la création de styles "ex nihilo"
c'est-a-dire en définissant leurs attributs un par
un.

— Modifier permet de modifier un style
existant a l'aide de la boite de définition des
styles abordée dans la section suivante de ce
chapitre.

— Supprimer...: permet de supprimer un style
personnalisé. Remarquez que la suppression
des styles prédéfinis de OpenOffice n'est pas
possible. Pour supprimer un style personnalisé,
cliguez-droit dessus dans la fenétre du Styliste
et choisissez Supprimer. Si le style est utilisé,
un message vous en avertit et si vous acceptez
la suppression, tous les objets auxquels il était
associé retrouvent le formatage prévu par
défaut par le programme (style par défaut).

Filtrer la liste des styles (3)

Au bas de la fenétre Styles et formatage, une liste
déroulante permet de filtrer les styles affichés

selon différents critéres. Cette liste varie selon la
catégorie de style.

— Tous (les styles) : tous les styles disponibles de
la catégorie choisie sont affichés.

— Styles appliqués : seuls les styles auxquels on a
déja eu recours pour formater le document sont
listés.

— Styles personnalisés : restreint |'affichage aux
styles personnalisés (créés par l'utilisateur pour
répondre a des besoins spécifiques).

— Hiérarchie : affichage arborescent des styles
permettant de voir leurs dépendances, c'est a
dire les styles parents sur lesquels on a basé
leur création.

Créer un nouveau style

La création d'un style peut se faire de plusieurs
facons : a l'aide d'un exemple, par modification
d'un style existant, ou encore depuis la boite de
dialogue de création de styles.

Création par I'exemple

Cette méthode consiste a mettre en forme
manuellement un élément qui servira de base a la
définition du style, puis, une fois atteint le résultat
souhaité, on demande au programme
d'enregistrer ces mises en forme dans un style en
cliquant sur le bouton Nouveau style a partir de
la sélection. Le programme ouvre alors une
fenétre permettant de nommer le style créé. Aprés
validation par OK, le nouveau style créé apparait
dans la liste des styles de sa catégorie.

Il est également possible de faire glisser I'élément,
une fois formaté, dans la fenétre du Styliste pour
ouvrir la boite permettant de créer le style et de lui
donner un nom.

Ainsi, vous pouvez, dans Writer, par exemple,
commencer par mettre en forme manuellement un
paragraphe de Titre2, puis enregistrer sa mise en
forme dans un style pour pouvoir la réappliquer a
tous les paragraphes de Titre2 dans votre
document, sans devoir répéter votre formatage
manuellement.

Création par modification d'un style
existant

On peut créer un nouveau style par
modification d'un style existant. Pour ce faire, il
sufft de lancer la commande contextuelle
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6.Styles et modéles

Nouveau... associée au style qu'on souhaite
utiliser comme base. Il reste alors & définir le nom
du style, puis modifier les attributs de mise en
forme du style de base pour créer le nouveau
style.

La boite de création de styles

On peut créer un nouveau style de toutes piéeces,
directement a l'aide de la boite de dialogue Style.
Une telle procédure démarre simplement en
appelant la commande contextuelle Nouveau
d'un clic droit dans un espace vide de la liste des
styles de la catégorie dans laquelle le nouveau
style doit étre créé.

Vous pouvez ainsi démarrer la procédure de
création et l'onglet Gérer vous propose de le lier a
celui qui se trouvait sélectionné dans la liste au
lancement de la commande (vous pouvez
toutefois changer cette liaison).

Modifier un style

On peut procéder de I'une des méthodes
suivantes :

— Sélectionnez le style a modifier dans le Styliste
puis appeler sa commande contextuelle
Modifier...,. Effectuez directement vos choix
dans la boite de formatage qui s'ouvre . A la
validation de la commande, le style est modifié
et les éléments formatés auparavant avec ce
style sont automatiquement actualisés.

— Formater ou choisir un élément disposant déja
des mises en forme souhaitées, sélectionner le
style a modifier puis appuyer sur le bouton
Actualiser le style. Le style est modifié en
conséquence et les éléments auxquels il avait
été appliqué sont mis a jour automatiquement.

Appliquer un style

Commencer par sélectionner dans le document

I'élément & formater, puis appliquer l'une des
procédures suivantes :

— Double cliquer, dans le Styliste, sur le hom du
style a appliquer.

— Taper au clavier le raccourci associé au style a
appliquer.

Appliquer un style par le mode Tout
remplir

Un clic sur l'icbne Mode Tout remplir active un
mode de travail qui permet d'appliquer un méme
style a divers éléments compatibles qu'on
sélectionne aprés que ce mode ait été activé.
Cette méthode est trés pratique pour formater
plusieurs éléments du méme type les uns apres
les autres.

Procédez comme suit :

a

1. Sélectionnez le style a appliquer dans la
fenétre du Styliste.

2. Cliguez sur l'icbne Mode Tout remplir.

3. Sélectionner successivement tous les objets a
formater, en cliquant simplement dessus, pour
leur appliquer le style choisi.

Pour quitter ce mode, cliquer une nouvelle fois sur
I'icone ou appuyez sur la touche Escape.

Lorsque ce mode est actif, un clic droit n'importe ou
dans le document annule la derniére action de
remplissage effectuée.

Des raccourcis clavier pour appliquer des
styles

Vous pouvez configurer des touches de raccourci
pour appliquer rapidement des styles dans votre
document. Certains raccourcis sont prédéfinis,
telles que Ctrl+1 pour le style Titre 1 et Ctrl+2
pour le style Titre 2 dans Writer, mais vous
pouvez les modifier et méme créer les votres.

Personnaliser

X|

Menus | Clavier | Barres dioutils || Evénemerits |

Raccouwrcis clavier ~ (O OpenOffice.org ‘
Chrl4+Maj45 |
Chrl+Majs6 © varer
Chrl+Maj+7 |
Chrl+Maj+8 Modifier
Chrl-+Maj+9 |
Chrl+Maj+h De gauche & droite Supprimer
Chrl+Maj+B Indice:
Crrl+ai+D De: droite & gauche |
Chrl+Maj+F Répéter la recherche —
e
Cerl+Maj+H s w —
< > Rétabir
Fanctions
Cabegorie Fonction
Numérotation A | |perscTire ~
Modifier | persoTitrad
3 i | persoTirel
| persoTikre2
| persoThred =)
| Pied d= page
ges |Pled de page drok
humérotation |Pied de page gauche
|Paire 1 b
£ > | | i

[ ok ][ annuer J[ side ]lg&abii
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Procédez comme suit ;

1. Lancez la commande de menu Outils>
Personnaliser pour ouvrir la  boite
Personnaliser.

2. Activez l'onglet Clavier.

3. Sélectionnez dans la liste un raccourci non
affecté.

4. Dans la rubriqgue Fonctions, déroulez la liste
Catégorie jusqu'a ce qu'apparaisse l'entrée
+Styles. En cliquant sur le signe "+" déroulez
la liste des catégories de styles utilisables. Une
fois la catégorie choisie, recherchez dans la
liste Fonction le style & associer au raccourci
clavier choisi, par exemple persoTitre3, puis
cliquez sur le bouton Modifier. Le raccourci
choisi est affecté au style et il apparait dans la
zone Touches.

5. Validez par OK.

Copier et déplacer des styles

Pour copier un style d'un document vers un autre,
ou entre un document et un modéle, lancez la
commande Fichier > Modéles > Gérer pour
ouvrir la boite de dialogue Gestion des modéles.

1. Dans les listes déroulantes Modéles et
Documents, situées au bas de la boite,
affichez les documents source et cible du
transfert ou de la copie, puis double-cliquez
sur leur nom puis sur l'icbne Styles pour que
s'affiche la liste de leurs styles respecitifs.

2. Pour copier un style, maintenez la touche Ctrl
enfoncée et faites glisser le nhom du style a
copier d'une liste & l'autre. Pour déplacer un
style, faites simplement glisser le nom du style
sans recourir & la touche Ctrl.

3. Répétez l'opération pour chaque style que
vous voulez copier/déplacer avant de cliquer
sur le bouton Fermer pour terminer vos
transferts ou copies.

» Le choix du volet affichant le document/modéles
fournissant les styles a copier/déplacer est sans
importance. On peut indifféremment utiliser le
volet gauche ou le volet droit.

« Si un document impliqué dans l'opération n'est
pas ouvert, le bouton Fichier dans la boite de
dialogue permet de le rechercher sur le disque
pour l'ouvrir.

Importer des styles

La commande Charger les styles ... est la
derniere commande du bouton multifonction situé
a droite de la barre d'outils de la fenétre Styles et
formatage. Elle permet d'importer dans le
document actif des styles présents dans un
modele ou un document externe. Cette méthode
permet d'importer tous les styles du document
externe d'un seul coup. Procédez comme suit :

1. Dans la fenétre Styles et formatage, cliquez
sur la pointe de fléeche orientée vers le bas,
juste a droite du dernier bouton de la barre
d'outils, et choisissez la commande Charger
les styles ....

2. Dans la boite de dialogue Charger les styles
qui s'ouvre (voir la copie d'écran ci-dessous),
recherchez et sélectionnez le
modele/document dont vous  souhaitez
importer les styles. Cliquez sur le bouton A
partir d'un fichier ... si les styles a importer
sont contenus dans un document texte et non
dans un modele listé dans la boite. Dans ce
cas, une boite de dialogue d'ouverture
apparait pour vous permettre de sélectionner
le document désiré.

3. Une fois choisi le document/modéle source,
cochez les cases correspondant aux types de
styles a importer, pour éviter l'importation de
styles qui ne vous intéressent pas. Si vous
sélectionnez l'option Ecraser, les styles
importés remplaceront ceux de méme nom
dans le document cible.

4. Cliquez sur OK pour démarrer l'importation des
styles choisis.

Charger les styles rzl
co i -
3 iyl ethes Template
Arriare-plans da présantation
T ——
Texts [ cadre [Oesges Dtwmerotation [ Ecraser

6.2. Les modeles

Un modéle est un document enregistré dans un
format de fichier spécial, qu'on peut réutiliser
comme base lors de la création de nouveaux
documents du méme genre.
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Les modéles peuvent renfermer tout ce qu'on
trouve dans les documents normaux : textes,
graphismes, feuille de styles, en plus
d'informations sur la configuration adoptée par
l'utilisateur, comme les unités de mesure
employées, la langue, la configuration
d'impression, la personnalisation des barres
d'outils et des menus, etc.

« Tous les documents créés dans OpenOffice sont
en fait basés sur des modeles. Si vous ne
spécifiez pas de modéle au départ, c'est le
modele par défaut du programme qui est
appliqué.

» Lorsque vous créez un nouveau document basé
sur un modele, le document qui apparait est une
copie du modéle et non pas le modele lui méme.

Le modele par défaut

C'est celui sur lequel sont basés tous les
nouveaux documents que vous créez par la
commande Fichier > Nouveau.

Changer de modeéle par défaut

Vous pouvez remplacer le modéle d'origine par
l'un de vos modeles personnalisés, a condition
qu'il ait été enregistré dans l'un des dossiers
affichés dans la boite de dialogue Gestion des
modeéles.

Procédez comme suit :

1. Lancez la commande Fichier > Modéles >
Gérer ... pour ouvrir la boite de gestion des
modeéles.

2. Dans le volet dédié aux Modéles, sélectionnez
le dossier renfermant le modéle personnalisé
gue vous souhaitez utiliser, puis sélectionnez-
le.

3. Cliguez sur le bouton Commandes et
choisissez Définir comme modéle par défaut
dans la liste déroulante. Vous pouvez
€galement trouver cette commande dans le
menu contextuel du modéle choisi.

La prochaine fois que vous créez un nouveau
document par la commande Fichier > Nouveau,
il sera basé sur votre nouveau modéle par défaut.

Restaurer le modéle par défaut d'origine
Pour restaurer le modeéle par défaut d'origine :

— Ouvrez la boite de gestion des modéles par la
commande Fichier > Modéles > Gérer ...

—Cliquez sur le bouton Commandes et
choisissez Rétablir le modéle par défaut .

La prochaine fois que vous créez un document
par la commande Fichier > Nouveau le
document est a nouveau créé a partir du modéle
par défaut d'origine.

Choisir un modele personnalisé

Pour créer un nouveau document basé sur un
autre modéle que le modele par défaut, vous
devez utiliser la commande Fichier > Nouveau >
Modeles et documents. La boite Modéles et
documents s'ouvre pour vous permettre de choisir
un modele personnalisé disponible sur votre
systeme.

Modéles et documents - Documents X

1 =@ 5 @)=

Titre

Mes documents

L

Mon grdinateur

Madéles supplémentaires en ligne... 6

Editer 7 [ owr  J[ annuer ] [ aide

La boite se compose des éléments suivants :

Le volet gauche (1) affiche une série de dossiers
dans lesquels on peut rechercher le modéle a
utiliser. Par défaut, c'est le le dossier Modéles qui
est sélectionné et son contenu affiché dans le
volet central (2) de la boite, mais vous pouvez
également utiliser des modeles stockés dans le
dossier Mes documents.

Le volet central (2) affiche le contenu du dossier
sélectionné dans le volet gauche. Des boutons de
navigation (4) permettent de se déplacer dans
l'arborescence de ses fichiers.

Lorsqu'un modele se trouve sélectionné dans le
volet central (2), il s'affiche dans la zone de
prévisualisation de droite. Les boutons (5)
permettent deux modalités d'affichage : Apercu ou
Propriétés.

Les boutons (7), au bas de la boite permettent :

— Gérer
modéles

ouverture du gestionnaire des
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— Ouvrir : valide la commande une fois le modele
sélectionné dans le volet central. Un double clic
sur un modele affiché dans le volet central a le
méme effet. Le résultat est l'affichage dans
I'espace de travail d'une copie du modéle choisi
comme nouveau document.

— Annuler : referme la boite sans rien faire (on
renonce a la commande)

Créer un modele personnalisé

Vous pouvez créer vos propres modeles a partir
d'un document normal épuré de son contenu non
réutilisable et dans lequel vous ne conservez que
les styles utiles. Ce qui va transformer ce
document .odt normal en modéle est simplement
la maniere dont vous l'enregistrez. La commande
d'enregistrement est la suivante :

Fichier > Modéles > Enregistrer.

Cette commande ouvre la boite d'enregistrement
ci-dessous.

Modeles %]
| L [o]4 J
(e ]

Nouveau modéle

‘ Rapport

Modéles

Catégaries Madéles

Mes modéles Curriculum vitae
Arrigre-plans de présentation

Jocuments
Feuilles de calcul Lettre
Présentations Lettre dinfo

Mémo

1. Tapez le nom de votre nouveau modeéle dans
le champ intitulé Nouveau modéle.

2. Dans la liste Catégories, sélectionnez celle
dans laquelle vous souhaitez le ranger.

3. Cliqguez sur OK pour enregistrer le nouveau
modéle et l'ajouter a la liste des modéles
disponibles dans la catégorie choisie.

* Les modeles sont enregistrés dans un format
spécial, avec extension .ott (Writer), .ots (Calc),
.otp (Impress), .otg (Draw).

« |l est possible d'installer des nouveaux modeles
sous forme d'extensions a l'aide du Gestionnaire
des extensions.

« Par défaut, sous Windows XP, les modéles
d'origine du programme se trouvent dans :
C:\ProgramFiles\OpenOffice.org3\Basis\Share\tem
plate\ (dans le cas de 00.org 3).

Editer un modeéle existant

Vous pouvez éditer directement un modéle
existant pour en modifier le contenu et les styles.

1. Lancez la commande Fichier > Modéles >
Gérer.

2. Dans la boite qui s'ouvre accédez au modele
gue vous souhaitez modifier. Une fois le
modele affiché dans le volet central,
sélectionnez-le puis cliquez sur le bouton
Commandes et choisissez Editer dans la liste
déroulante.

3. Votre modele s'affiche alors dans la fenétre du
module capable de I'éditer et vous pouvez le
modifier.

4. Une fois les modifications réalisée, enregistrez
votre document comme modele par la
commande Fichier > Enregistrer dans la
barre des menus.

Il n'est pas possible d'éditer les modéles d'origine
du programme.

Actualiser un document

Vous pouvez répercuter les modifications
effectuées sur un modéle aux documents
antérieurs basés sur sa version précédente.

L'actualisation se limite cependant a une
réapplication des nouveaux styles, les modifications
de contenus du modéle modifié ne sont pas
répercutées lors d'une telle mise a jour.

Lorsque vous avez modifié un modéle et que
vous ouvrez un document basé dessus le
message suivant s'affiche :

IBM Lotus Symphony @

6 Le modele Chronological Resume. ott sur lequel ce document: est base, a &té modifie. Youlez-vous
mettre & jour la mise en Forme en Fonction des styles du modéle madifié 7

[ Mettre & jour les styles ] [ Conserver les styles précédents ] [ Aide ]

Vous avez alors le choix entre les deux
procédures suivantes :

— Cliquer sur le bouton Mettre a jour les styles
pour appliquer au document les styles modifiés
dans le modéle. Cela revient a actualiser votre
document sur le modéle modifié.

— Cliquer sur le bouton Conserver les styles
précédents si vous ne voulez pas appliquer a
votre document les styles qui ont été modifiés
au niveau du modeéle. En choisissant cette
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N

option, vous renoncez définitivement a
l'actualisation de votre document par le modéle
modifié. La boite de message ci-dessus ne vous
apparaitra plus.

Changer de modele

Vous pouvez lier l'un de vos modéles
personnalisés a un document existant basé sur le
modeéle par défaut. Dans ce cas, le document
adopte les propriétés de styles du nouveau
modeéle en remplacement de celles qui lui étaient
précédemment appliquées de par sa liaison au
modéle antérieur.

Pour pouvoir procéder de maniere simple, les
noms des styles appliqués devraient étre
identiques dans le document et le nouveau
modéle appligué. Comme c'est rarement le cas,
vous devrez souvent recourir a la fonction de
recherche et remplacement pour remplacer les
anciens styles par les nouveaux, une fois votre
document lié au nouveau modéle.

Procédez comme suit :

1. Lancez la commande Fichier > Nouveau >
Modéles et documents et choisissez le
modeéle a utiliser. Vous créez ainsi un nouveau
document basé sur le modéle avec lequel vous
souhaitez actualiser votre document.

2. Ouvrez ensuite le document que vous voulez
modifier, puis utilisez le raccourci Ctrl+A pour
le sélectionner intégralement.

3. Collez la sélection dans le nouveau document
créé a l'étape 1.

4. Enregistrez votre document sous un nouveau
nom.

5. Utilisez la commande de recherche et de
remplacement pour remplacer les anciens
styles par les nouveaux, si les noms des styles
sont différents.

6. Procédez au nettoyage de votre nouveau
document en supprimant des éléments hérités
du nouveau modele appliqué, s'ils ne vous
sont pas utiles.

Organiser les modeles

OpenOffice ne peut utiliser que des modéles
stockés dans des répertoires prévus a cet effet,
mais vous pouvez créer d'autres répertoires afin
d'organiser vos modeles de maniére thématique.

Il est également possible d'importer et d'exporter
des modéles.

Toutes les opérations de gestion des modéles se
font depuis la boite de dialogue Gestion des
modeéles qui s'ouvre par la commande Fichier >
Modeles > Gérer...

Les commandes de gestion possibles pour
I'élément sélectionné dans la boite (dossier ou
modele) sont présentes a la fois dans le menu du
bouton Commandes et le menu contextuel
associé a I'élément sélectionné (dossier ou
modele).

" Gestion des moddles o5

&= Gérer styles et modéles Fermer
Tutoriel Mise en forme

Nouveau Ins

(3 Arriére-plans de présentation Sans nom1
0 Présentations

Supprimer Suppr
Importer un modéle...
Parameétres de l'imprimante..

Actualiser

Carnet d'adresses...
E‘ Fichier...

[Modetes [z [pocuments

Importer un modéle

Si un modéle ne se trouve pas dans l'un des
dossiers de stockage de la boite Gestion des
modeéles, vous devez l'importer dans l'un de ces
dossiers avant de pouvoir l'utiliser. Pour importer
un modéle dans un dossier de modeles :

1. Dans la boite Gestion des modéles, désignez
le dossier dans lequel vous souhaitez importer
le modéle.

2. Cliguez sur le bouton Commandes et

choisissez Importer un modeéle .... Une
fenétre classique d'ouverture de fichiers
apparait.

3. Recherchez et sélectionnez le modele a
importer, puis cliquez sur Ouvrir. La boite
d'ouverture se referme et le modele se
retrouve dans le dossier sélectionné et vous
pouvez, au besoin le renommer avant de
valider par Enter.

Exporter un modele

Pour exporter un modéle depuis un dossier de
modeles vers un autre emplacement, par exemple
le dossier Mes documents :
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1. Dans la boite de dialogue Gestion des
modéles, double-cliquez sur le dossier
renfermant le modéle a exporter.

Sélectionnez le modele a exporter.

3. Cliquez sur le bouton Commandes et
choisissez Exporter le modeéle ... . La boite
d'enregistrement Enregistrer sous apparait.

4. Désignez le dossier cible vers lequel
I'exportation doit se faire, puis cliquez sur le
bouton Enregistrer.

n

L'exportation ne supprime pas le modele d'origine,
elle en crée simplement une copie a un autre endroit.

Supprimer un modeéle (personnalisé)

1. Dans la boite de dialogue Gestion de modéles,
double-cliquez sur le dossier qui contient le
modéle a supprimer. Une liste de tous les
modeéles contenus dans ce dossier apparait.

. Sélectionnez le modele a supprimer.

3. Cliguez sur le bouton Commandes et
choisissez Supprimer dans le menu déroulant.
Vous pouvez également procéder depuis le
menu contextuel du modéle a supprimer. Une
boite de message vous demande de confirmer
la suppression. Cliquez sur Oui.

N

Vous ne pouvez supprimer que des modeéles
personnalisés, jamais ceux fournis d'origine avec
OpenOffice.

Déplacer un modele
Pour déplacer un modéle dans un autre dossier :

1. Dans la boite de dialogue Gestion de modéles,
double-cliquez sur le dossier qui contient le
modéle a déplacer. Une liste de tous les
modéles contenus dans ce dossier apparait.

2. Cliquez sur le modéle a déplacer et faites le

glisser vers le dossier destinataire souhaité.

Créer un dossier de modeéles

Dans la fenétre du Gestionnaire de modeéles
sélectionnez un dossier quelconque, puis cliquez
sur le bouton Commandes et choisissez la
commande Créer. Un nouveau dossier intitulé
Sans nom est créé dans la liste des dossiers et
un curseur texte clignote a I'extrémité de l'intitulé.

Cliquez sur la touche Backspace pour supprimer
le nom d'origine, puis entrez le nom souhaité
avant de valider par Enter.

Le répertoire créé se place a la suite des dossiers
existants. Il n'est pas possible de le faire glisser a
l'intérieur d'un autre répertoire pour en faire un
sous-dossier de celui-ci.

Supprimer un dossier de modéles
Pour supprimer un dossier de modéles:

1. Dans la boite de dialogue Gestion de modéles,
sélectionnez le dossier a supprimer.

2. Cliguez sur le bouton Commandes et
choisissez Supprimer (ou utiliser le menu
contextuel du dossier). Une boite
d'avertissement vous demande de confirmer la
suppression. Cliquez sur le bouton Oui.
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Un tableau se compose de cellules organisées en
lignes et en colonnes. Il permet de disposer des
informations textuelles et numérigues en colonnes
et de les formater.

7.1. Créer un tableau

OpenOffice dispose d'une fonctionnalité de
tableau, accessible depuis Writer, Impress et
Draw, de I'une des maniéres suivantes :

— Commande de menu Insertion > Tableau...
ouvrant une boite de dialogue qui permet
d'insérer un tableau de taille définie (nombre de
lignes et de colonnes).

_ Bouton Tableau = ~ dans les barres d'outils
Standard et Tableau. Un clic sur l'icbne du
tableau ouvre la boite d'insertion de tableau. Un
clic sur le bouton fléché situé a sa droite affiche
une grille permettant de définir graphiqguement
la taille du tableau par pointage a l'aide de la

souris
RPN | 'K

4w 3
Le tableau créé est inséré :

A la position du point dinsertion dans un
document Writer car dans ce cas il est intégré a
la couche de texte.

1 1 1 1 1
1 1 1 1 1

Comme objet dans la page active d'un document
Impress ou Draw.

I N N

g | | |
Dans ce cas, on peut le déplacer a l'aide de la
souris en le "prenant” par sa bordure, comme un
simple objet graphique, I'agrandir ou le réduire en
le manipulant a la souris par ses poignées de
redimensionnement et méme le supprimer en
appuyant simplement sur la touche Delete.

Dans Writer, la fonctionnalité tableau est plus
élaborée, elle permet l'insertion de formules de
calculs, le tri, l'insertion d'images et méme de
tableaux a [l'intérieur de cellules. De plus, les
contenus peuvent étre formatés a l'aide de styles,
comme du texte normal.

Ces fonctionnalités supplémentaires seront décrites
en détails dans le manuel d'utilisation de Writer.

On se limitera ici a la description des manipulations
et fonctionnalités de base communes aux 3
modules : méthodes de création, saisie des données
et utilisation de la barre d'outils Tableau.

Lorsqu'un tableau vient d'étre créé, ou lorsqu'on
le sélectionne, la barre d'outils Tableau apparait
pour permettre de le manipuler.
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7.2. Saisir les données

Pour remplir une cellule, il suffit d’y placer le point
d’'insertion avant de taper la valeur qu’elle doit
contenir. La hauteur des lignes s'adapte
automatiquement lors de la saisie de données sur
plusieurs lignes dans des cellules.

5% 13% 445

Pour effacer le contenu de cellules sélectionnées,
appuyer sur la touche Delete. Les cellules sont
vidées de leur contenu mais pas supprimées du
tableau.

Copier ou déplacer des
contenus

Pour copier ou déplacer du texte

1. Sélectionner les cellules a copier ou a
déplacer, puis lancer la commande
correspondante depuis le menu contextuel de
la sélection.

2. Positionner le point d'insertion au nouvel
emplacement, puis lancer la commande de
collage.

Les copies ou déplacements de textes a la souris ne
sont possibles que dans les tableaux Writer.

Déplacer le point d'insertion au
clavier
Il est possible de déplacer, au clavier, le point

dinsertion de cellule en cellule ou méme a
I'intérieur d'une cellule contenant du texte.

— Tab : déplace le point d'insertion vers la cellule
suivante.

— Shift+Tab : déplace le point d'insertion vers la
cellule précédente.

— Home : le point d'insertion est déplacé au début
du contenu de la cellule courante

— End : déplace le point d'insertion a la fin du
contenu de la cellule courante

- Fleches horizontales déplacent le point
d'insertion dans la cellule courante, d'un
caractére vers la gauche ou la droite si le point
d'insertion se trouve a l'intérieur du texte, sinon,
passage a la cellule de gauche ou de droite.

- Fleches verticales déplacent le point
d'insertion vers la cellule supérieure ou
inférieure de la colonne courante.

7.3. Formater les données

La mise en forme des données s'effectue de
maniére classique : on les sélectionne, puis on
leur applique les commandes de formatage
nécessaires pour obtenir le résultat souhaité.

Barre Formatage de texte

Lorsqu'on sélectionne un tableau dans /mpress
ou Draw, la barre Formatage de texte apparait
automatiquement avec les principaux outils de
mise en forme des textes.

Notez la présence, dans la barre, de deux
boutons conduisant a l'ouverture des boites de
dialogue de formatage des caractéres et des

EA

Dans le cas de Writer, aucune barre d'outils
supplémentaire n'apparait, puisque le logiciel
affiche en permanence une barre Formatage avec
tous les outils nécessaires.

Il est bien s(r toujours possible de trouver toutes les
commandes de formatage de texte dans le menu
Format ou le menu contextuel d'une sélection.

paragraphes

Aligner le contenu des cellules

Le contenu des cellules peut étre aligné verticale-
ment et horizontalement.
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Alignement vertical
On le réalise a l'aide de boutons situés dans la

. =1 [ [E =
barre d'outils Tableau .

Alignement horizontal

On le réalise par lintermédiaire des boutons
classiques d'alignement de paragraphes situés
dans la barre Formatage de texte (Impress et
Draw) ou la barre d'outils de formatage de Writer.

7.4. Les sélections

Dans un tableau, on peut sélectionner une cellule,
une plage rectangulaire de cellules contigués, ou
encore une ligne ou une colonne complétes.

Lorsqu'une sélection est active, un clic avec le
bouton droit de la souris fait apparaitre un menu
contextuel répertoriant les commandes
applicables a la sélection courante. Ces
commandes peuvent concerner :

—la structure du tableau : insertion/suppression
de lignes ou de colonnes, modification de la
hauteur des lignes et de la largeur des
colonnes, affichage ou masquage de bordures,
couleur de fond du tableau, fusion ou
fractionnement de cellules etc.

— les données contenues dans le tableau : mises
en forme des caractéres et paragraphes,
effacement de données, etc.

Les méthodes de sélection décrites ci-dessous
permettent de sélectionner complétement des
éléments d'un tableau avec les données qui s'y
trouvent.

Une cellule

La sélection d’'une cellule se fait simplement en y
placant le point d'insertion, c’est la condition
requise pour pouvoir y entrer un contenu, quel
que soit son type.

Cette simple opération suffit également pour
indiquer au programme la ligne/colonne
renfermant la cellule et lui permettre de pouvoir
les supprimer, mais elle est insuffisante pour
travailler sur les données qui s’y trouvent : celles-
ci doivent étre sélectionnées a leur tour pour
gu’on puisse agir spécifiguement dessus.

Ligne ou colonne

Les deux méthodes ci-dessous sont générales et
fonctionnent dans tous les modules (Writer,
Impress et Draw) :

— Sélectionner, par un Cliquer-glisser a l'aide de la
souris I'ensemble des cellules de la ligne ou de
la colonne.

— Placer le point d’'insertion dans une cellule de la
ligne ou de la colonne a sélectionner, puis
lancer la commande contextuelle de sélection
de ligne ou de colonne selon le cas.

Plage de cellules
Procéder comme suit

1. Placer le point d’insertion dans la cellule située
a I'extrémité supérieure gauche de la zone a
sélectionner et ne pas relacher le bouton
gauche de la souris.

2. Faire glisser la souris jusqu’a la cellule située
a l'extrémité inférieure droite de la zone a
sélectionner.

3. Relacher le bouton gauche de la souris.

Vous pouvez maintenant agir globalement sur les
contenus pour les formater ou les effacer.

Tableau en entier

Sélectionner la premiére colonne / ligne puis
étendre, par un Cliquer-glisser, la sélection a
'ensemble des colonnes / lignes du tableau. Dans
ce cas, on sélectionne a la fois le tableau et son
contenu.

7.5. Modifier un tableau

On peut agir sur la structure d’'un tableau et en
modifier, par exemple, la hauteur des lignes et la
largeur des colonnes au clavier ou a l'aide de la
souris. |l est également possible de rajouter des
lignes et des colonnes et de fusionner/fractionner
des cellules.

Vous pouvez utiliser le tableau exemple ci-
dessous pour effectuer vos manipulations.

Répartition des
épargnants
selon situation
familiale 2008
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Célibataires Mariés Familles avec
enfant(s)
38% 18% 44%

Les commandes permettant de modifier la
structure d’'un tableau sont disponibles dans la
barre d'outils Tableau, qui s'affiche
automatiquement lorsqu'un tableau se trouve
sélectionné ou que le curseur de texte se trouve
placé a l'intérieur de l'une de ses cellules.

Largeur de colonnes et hauteur
des lignes

On peut modifier la largeur d’une colonne ou la
hauteur d’'une ligne a l'aide de la souris ou d'une
commande d'ajustement située dans la barre
d'outils Tableau.

A I'aide de la souris

Pointer juste sur la ligne de séparation entre 2
lignes/2colonnes puis procédez au
redimensionnement par un Cliquer glisser. On
peut également procéder depuis les regles en
manipulant les indicateurs de lignes/colonnes.

e

Modifier la largeur d’une colonne
-i~

PLEEETE e T e e R ,,.* e R e o ! S ) e

Ld

Modifier la hauteur d’'une ligne

A I'aide d'une commande d'ajustement
Lorsque plusieurs colonnes sont sélectionnées, le
B - .
bouton Optimiser de la barre d'outils
propose la commande Répartir les colonnes

réguliéerement pour leur donner une largeur
identigue. La commande Répartir les lignes

proportionnellement réalise la méme opération,
mais pour la hauteur des lignes sélectionnées.

Gérer les lignes et les colonnes

Les commandes a disposition dans la barre
d'outils Tableau correspondent aux boutons verts
pour les insertions et rouges pour les
suppressions.

E fE = B

Par défaut, les insertions de lignes et colonnes se
font aprés la ligne ou la colonne contenant le
point d'insertion.

Fusionner ou fractionner des
cellules

La fusion et le fractionnement de cellules sont des
opérations a ne réaliser qua la fin de la
construction d’'un tableau, une fois que toutes les
données sont saisies et qu'on est certain que le
nombre de colonnes ne doit plus étre modifié.

Fusionner des cellules

La fusion de cellules est spécialement utile pour
étendre le titre d'un tableau sur plusieurs
colonnes.

On commence par sélectionner les cellules a
fusionner (cellules en ligne ou en colonne) puis on

clique sur le bouton Fusionner les cellules ==
depuis la barre d'outils Tableau, ou on utilise la
commande contextuelle Cellule > Fusionner.

Scinder des cellules

C'est l'opération inverse de la précédente : on
sélectionne une cellule et on demande sa
scission.

Une boite de dialogue permet alors de choisir en
combien de cellules la scission doit se faire et si
elle doit se faire horizontalement ou
verticalement.

La commande de scission est disponible dans la
barre d'outils Tableau ou sous forme de
commande contextuelle.

7.6. Formater un tableau

Le formatage d'un tableau peut se faire
directement depuis la barre d'outils Tableau, ou
en passant par la boite de dialogue Formatage
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des cellules (Impress et Draw) ou son homologue
Format de tableau dans Writer. Ces boites de
dialogue s'ouvrent lorsqu'on clique sur le bouton

Propriétés du tableau dans la barre d'outils
Tableau.

La commande contextuelle Tableau permet
également I'ouverture de la boite de formatage des
tableaux.

A l'aide de la barre d'outils

La barre d'outils Tableau comporte 4 boutons
permettant de mettre rapidement en forme un
tableau.

=R - 2 -

Les deux premiers permettent de choisir un style
et une couleur de ligne.

Les deux derniers permettent de définir un type
d'encadrement et de lui choisir une couleur de
fond.

A l'aide de la boite de dialogue

Nous ne décrirons ici que la boite de formatage des
tableaux disponible dans Impress et Draw. Celle qui
s'ouvre dans Writer, plus complete, sera décrite
dans le manuel de Writer.

La boite se compose de 4 onglets : Police, Effets
de caracteres, Bordures et Arriére-plan.

Police

Formater les cellules [ZJ

Police | Effets de caractéres | Bordures [ Arrigre-plan |

Langue

"% Frangais (Suisss) W

La méme police est utilisée pour limpression et ['affichage & 'écran,

Arial

L [o]4 J[ Annuler ][ Aide J[ Retablir J

L'onglet permet de choisir la police de caractére a
utiliser, son style, ainsi que la taille des caractéres

a utiliser pour formater les

sélectionnées.

Effets de caractéres

Folice |Effets de caractéres |Eordures " Arrigre-plan ‘

Couleur de police Surlignage
1 Autarnatique v |(Sans)

Barré

Couleur de surlignage

L | ||:| Autornatique

(Sans) “
Relief Soulignage Couleur de soulignage
|(Sans) v | |(Sans) v | ||:| Automatique
|:| Contour Mok par rnok
[ ombre
Bordures
Disposition des lignes Ligne ———————————— Espacement avec le contenu ——
I.?'ar défaut Style Gauche
E 2] —
i = e . ¥
Defini par l'utilisateur 0.50pt = |
toope 5 | s
2,50 pt
4,00 pt Bas 0.13cm &
Synchroniser
Couleur
||:| Blanc v |

Cet onglet permet de définir des bordures pour le
tableau, ou une plage sélectionnée, ainsi que
'écart a maintenir entre les données et les
bordures des cellules.

Si l'option Synchroniser est cochée, l'espacement
que vous définissez sera uniformément appliqué
aux 4 bordures de la cellule.

Des bordures prédéfinies sont a disposition, mais
il est également possible de les définir au coup
par coup en les sélectionnant dans une
représentation miniature de tableau.

Arriére-plan

La définition d’'un arriere-plan peut améliorer la
lisibilité des données, en mettant en évidence les
plages importantes. On peut lappliquer a
I'ensemble du tableau, ou seulement a des lignes
ou des plages de cellules.

On peut choisir parmi 4 types d'arriére-plan :
couleur, dégradé, hachure ou bitmap.

En fonction du choix effectué, la boite se modifie
pour permettre de paramétrer le type de fond
choisi.
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Ce chapitre traite des champs et des liens, qui
sont des zones de texte spéciales qu'on peut
insérer dans un document Writer, une cellule de
feuille de calcul, ou comme objets texte dans
Impress et Draw.

8.1. Hyperliens

Un lien hypertexte (ou hyperlien) est une zone
de texte particuliere permettant d'atteindre,
lorsqu'on clique dessus, l'un des éléments
suivants :

— Un fichier.
— Un emplacement dans un fichier.

— Une page Web (sur le Web ou sur un intranet),
un site FTP, ou Telnet.

— Une adresse de messagerie ou de groupe de
discussion

Un lien se compose de deux éléments : un texte
et une adresse sous-jacente.

Insérer un hyperlien
Il est possible de procéder de trois fagons :

— Saisie directe au clavier. Dans Impress et Draw,
la saisie doit se faire dans un objet de texte en
mode édition.

— Depuis la boite de dialogue Hyperlien.
— Depuis la Barre d’hyperlien.

Saisie directe au clavier

Pour insérer directement une URL a la frappe, il
suffit de I'entrer au clavier et de la faire suivre d'un
espace : TURL entrée recoit alors
automatiquement les attributs de lien (couleur et
soulignement) prévus par le programme.

Si vous ne voulez pas que le programme
convertisse I'URL entrée en hyperlien, utilisez la
commande contextuelle Supprimer ['hyperlien
ou appuyez sur la combinaison de touches Ctrl+Z
immédiatement aprés que le formatage a été

appliqué.

Si la conversion en hyperlien ne se produit pas, vous
pouvez activer cette fonctionnalité par la
commande Outils > Options d’AutoCorrection -
Options en cochant dans la liste des options
Détecter les URL.

Pour changer la couleur par défaut appliquée aux
hyperliens dans tous les modules de OpenOffice,
utilisez la commande Outils > Options >
OpenOffice.org > Apparence, puis sélectionnez
les options Liens visités et Liens non visités et
indiquez la couleur souhaitée avant de valider par
OK.

Lorsqu'un hyperlien pointe vers un fichier local,
|'adressage peut étre relatif ou absolu.

* Un lien hypertexte absolu contient I'adresse
compléte de la cible vers lequel il pointe.

* Un lien hypertexte relatif contient le chemin
d'acces au fichier pointé, mais défini a partir du
répertoire ol se trouve stocké le document dans
lequel I'hyperlien est inséré.

Boite Hyperlien

Vous pouvez insérer et modifier des liens depuis
la boite de dialogue ci-dessous.

Pour activer un hyperlien, c'est-a-dire atteindre,
I'adresse vers laquelle il pointe, il suffit de cliquer
dessus.

Dans Writer, il faut procéder en maintenant Ia
touche Ctrl enfoncée. La procédure est rappelée
dans une infobulle chaque fois que I'on pose le
pointeur de la souris (sans cliquer) sur un hyperlien.

Un lien hypertexte possede un menu contextuel
comprenant des commandes pour I'ouvrir, I'éditer,
le copier ou le supprimer.

Hyperlien |£\
Type dhyperlien
® web ([@]5:] O Telnet
Internet. Gible “ .,l
2 (e]
Mail B News
e Paramétres supplémentaires
Texte \ \
$EL
= Horn \ \
houveau
cocumert e e N

Cette boite s'ouvre ouverte par la commande
Insertion > Hyperlien ou le bouton commande

Hyperlien =1 dans la barre d'outils Standard.
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Pour convertir un texte en lien, le sélectionner
avant d'ouvrir la boite de dialogue Hyperlien.

1. Dans le volet gauche de la boite, choisissez le
type d’hyperlien a créer :

— Internet : choisissez entre Web, FTP ou Telnet.
Dans le cas d'une adresse FTP, deux champs
supplémentaires apparaissent pour permettre
la saisie d'un identifiant et d'un mot de passe.

— Mail & News : pour insérer une adresse email
ou celle d'un forum auquel on est abonné.

— Document : pour insérer le chemin conduisant
au fichier a ouvrir. Le bouton Cible dans le
document permet de préciser I'endroit
particulier du document vers lequel pointera le
lien.

— Nouveau document I'hyperlien crée un
nouveau document dont vous devez indiquer le
chemin de sauvegarde (bouton Sélectionner
un chemin). Deux boutons radio apparaissent
pour demander s'il faut procéder directement a
I'édition du nouveau document ou la différer.

2. Dans le champ Texte, saisissez le texte qui
apparaitra a l'endroit ou I'URL sera insérée. Si
une sélection de texte était active avant
l'ouverture de la boite, elle est automatiquement
reprise comme intitulé de I'URL dans le champ
Texte.

3. Dans le champ Cible, tapez 'URL & atteindre
ou le chemin au fichier a ouvrir, selon le type
d'hyperlien a créer. Vous pouvez vous aider des

boutons Navigateur Web et Cible dans le
@

document . pour indiquer votre cible.

4. Définir la valeur du Cadre permet d'indiquer
comment I'hyperlien doit s'ouvrir. Cela s'applique
aux documents qui s'ouvrent dans un navigateur
Web.

5. Formulaire : spécifier si le lien doit s'afficher
comme texte ou sous forme de bouton.

6. Bouton Evénements : ce bouton doit étre
activé pour permettre au programme de réagir
aux événements pour lesquels I'utilisateur a écrit
du code (macro).

7. Champ Nom : s'applique aux documents HTML
et permet dindiquer le texte qui sera ajouté

comme attribut nom dans le code HTML de
I'hyperlien.

8. Cliquez sur Appliquer pour valider l'insertion.

9. Cliquez sur le bouton Fermer pour refermer la
boite de dialogue.

Si vous devez créer plusieurs liens, vous pouvez
maintenir la boite de dialogue ouverte jusqu'a la fin
de votre travail d'édition.

La Barre Hyperlien

Lancez la commande Affichage > Barre d'outils

> Barre d'hyperlien pour faire apparaitre la barre

au dessus de I'espace de travail.

== ] - fpowedcoace Flo-lw-x-
1 2 3 4 5

1. Dans le champ Nom de I'URL, saisissez le
texte qui apparaitra a l'endroit ou I'URL sera
insérée. Si une sélection de texte est active, elle
est automatiquement reprise comme intitulé de
'URL.

2. Tapez ou collez I'adresse a atteindre.

3. Définir le cadre cible dans la liste déroulante
associée au bouton.

4. Choisir entre l'insertion sous forme de texte ou
de bouton.

5. Le bouton Rechercher propose une liste de
moteurs de recherche permettant d'atteindre la
cible dont I'URL sera recopiée dans le lien a
construire.

Editer un hyperlien existant

Dans un document Writer

Pour éditer un lien hypertexte, cliquez quelque
part a l'intérieur, puis ouvrir sa boite de dialogue
d'édition en cliquant sur le bouton Hyperlien dans
la barre d'outils Standard ou en lancant la
commande contextuelle Editer > Hyperlien.

Si vous devez éditer plusieurs hyperliens, vous
pouvez maintenir la boite de dialogue ouverte
jusqu'a la fin de votre travail d'édition. Veillez a
bien cliquer sur le bouton Appliquer apres
chaque édition et ne cliquez sur le bouton Fermer
gu'une fois le travail complétement terminé.

Vous pouvez aussi éditer un lien depuis la Barre
d'hyperlien.

© 2012 - 2013 G. Waterval

Version : 26/04/13

0004Kids - Apache OpenOffice - OOoLight

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

Apache licence, Version 2.0

79/102



http://wiki.ooolight.org/index.php/Main_Page/fr
http://openoffice.apache.org/
http://wiki.ooo4kids.org/index.php/Main_Page/fr
http://www.apache.org/licenses/LICENSE-2.0

8.Hyperliens et champs

Dans Impress ou Draw (objet lien)

Y

Pour sélectionner I'hyperlien a modifier, utilisez
I'une des méthodes suivantes :

— Cliquez simplement dessus en maintenant la
touche Alt enfoncée : des poignées de sélection
apparaissent et I'objet peut alors étre manipulé
et déplacé a l'aide de la souris.

— Cliquez dessus avec le bouton droit de la souris.

Une fois l'objet  hyperlien  sélectionné,
sélectionnez son texte pour le rendre éditable et
appelez la commande Insertion > Hyperlien ...
ou cliquez sur le bouton Hyperlien dans la barre
d'outils Standard pour ouvrir la boite Hyperlien et
procéder aux modifications.

B esenutes FAD B

[ RS R LA

Objet hyperlien sélectionné

o i
H ssolrces FAD fé
g”/////////////////////////;’:

Hyperlien en mode édition

8.2. Les champs

Les champs sont des zones de texte spéciales
qui permettent d'insérer :

— des informations variables dans le temps et dont
la valeur exacte n'est pas connue au moment
de la frappe (informations relatives a la
pagination d'un document, date du jour, etc.) ;

— des informations générales sur le document :
nom de l'auteur, nom et chemin d'acces au
fichier de sauvegarde, etc.

L'insertion d'informations sous forme de champs
permet leur actualisation automatique lorsque des
changements interviennent.

La commande Insertion > Champs propose une
liste de champs insérables d'un seul clic : Date,
Heure, Numéro de page, Nombre de pages, Titre,
Auteur, etc. Une fois insérés, les champs peuvent
étre édités ou mis a jour par la commande
Editon > champs ou son homologue
contextuelle.

Pour convertir le contenu d'un champ en texte,
effectuez une copie du champ puis collez-le comme
texte brut par la commande Edition > Collage

spécial > Texte non formaté.

Dans Writer

Les champs se comportent comme des blocs de
texte normaux qui peuvent étre formatés,
déplacés, recopiés ou encore supprimés comme
du texte normal.

On les utilise également pour insérer des
références a des éléments d'un document : Titres,
notes de bas de page, etc. (renvois) ou encore
pour insérer du texte conditionnel uniquement
visible ou imprimé sous certaines conditions,
comme les passages de texte qui doivent étre
adaptés au genre du destinataire, dans le cadre
d'un publipostage, par exemple.

Dans Impress et Draw

Les champs se comportent comme des objets de
texte qui peuvent étre formatés, déplacés,
recopiés ou encore supprimés comme des objets
texte normaux.

Actualiser le contenu des
champs

Par défaut, les champs d'un document ne sont
pas réévalués automatiquement, mais
systématiquement au lancement d'une
commande d'impression ou a l'ouverture du
document.

© 2012 - 2013 G. Waterval

Version : 26/04/13

Apache licence, Version 2.0

0004Kids - Apache OpenOffice - OOoLight

Des solutions libres et gratuites pour votre bureautique privée et professionnelle

80/102



http://wiki.ooolight.org/index.php/Main_Page/fr
http://openoffice.apache.org/
http://wiki.ooo4kids.org/index.php/Main_Page/fr
http://www.apache.org/licenses/LICENSE-2.0

9.L'insertion d'objets

9. L'insertion d'objets

9.L'insertion d'objets........cccociii 81
9. 1.LaGallery....ccceviieeeeieeeeeeeee e 81
La fenétre de la Gallery...........cccvvvvveveennns 81
Insérer un objet de la Gallery ................... 82
Créer un nouveau théme ......................... 82
Ajouter les objets d'un document.............. 83
Importer des objets .......ccoovvveieviiiiiiiiinnn. 83
Créer un théme exportable....................... 83
Importer un théme extérieur...................... 84
9.2.Les images vectorielles.............ccccvvveeen. 84
Les outils de la barre Dessin..................... 84
Du texte dans une forme............ccccovinnnne 85
Redimensionner une forme....................... 85
Options de disposition.............cccvvvveeeeeennnes 85
Options de retournement..............ccceevueee. 86
Grouper des formes..........cccceeeviiieeiiieeinnnns 86
9.3.Les objets FONtWOrK..........ccccvvveeeeeiiienneenn. 86
Créer un objet Fontwork...........ccccccceeeenne. 86
Bordure de sélection .............ccciieiieennns 87
Editer |e teXte ....cocveeeveeeeee e, 87
Formater un objet Fontwork...................... 87
9.4.Les images bitmap.........cccceeeeeviiiiiennneenn. 87
Modalités d'insertion.............cccevvveveeerennee. 87
Redimensionner une image...................... 88
Recadrer une image..........occveeeeeicineeeennne 88
Alignement horizontal et vertical............... 89
Faire tourner une image...........cccccvvveveeenns 89
Options de diSposition............cccuvvvveeeeeennne 89
Options de retournement..............ccceevueee. 90
Formater les images........cccocceevevnennnnnnnnne 90
Barre d'outils Image..........cccccevvvviinienennnn. 90
9.5.Image réactive..........cccceevieeeiiiiiiiiiieeee, 91
9.6.Les diagrammes.........c.ccoevevereiieieieicee 91
Insérer un graphique............cccceccceeeeeeeennn, 92
Accéder aux commandes...........cccceeeeenneee 92
La Table des données...........cccccvveveeeennnee 93
Changer de représentation....................... 93
Modifier les éléments internes.................. 94
Ajouter des dessinS.......cccvveeeeeieeeeeiiiieeen, 96
Graphiques 3D.......ccccciiieiii 96
9.7.0bjets multimedia..............ooeeevvvvvviviinnnnnn. 97
9.8.0bjets OLE.....ccooiiiieeiiieii, 97

Ce chapitre décrit les différents objets insérables
dans tous les types de documents.

Un objet est un élément qui n'est pas du texte (mais
qui peut en contenir). Appartiennent a cette
catégories les images vectorielles et bitmaps,
cadres, formules, objets OLE, diagrammes, etc.

9.1. La Gallery

Dans OpenOffice, I'outil Gallery permet de gérer
et d'organiser l'accés, non seulement aux cliparts
classiques, mais aussi a tous les objets
graphiques (logos, par exemple) et multimédias
utilisés fréquemment dans les documents. L'outil
est a disposition des modules Writer, Calc,
Impress et Draw.

Dans la fenétre de la Gallery, tous ces objets
peuvent étre classés en différents themes dans
lesquels ils sont représentés par une vignette
pointant sur le fichier correspondant, qui peut étre
stocké sur le disque, un intranet ou méme un
CDROM.

Les cliparts sont de petites images prétes a I'emploi
destinées a illustrer des documents (annonces,
diaporamas, logos dans les en-tétes de lettres ou sur
les enveloppes, etc.). lls peuvent avoir différentes
tailles et sont généralement aux formats JPEG, GIF
ou PNG.

Certaines bibliotheques de cliparts sont librement
utilisables. C'est le cas de ceux fournis par le site
http://openclipart.org/

Les cliparts sont regroupés en bibliotheques ou
themes correspondant a différents domaines
paysages, cartes géographiques, personnalités,
batiments, etc.

La fenétre de la Gallery

La commande Outils > Gallery, ou le bouton =]
Gallery dans la barre d'outils Standard activent et
désactivent l'affichage de la fenétre de la Gallery
sous la zone de commandes.

Dans AOO 4.0 un acces a la Gallery est également
possible depuis la barre latérale (Sidebar).

La fenétre de la Gallery affiche ses objets
regroupés en théemes (catégories) qu'on peut
renommer, actualiser, et méme supprimer (s'il
s'agit de thémes personnalisés) a l'aide des
commandes présentes dans leur menu
contextuel.

— La fenétre peut étre agrandie en hauteur et en
largeur a I'aide de la souris.

— On peut la masquer (sans la refermer) pour
récupérer de l'espace d'affichage, en cliquant
sur le bouton rectangulaire central situé a la
base de sa fenétre ==== lorsqu'elle est
disposée horizontalement.
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9.L'insertion d'objets

- On peut refermer la Gallery en relancant une Insérer un objet de la Gallery
nouvelle fois la commande qui a servi & l'ouvrir

(commande interrupteur). L'insertion d'un objet de la Gallery dans le

document actif, au point d'ancrage souhaité, peut
o se faire sous forme de copie ou de lien. Deux
méthodes sont possibles :

[ (=

— Par un simple Cliquer-glisser de I'objet depuis
la fenétre de la Gallery jusqu'au point d'ancrage
souhaité dans le document. Une telle procédure
insére une copie de I'objet, comme en témoigne
la forme adoptée par le pointeur de la souris au

1. Bouton daccés a la boite de dialogue cours de [lopération. Si vous procédez en
Propriétés de Nouveau théme, pour la création maintenant les touches Shift et Ctrl enfoncées,
de nouveaux thémes et lintégration de vous insérez un lien vers l'objet et non I'objet lui-
nouveaux cliparts. méme, comme le montre la forme adoptée par

2. Volet affichant, le contenu du théme le pointeur de la souris & cette occasion.
sélectionné dans la liste des thémes (a — En ouvrant d'un clic droit le menu contextuel du
gauche). En haut a gauche de ce volet, deux clipart a insérer, puis en choisissant la
icones permettent de sélectionner un type commande contextuelle Ajouter > Copier ou
d'affichage : sous forme d'icbnes ou de liste Lien si vous souhaitez une insertion sous forme
détaillée. Lorsqu'on clique sur un objet, son de lien et non lintégration de l'objet dans le
nom et son chemin d'acces s'affichent dans la document.
partie supérieure de la fenétre : : —

. . R . . * Les objets de type dessin sont systématiquement

3. Volet affichant la liste des themes disponibles. insérés comme copies.

Un clic droit sur lI'un des thémes disponibles . Les images bitmaps sont insérées comme copies
affiche les commandes permettant de le ou comme liens, c'est a |'utilisateur d'en décider.
manipuler. « Les objets multimédias sont systématiquement

insérés sous forme de liens.

* Les themes représentés par une icbne rouge

|E sont les thémes fournis d'origine avec le Créer un nouveau theme
programme ou des thémes extérieurs que vous

avez installés. lls se trouvent dans le répertoire Pour créer un nouveau theme :

Gallery du programme. Depuis la fenétre de la 1. Cliquez sur le bouton Nouveau Théme ... au-
Gallery, vous ne pouvez pas les modifier ni les dessus de la liste des themes existants. La
supprimer. boite Propriétés de Nouveau Théme s'ouvre.

2. Dans l'onglet Général donnez un nom au
nouveau théme.

3. Dans l'onglet Fichiers recherchez les fichiers a
intégrer comme liens dans le nouveau theme,
puis cliquez sur le bouton Ajouter.

* Les thémes représentés par une icbne verte =
, comme Mon théme, sont vos themes
personnalisés, vous pouvez les supprimer, les
compléter, y supprimer des objets et les
renommer a tout moment. lls se trouvent

stockés dans le sous répertoire Gallery de votre 4. Validez la création du theme par OK. Le
dossier de profil. nouveau théme se rajoute a la liste. Une icbne
4. Vous pouvez masquer la fenétre de la Gallery verte signale qu'il s'agit d'un theme utilisateur.
(sans la refermer) en cliquant sur le bouton Le nouveau théme créé est enregistré dans le
=== pour récupérer de I'espace d'affichage. répertoire Gallery du dossier de votre profil
utilisateur, sous forme de 3 fichiers : sgxx.sdg;
Aucune fonctionnalité de recherche n’est disponible sgxx.thm; sgxx.sdv, ol xx représente un numéro
pour accéder a un objet donné, il faut procéder identique apparaissant dans le nom des 3 fichiers.
manuellement en parcourant le contenu du ou des Le chemin conduisant a ce répertoire est indiqué
thémes ol on pense que se trouve I'objet recherché. dans Outils > Options ... > OpenOffice >
Chemins (entrée Gallery).
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9.L'insertion d'objets

Ajouter les objets d'un
document

Pour ajouter dans un théme utilisateur de la
Gallery, par simple Cliguer-glisser, des images ou
dessins présentes dans le document ;

1. Sélectionnez le theme de la Gallery dans lequel
I'image doit étre ajoutée.

2. Positionnez le pointeur de la souris au-dessus
de l'image a ajouter, sans cliquer.

— Si le pointeur de la souris prend la forme
d'une main avec un index pointé, un lien
hypertexte est associé a l'image. Dans ce cas,
vous devez cliquer sur l'image en appuyant
sur la touche Alt pour la sélectionner sans
activer le lien sous jacent.

— Si le pointeur de la souris ne change pas
lorsqu'il est placé sur limage, cliquez
simplement sur I'image pour la sélectionner.

3. Cliguez une seconde fois sur [limage
sélectionnée a l'étape précédente, puis faites-la
glisser dans le théme choisi.

* Les dessins sont directement intégrés dans le
théme de destination.

- Les images bitmaps sont enregistrées sous forme
de fichiers au format .png dans un sous répertoire
dragdrop du dossier Gallery du profil de
I'utilisateur et un lien est créé vers elles dans le

theme dans lequel on les a placées.

Importer des objets

Pour importer, sous forme de liens, des fichiers
présents sur vos disques dans la Gallery,
procédez comme suit:

1. Choisissez le theme a compléter et cliquez
dessus avec le bouton droit de votre souris
pour accéder a sa commande contextuelle
Propriétés ....

2. Dans la boite de propriétés qui s'ouvre
accédez a l'onglet Fichiers puis cliquez sur le
bouton Recherche de fichiers.

3. Une boite d'ouverture de fichiers apparait et
vous pouvez alors indiquer le répertoire
contenant les fichiers images a ajouter dans le
théme.

4. Une fois votre répertoire sélectionné, cliquez
sur le bouton Sélectionner pour afficher la
liste de ses fichiers. Vous pouvez filtrer cette

liste et limiter son affichage a un type de fichier
bien précis en utilisant le menu déroulant Type
de fichier.

5. Il vous reste maintenant a ajouter tous les
fichiers en cliquant sur le bouton Ajouter tout
ou sélectionner dans la liste seulement ceux
que vous souhaitez importer avant de cliquer
sur le bouton Ajouter.

6. Votre liste de fichiers est maintenant
composeée. Il vous reste a cliquer sur le bouton
OK pour réaliser l'importation, sous forme de
liens, des fichiers choisis.

Pour sélectionner plusieurs fichiers, maintenez la
touche Ctrl enfoncée en cliquant sur chaque fichier.

Créer un theme exportable

Vous pouvez créer un théme sous forme d'archive
.zip pour le fournir a un tiers. Procédez comme
suit en respectant bien la chronologie des étapes
ci-dessous.

1. Sivous souhaitez intégrer des images bitmaps
a votre theme, rendez-vous dans le répertoire
Gallery de OpenOffice pour les insérer dans un
nouveau répertoire que vous pouvez nommer
avec le nom du théme & créer.

2. Créez votre théme par la commande Nouveau
théme ... de la fenétre de la Gallery. Comme
le signale la boite de création, I'emplacement
du fichier correspondant a votre nouveau
théme se trouve dans votre profil utilisateur
file:///[Users/Votre_nom/AppData/Roaming/Ope
nOffice/4/user/gallery/sg46.sdg, par exemple.

3. Pour intégrer les images bitmaps installées au
cours de la premiére étape, utlisez la
commande Propriétés dans le menu
contextuel de votre theme. Pour intégrer des
dessins vectoriels, les réaliser dans Draw, puis
les faire simplement glisser dans votre theme.

4. Déplacez maintenant les 3 fichiers sgxx.sdg;
sgxx.thm; sgxx.sdv du répertoire gallery de
votre dossier de profil a celui d'OpenOffice.

5. Quittez OpenOffice, puis redémarrez-le. Votre
nouveau théme devrait apparaitre dans la
fenétre de la Gallery.

6. Créer une archive .zip avec les 3 fichiers
correspondant a votre nouveau théme et le
répertoire contenant les images que vous avez
intégrées au theme.
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9.L'insertion d'objets

Importer un theme extérieur

Procédez comme suit pour installer un théme
extérieur fourni sous forme d'archive .zip :

1. Quittez complétement OpenOffice.

2. Téléchargez le fichier .zip du theme a importer,
puis décompressez-le. Vous y trouvez 3
fichiers : sgxx.sdg; sgxx.thm; sgxx.sdv, ou Xx
représente un chiffre identique apparaissant
dans le nom des 3 fichiers.

3. Dans votre explorateur de fichiers allez a:
C:\ProgramFiles\OO\Basis\share\gallery\  qui
représente le chemin conduisant au répertoire
Gallery de OpenOffice (pas celui figurant dans
votre dossier de profil utilisateur) et vérifiez
gue le numéro apparaissant dans les 3 fichiers
du theme a importer n'est pas déja utilisé dans
les 3 fichiers correspondant a un théme déja
en place dans la Gallery.

* Si ce nest pas le cas, vous pouvez
directement transférer les fichiers de votre
nouveau théme dans le dossier Gallery

* Si cest le cas, vous devez dabord
renommer vos 3 fichiers en leur attribuant un
autre numéro avant de les transférer dans le
répertoire Gallery, pour éviter d'écraser un
théme existant.

4. Relancez OpenOffice : vous devriez trouver
votre nouveau théme dans la Gallery avec son
contenu. Il devrait étre précédé d'une icdne
rouge indiquant qu'il s'agit d'un théme installé
dans le répertoire Gallery du programme et
non dans celui de votre répertoire de profil.

9.2. Les images vectorielles

Ce sont des images définies par une série de
lignes ou de polygones, qui peuvent subir sans
dommage des transformations géométriques
(agrandissements, etc).

On les emploie surtout pour les dessins
techniques, les cartes, les logos et schémas

destinés & [limpression, car on peut les
redimensionner a volonté sans perte de qualité.

Appartiennent a cette catégorie les objets
Fontwork, les cliparts vectoriels, ainsi que les
formes de base ou les dessins tracés a l'aide de
la barre d'outils Dessin ou d'un logiciel tiers de
dessin vectoriel, comme le module de dessin

Draw de OpenOffice, ou un logiciel externe
comme Inkscape.

Les dessins se manipulent comme les autres
graphismes (position et taille, disposition, choix du
type de ligne et de remplissage, etc.). lls peuvent
étre regroupés pour fixer leur position relative et
leurs proportions avant d'étre intégrés dans un
document.

Les commandes les plus utiles pour manipuler les
dessins sont toujours regroupées dans leur menu
contextuel.

Les outils de la barre Dessin

L'affichage de cette barre d'outils est contrblé par
la commande Affichage > Barres d'outils >
Dessin. Par défaut, elle se place au bas de
I'écran, juste au-dessus de la barre d'état du
module actif mais on peut bien sOr décider de la
placer ailleurs.

Cette barre permet de réaliser directement dans
un document des graphismes simples a partir de
formes prédéfinies telles que rectangles, cercles,
lignes, etc.

Les fonctions disponibles sont les suivantes :

1 2 3 4 5 67

h /| =e<eT®

- @-w-E-P-k- ow®

8 9 10 11 12 13 14 15 16 17
1. Sélectionner 10. Fleches pleines
2. Ligne 11. Organigrammes
3. Rectangle 12. Légendes
4. Ellipse 13. Etoiles
5. Ligne a main levée 14. Points
6. Texte 15. Galerie Fontwork
7. Légende 16. A partir d'un fichier
8. Formes de base 17. (Dés)activer I'extrusion
9. Formes des symboles

La barre Dessin de Impress et Draw dispose de
fonctionnalités supplémentaires non présentes
dans celle de Writer et Calc qui ne dispose que
de fonctions de dessin élémentaires.

Pour utiliser un outil de la barre Dessin :
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9.L'insertion d'objets

1. Cliquez dans le document a I'endroit d'insertion
(dans un document Writer, vous pourrez
modifier le point d'ancrage plus tard, si vous le
souhaitez). Dans Impress et Draw, I'opération
se limite a désigner la page dans laquelle la
forme doit étre insérée.

2. Sélectionnez l'outil a utliser dans la barre
d'outils Dessin. Le pointeur de la souris prend
la forme d'une croix.

3. Effectuez un Cliquer-glisser pour réaliser le
tracé de la forme, puis relachez le bouton de la
souris une fois le tracé terminé. Dans Writer et
Calc, l'outil de dessin utilisé reste actif et vous
pouvez enchainer avec le tracé d'un autre
objet du méme type Pour désactiver la fonction
de dessin utilisée, appuyez sur la touche
Escape ou cliquez sur l'outil Sélectionner
(premier bouton de la barre d'outils Dessin).
Dans Impress et Draw, vous basculez
automatiquement en mode sélection apres le
tracé d'une forme.

Une fois le dessin créé, vous pouvez directement
le déplacer, le redimensionner a la souris, ou
modifier ses propriétés (couleur de remplissage,
type de ligne, etc.) en utilisant ses commandes
contextuelles, ou la barre d'outils Ligne et
remplissage (Draw et Impress) ou Propriétés de
I'objet de dessin (Calc et Writer) qui apparait
automatiquement lorsqu'un objet dessin est
sélectionné.

tigne et remplissage v x
f =~ |—» [voom )] (MGis )
A |Couleur Vll:l Eleu 9 V| =h

Du texte dans une forme

~ Endouble
cliquant sur une forme dessinée, un
curseur texte apparait a l'intérieur et il est
possible d'y saisir du texte. Si l'option Aligner au

contour est active, les bords latéraux de la forme se
comportent comme les marges d'une page et le

texte peut étre saisi comme du texte

normal.

4

Lorsqu'une forme se trouve en mode édition, une
barre doutils de formatage de texte apparait
automatiquement avec les outils nécessaires a la
mise en forme de texte.

— Dans Writer, c'est la barre Objet de texte qui
apparait.

— Dans Impress, Draw et Calc, c'est la barre
d'outils Formatage du texte qui apparait.

‘Arial IZH ‘1 E“

K £ | A e A -

On trouve dans ces barres des commande
directes de formatage des caractéres et des
paragraphes, ainsi que les commandes d'acces
aux boites de dialogue Caractére et Paragraphe
(entourées en rouge dans le screenshot ci-
dessus).

(]
~
7]
=
1]

e= ==
o= &=

Redimensionner une forme

Les techniques de redimensionnement utilisées
pour les images bitmaps s'appliquent également
aux formes dessinées.

On commence par sélectionner l'objet, puis on le
redimensionne par un Cliquer-glisser sur l'une
des huit poignées de redimensionnement
apparaissant sur sa bordure de sélection.

Pour un redimensionnement a I'échelle, on utilise
l'une des poignées d'angle en maintenant la
touche Shift enfoncée pendant I'opération.

Pour un contréle plus fin du redimensionnement,
on utilise la commande de menu Format >
Propriétés > Position et Taille, ou la commande
contextuelle correspondante, qui toutes deux
ouvrent une boite permettant de définir la largeur
et la hauteur de facon indépendante. Si I'option
Proportionnel est sélectionnée, le
redimensionnement s'effectue sans distorsion.

Options de disposition

Les options de disposition, disponibles dans le
menu Format ou le menu contextuel de la forme,
gérent le chevauchement des objets qui
s'empilent dans l'ordre inverse de leur création.
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9.L'insertion d'objets

1. Envoyer a l'avant: le graphisme se retrouve
placé au dessus du texte et de tous les objets
graphiques, c'est a dire a I'avant-plan.

2. Envoyer vers l'avant. remonte l|'objet d'un
niveau dans la pile. En fonction du nombre de
niveaux d'objets existants, vous pouvez étre
amené a répéter un certain nombre de fois la
commande pour obtenir le résultat souhaité.

3. Envoyer vers l'arriére redescend d'un
niveau vers le bas l'objet sélectionné dans la
pile.

4. Envoyer a l'arriéere : descend le graphique
sélectionné tout en bas de la pile. Le texte du
document et les objets insérés sont alors tous
au-dessus de lui.

5. A l'arriere-plan/ Au premier plan: cette
option, disponible dans Writer et Calc permet
de placer un dessin en avant-plan ou en
arriere-plan du document dans lequel il est
inséré. Lorsqu'un dessin se trouve en arriere-
plan d'un texte, il ne peut étre sélectionné a la
souris qu'en combinaison avec la touche Ctrl.

Options de retournement

Le menu Format propose la commande
Retourner pour basculer un dessin sélectionné
horizontalement ou verticalement.

Grouper des formes
Pour grouper des objets de dessin:

1. Sélectionnez un objet, puis maintenez la
touche Shift enfoncée et sélectionnez les
autres formes a inclure dans le groupe.

2. Une fois les objets sélectionnés, positionnez le
pointeur de la souris sur 'un d'entre eux puis
cliguez a droite et choisissez la commande
contextuelle Groupe > Grouper.

Il existe encore une commande Dissocier pour
éclater un groupe existant et une commande
contextuelle Entrer dans le groupe pour pouvoir
accéder a un élément individuel d'un groupe et le
manipuler de maniére séparée.

9.3. Les objets Fontwork

L'outil de titrage Fontwork permet d'adapter du
texte autour de diverses formes. L'outil est a
disposition dans tous les modules de OpenOffice.

Créer un objet Fontwork

Le bouton Galerie Fontwork & situé dans la
barre d'outils Dessin ouvre une fenétre de
modeles d'objets Fontwork permettant de créer un
titre sous forme d'objet graphique.

Galerie Fontwork x|

Sélectionner un style Fontwork :

Gl Fomtwo  Fonfyfork
port™ N purtos® |
et

Fopfyork

b

[ oK J [ Annuler J [ aide J

Choisissez le modéle souhaité, puis cliquez sur le
bouton OK pour insérer l'objet correspondant
dans votre document.

Foptyork

La barre d'outils Fontwork apparait. Elle se
compose des boutons commande suivants :

W k- A - A -
1 2 3 5

1. Galerie Fontwork : ouvre & nouveau la fenétre
Fontwork.

2. Forme Fontwork : propose une palette de
formes prédéfinies pour [I'objet Fontwork
inséré.

3. Hauteur identique pour les lettres
Fontwork : applique ou non une hauteur
identique pour toutes les lettres, majuscules et
minuscules.

[l
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9.L'insertion d'objets

4. Alignement Fontwork propose divers
options d'alignement pour le texte Fontwork.

5. Espacement des caractéres Fontwork
choix d'espacement entre les lettres Fontwork.
La valeur 100% correspond a un espacement
normal.

Bordure de sélection
Elle se compose de :

- 8 poignées de redimensionnement carrées, de
couleur bleue, servant a redimensionner l'objet ;

— 1 poignée ronde de couleur jaune permettant de
faire tourner I'objet. Lorsque le pointeur de la
souris est posé sur cette poignée, il prend la
forme d'une main.

Editer le texte

Pour basculer en mode d'édition de texte, et
pouvoir remplacez le texte proposé par défaut par
le vbtre, double-cliquez sur l'une des lettres (pas
entre deux lettres). Une fois le texte saisi, utilisez
la touche Escape pour quitter le mode édition.

Formater un objet Fontwork

Vous pouvez également appliquer a un objet
FontWork des modifications et un formatage a
l'aide de commandes présentes dans son menu
contextuel : Ligne, remplissage, texte, position et
taille, disposition, ancrage, etc.

9.4. Lesimages bitmap

Les images bitmaps sont produites par les
appareils photos numériques, les scanners et les
captures d'écran. Les cliparts bitmaps fournis
d'origine avec AOO appartiennent également a
cette catégorie.

Elles sont constituées d'une mosaique de points,
appelés pixels et s'utilisent dans la plupart des
illustrations graphiques, mais avec le double
inconvénient d'étre lourdes au stockage et de
présenter assez vite une pixellisation lorsqu'on
cherche a trop les agrandir.

Il est possible de convertir une image vectorielle en
bitmap en la copiant dans le presse-papiers de
Windows, puis en utilisant la commande de collage
spécial pour la coller au format bitmap.

Modalités d'insertion

En fonction de l'origine de limage a insérer,
plusieurs méthodes sont possibles.

Copie depuis le presse-papiers de
Windows

On peut directement insérer, par collage, un

graphisme copié dans le presse papiers de

Windows.

Insertion depuis I'explorateur de fichiers

Vous pouvez faire glisser directement dans un
document un fichier image depuis votre
Explorateur de fichiers Windows. Cette méthode
intégre une copie de l'image dans le document.

Si vous procédez en combinaison avec la touche
Ctrl de votre clavier, limage se trouve insérée
sous forme de lien.

Insertion a partir d'un fichier local

La commande de menu Insertion > Image a
partir du fichier ..., ou le bouton A partir d'un

fichier =N dans la barre d'outils Dessin ouvrent
la boite Insérer une image, depuis laquelle vous
pouvez rechercher sur vos disques limage a
insérer. La boite dispose d'une option Apercu
fournissant une prévisualisation de I'image choisie
avant de l'insérer.

Une option Lier est également disponible dans la
boite pour insérer I'image sous forme de lien. Par
la suite, si vous décidez d'intégrer l'image liée, par
exemple, pour pouvoir transférer votre document
a un tiers sans devoir lui envoyer séparément les
images, vous devez procéder comme suit :

1. Une fois le document ouvert, lancez la
commande Edition > Liens ... depuis la barre
des menus.

2. La boite de dialogue d'édition de liens apparait
et montre tous les fichiers liés. Dans la liste
Fichiers sources, sélectionnez les fichiers que
vous souhaitez intégrer dans le document.

. Cliquez sur le bouton Rompre le lien.

4. Enregistrez votre document pour sauvegarder

les modifications.

Le bouton Modifier ... permet de retourner a la

boite d'ouverture de fichier pour remplacer l'image
pointée par le lien par une autre, si nécessaire.

w
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9.L'insertion d'objets

Redimensionner une image

a

Une image est toujours insérée a sa taille
maximale. Pour l'adapter au document, il est
nécessaire de la redimensionner.

Le redimensionnement est a réaliser en premier
apres l'insertion d'une image dans un document, les
opérations visant a la modifier et a la corriger
doivent se faire aprés, méme s'il ne s'agit pas la
d'une regle absolue.

Les images peuvent étre redimensionnées
simplement a l'aide de la souris. Cependant, il est
également possible de recourir a une commande
pour réaliser |'opération de maniére plus précise

Utiliser la souris

Le redimensionnement se fait en faisant glisser
les poignées de redimensionnement qui
garnissent la bordure de sélection de limage
lorsqu'elle est sélectionnée.

1. Cliquez sur l'image pour la sélectionner et faire
apparaitre ses poignées de
redimensionnement.

2. Positionnez le pointeur sur lune des
poignées : celui-ci change de forme pour
adopter celle d'un graphisme indiquant la
direction du redimensionnement.

3. Cliquez et faites glisser pour redimensionner
l'image.

4. Relachez le bouton de la souris lorsque la taille
souhaitée est atteinte.

Les poignées situées aux angles de la bordure de
sélection permettent un redimensionnement a la
fois en hauteur et en largeur, alors que les
poignées situées au milieu des 4 coétés du
rectangle de sélection ne gérent le
redimensionnement que dans une seule direction.

Pour conserver les proportions originales de I'image
lors d'un redimensionnement par une poignée
d'angle, on peut procéder en maintenant la touche
Shift enfoncée en s'assurant de d'abord relacher le
bouton de la souris avant de relacher la touche
Shift lorsque la taille souhaitée est atteinte.

La commande Position et taille

Cliguez a droite sur limage puis choisissez la
commande contextuelle Image...

Dans la boite qui s'ouvre, sélectionnez l'onglet
Type.

Taille
Largeur
[ relatiF 1
Hauteur
[1relati 2

Conserver le ratio

[ Taille d'origine ]

L'option Conserver le ratio permet de conserver le
méme rapport largeur/hauteur pour éviter de
déformer l'image..

1. L'option Relatif permet d'alterner entre le
pourcentage et la dimension réelle de la
largeur de limage dans la liste déroulante
Largeur. La largeur peut en effet étre exprimée
comme pourcentage de la largeur du texte de
la page.

2. L'option Relatif permet d'alterner entre le
pourcentage et la dimension réelle de la
hauteur de limage dans la liste déroulante
Hauteur. La hauteur peut en effet étre
exprimée comme pourcentage de la hauteur
occupée par le texte de la page.

Le bouton Taille d'origine restaure la taille
originale de l'image.

Recadrer une image

Dans une image bitmap, il arrive que seule une
partie soit intéressante. Inutile alors de chercher a
la réduire, car c'est toute I'image qui est réduite, y
compris la partie non désirée ; il faut la rogner
(recadrer) pour en supprimer les parties non
désirées.

Le recadrage se fait dans l'onglet Rogner de la
boite Image, comme montré ci-dessous.

1. Lorsque cette option est sélectionnée, le
recadrage n'affecte pas I'échelle de limage,
mais seulement sa taille.

2. Lorsque cette option est sélectionnée, le
rognage n'affecte pas la taille originale de
l'image, mais bien son échelle, ce qui peut
conduire a des distorsions.

3. Lorsqu'une valeur est entrée dans l'un de ces
champs, l'image est recadrée de cette valeur.
Le résultat final obtenu dépendra bien s(r du
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choix effectué entre les options Conserver
I'échelle ou Conserver la taille de I'image.

4. Echelle Largeur et Hauteur: indiquer en
pourcentage les valeurs a appliquer pour le
rognage de limage. La taille de l'image se
modifie en conséquence. Pour réaliser un
redimensionnement a [I'échelle, les deux
valeurs doivent étre identiques.

5. Les champs Largeur et Hauteur se modifient a
mesure qu'on saisit des valeurs de rognage.
La zone de prévisualisation permet d'estimer la
valeur correcte de rognage a appliquer.

6. Ce bouton permet de restaurer la taille
d'origine de l'image.

| Macro |

i'l'ype Optiors | jon dutexte | Hyperlien | Image |Rogner |Bordures | amigre-plan |
Rogrer
@ Conserver edhelel 1
© Conserver la taile de limags 2
Gauche [0.00cm (S Haut 3 0.00cm |
Drote  [0.00cm (3] s [0.00m 3]
Echelle
e [0 B
Heutew  [100% (31|
Talle de limage
Largeur 5.48m & 5.48crm x 6.53em
= =S
6
L ok || Annuer ||  ade || metabir |

Le rognage a l'aide de la souris n'est possible que
dans Draw, Impress et Calc, grace au bouton

Rogner[%] intégré dans leur barre d'outils Image.
Pour disposer d'une fonctionnalité similaire dans
Writer, vous devez installer I'extension CropOOo.
qui installe une nouvelle barre d'outils intitulée

CropOOo comportant un bouton unique H

Alighement horizontal et
vertical

L'alignement permet de définir la position occupée
par l'objet verticalement ou horizontalement par
rapport a son point d'ancrage. Les commandes
d'alignement sont disponibles :

— Dans le menu Format..

— Dans le menu contextuel de l'image.

— Dans la barre d'outils Image.

Une fois le point d'ancrage défini, il reste a
positionner le graphisme par rapport a lui, c'est a
dire l'aligner verticalement ou horizontalement sur
le point d'ancrage choisi. Il existe 3 options par
type d'alignement :

— gauche, centre, droite pour [lalignement
horizontal ;

—haut, au centre, en bas : pour lalignement
vertical.

Faire tourner une image

Writer et Calc ne disposent pas d'un outil intégré
permettant la rotation d'une image, il faut
impérativement passer par Impress et Draw pour
disposer de cette fonctionnalité:

1. Ouvrez un nouveau document dans le module
Dessin ou Présentation, puis insérez I'image a
faire tourner.

2. L'image étant sélectionnée, sélectionnez
l'icbne de rotation dans la barre d'outils
Dessin.

3. Faites pivoter limage comme souhaité, en
utilisant les poignées rouges apparues aux
coins de limage. Par défaut, la rotation
s'effectue autour d'un axe situé au centre de
limage (indiqué par une croix noire), mais
vous pouvez changer la position de cet axe a
l'aide de la souris. Pour limiter l'angle de
rotation a des multiples de 15 degrés,
maintenez la touche Shift enfoncée pendant
gue vous faites tourner l'image.

4. Sélectionnez limage finale obtenue, par
exemple a l'aide du raccourci Ctrl+A, puis
copiez la dans le presse-papiers par Ctrl+C.

5. Revenez & votre document pour y marquer
I'endroit ou limage doit étre insérée, puis
utilisez le raccourci clavier Ctrl+V (ou la
commande Edition > Coller) pour la recopier
a cet endroit.

Options de disposition

Les options de disposition ne s'avérent utiles que
lorsque des objets se chevauchent. Vous pouvez
choisir entre quatre positions, plus une cinquieme
disposition spéciale pour les objets dessinés

1. Envoyer a l'avant: le graphisme se retrouve
placé au dessus du texte et de tous les objets
graphiques, c'est a dire a l'avant-plan.
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2. Envoyer vers l'avant. remonte l'objet d'un
niveau dans la pile. En fonction du nombre de
niveaux d'objets existants, vous pouvez étre
amené a répéter un certain nombre de fois la
commande pour obtenir le résultat souhaité.

3. Envoyer vers l'arriére redescend d'un
niveau vers le bas l'objet sélectionné dans la
pile.

4. Envoyer a l'arriere : descend le graphique
sélectionné tout en bas de la pile. Le texte du
document et les objets insérés sont alors tous
au-dessus de lui.

5. A l'arriere-plan/ Au premier plan: cette
option, disponible dans Writer et Calc permet
de placer un dessin en avant-plan ou en
arriere-plan du document dans lequel il est
inséré. Lorsqu'un dessin se trouve en arriére-
plan d'un texte, il ne peut étre sélectionné a la
souris qu'en combinaison avec la touche Ctrl.

Les commandes de disposition sont accessibles
depuis :

- La barre d'outils Image.

- Le menu Format.

- Le menu contextuel d'une image sélectionnée.

Options de retournement

Le menu contextuel des images renferme encore
une commande contextuelle Retourner,
permettant de les retourner horizontalement ou
verticalement.

Formater les images

Des commandes contextuelles sont également
disponibles pour formater les images bitmaps.

— Dans Writer les options de formatage sont
toutes regroupées dans la boite de dialogue
Image, accessible par la commande
contextuelle Image... ou un double clic sur une
image insérée.

—Dans Calc, Draw et Impress: commandes
contextuelles Ligne, Remplissage.

Barre d'outils Image

Dans tous les modules, la barre d'outils Image
s'affiche deés qu'une image se trouve sélectionnée
dans un document.

Nous prendrons comme exemple la barre Image
qui apparait dans Draw et Impress, car les

commandes qui la composent se retrouvent
également dans Calc et Writer (sauf la commande
de rognage qu'on ne trouve pas dans Writer).

Cette barre en integre elle-méme deux autres : la
barre Filtre, qui peut étre déplacée, et la barre
Couleur, qui s'ouvre comme barre d'outils flottante
séparée.

Les commandes supplémentaires présentes sur
la barre d'outils Image de Calc et Writer seront
expliguées dans les manuels d'utilisation de ces
deux modules.

Qv [Pardfan @ o 2 A 2@ X
I 2 3 4 56 7 8

1. Filtre : voir plus bas.

2. Mode graphique: les modes graphiques

possibles sont : Par défaut, Niveaux de gris,

Noir/Blanc, ou Filigrane.

Couleur : voir plus bas.

4. Transparence : permet un réglage du
pourcentage de transparence de l'image. Ce
réglage est particulierement important lors de
la création d'un filigrane ou lorsqu'on souhaite
positionner une image en arriere-plan.

5. Ligne : ouvre la boite de dialogue Ligne.

6. Remplissage : ouvre la boite de dialogue
Remplissage.

7. Ombre : commande bascule pour appliquer
une ombre ou la supprimer.

8. Rogner l'image : ouvre la boite de dialogue
Rogner.

Filtre

BepeREEOIrEN
123466 788 101

w

1 Invertir : inverse les couleurs d'une image en
couleurs ou les valeurs de luminosité d'une
image en niveaux de gris.

2 Adoucir : adoucit le contraste.

Augmenter la netteté : augmente le contraste.

Supprimer les interférences : enléve des pixels

d'une image.

5 Solarisation : imite les effets d'un excés de
lumiere dans un tableau. Une boite de
dialogue permet d'ajuster les parameétres.

A~ W
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6 Vieillissement : simule le vieilissement d'une
photo. Peut étre appliqué a plusieurs reprises.
Le niveau de vieilissement peut étre réglé
dans une boite de dialogue.

7 Poster: conféere a une image l'aspect d'une
peinture en réduisant son nombre de couleurs.

8 Pop'art: modifie l'image de facon
spectaculaire.

9 Dessin au fusain : conféere a l'image l'aspect
d'un dessin au fusain.

10 Relief : une boite de dialogue permet d'agir sur
I'effet de relief en ajustant la source de lumiére
a l'origine de l'ombre.

11 Mosaique : rassemble des groupes de pixels
dans une zone unique d'une seule couleur.

Couleur

Eauleur =1 | Cette palette permet de modifier

les couleurs de base de l'image

o e
Elow # (rouge, vert, bleu dans le
=1 |systtme RGB) ainsi que sa
0% |& S
luminosité, son contraste et son
= [# |gamma. Si le résultat n'est pas
0% %

satisfaisant, vous pouvez utiliser

{L} le raccourci Ctrl + Z pour

restaurer les valeurs par défaut.

9.5. Image réactive

OpenOffice dispose d'une fonctionnalité pour
créer, dans une image bitmap, des zones
réactives (cliquables) permettant d'accéder, d'un
clic de souris, a des adresses spécifiques
(adresses web ou chemins vers des fichiers
locaux) ou de démarrer des macros.

Procédez comme suit :

1. Sélectionnez l'image puis lancez la commande
Edition > Image Map pour ouvrir la fenétre
Editeur d'Image Map.

2. Utilisez les formes disponibles dans la boite
(Rectangle, Ellipse, Polygone, Polygone a main
levée) pour dessiner les zones souhaitées
directement sur l'image affichée dans la boite de
dialogue, puis ajustez leur position.

3. Sélectionnez une a une vos zones et affectez
leur I'action & exécuter lorsqu'on cliquera dessus.

- S'il s'agit de créer un lien sur cette zone,
d'associer une URL, saisissez son adresse (ou
le chemin vers un fichier local) dans le champ
Adresse, puis renseignez, dans le champ Texte,
le texte qui devra apparaitre dans une infobulle,
lorsqu'on pointera sur la zone. Dans la liste
Cadre, choisissez le type de cadre dans lequel
devra s'afficher la cible du lien. La valeur _self,
qui ouvre la cible dans la fenétre du navigateur
actif, devrait fonctionner dans la majorité des
cas et est recommandée.

— S'il s'agit d'associer une macro, désignez la en
cliguant sur le bouton Macro ... & .

— Cliquez sur le bouton Actif f pour rendre la
zone active. Ce bouton commande a un
comportement  d'interrupteur en position
enfoncée, il signifie que la zone sélectionnée est
active et en position relachée, qu'elle ne l'est
pas.

5. Cliquez sur le bouton Appliquer 4 pour
valider les modifications entreprises sur l'image,

puis cliquez sur le bouton Enregistrer... Si
vous souhaitez sauvegarder votre image Map
comme fichier indépendant.

6. Refermez la boite de dialogue pour revenir a
I'affichage de votre document.

Lorsque l'image est affichée, un clic sur ses zones
réactives démarre les différentes actions qui leur
sont associées. Pour repérer celles-ci pointez
simplement sur I'image. Lorsque le pointeur de la
souris prend la forme d'une main, vous étes
positionné sur une zone réactive et son texte
s'affiche dans une infobulle. A ce moment, il suffit
de cliquer pour exécuter l'action associée a la
zone.

9.6. Les diagrammes

OpenOffice dispose d'un module permettant de
réaliser rapidement une représentation graphique
de données sélectionnées dans un tableau dans
un document Calc, Writer, Impress ou Draw?. Ce

2 Le module Diagramme présente plus de
fonctionnalités dans Calc. Cette section n‘aborde
gue les fonctionnalités générales, communes a
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module permet également, dans un second
temps, de retoucher le diagramme obtenu a l'aide
de toute une série de fonctions d'édition et de
personnalisation.

Un graphique (ou diagramme) représente
graphiquement les données d'un tableau et facilite
leur interprétation en visualisant les tendances ou
les relations qui existent entre elles. En effet, les
graphigues ont l'avantage de résumer en une
seule image représentative de grosses quantités
de données, et de faciliter ainsi leur analyse.

Il existe une liaison entre un graphique et les
données qu'il représente. Lorsque celles-ci sont
modifiées, le graphique correspondant est
automatiquement actualisé.

Pour illustrer l'utilisation de ce module, nous
utiliserons le tableau de données ci-dessous.

Dans Writer, Impress et Draw ce graphique est
accompagné d'une table de données exemple
gu'il faut remplacer par les valeurs a
représenter ;

Dans Calc, le diagramme est directement
construit a partir de valeurs sélectionnées au
départ dans la feuille de calcul et la premiere
boite de I'Assistant de création de graphique
apparait pour permettre de personnaliser le
modele et d'obtenir le diagramme final désiré.

Accéder aux commandes

Lorsqu'un graphique se trouve en mode Edition
(en double cliqguant dessus), comme dans
I'exemple ci-dessus, les commandes permettant
de le manipuler sont accessibles aux endroits
suivants.

A | B | C | 2

i Ordures ménagéres o
7= 1992 1995

3 [Métaux 3% 5% B
4 |Verre 11% 9% o Wccorre 1
"5 |Plastiques 15% 18% I Desrmes |
_ B [Textiles 2% 5% 7

7 [Mat. Drganiques 30% 5% 5
EP“F ers 39% 8%

Insérer un graphique

Le démarrage du module graphique ne se fait pas
exactement de la méme maniére dans tous les
composants de OpenOffice.

1. Dans Impress, Draw et Calc, on utilise la
commande Insertion > Diagramme... ou le

bouton correspondant L dans la barre d'outils
Standard.

2. Dans Impress, on peut aussi cliquer sur l'icbne
présente dans un espace réservé Diagramme

ol d'une mise en page de diapositive
destinée a contenir un graphique.

3. Dans Writer, il faut utiliser la commande
Insertion > Objet > Diagramme ... Il n'y a pas
de bouton de démarrage dans la barre d'outils
Standard.

Dans tous les cas, un graphique par défaut

apparait.

Writer, Calc, Impress et Draw.

Lgre 1 Ugre 2 Ugre 3 Lgre 4

Barre d'outils Formatage
Formatsge vx

[2ane A dagramme: ] Formater asekecton | B @ (= [= | &
6 7 8

1 2 34 3

1. Elément de diagramme sélectionne
I'élément de diagramme choisi dans la liste
déroulante.

2. Formater la sélection : ouvre la boite de
formatage spécifique a I'élément sélectionné.

3. Type de diagramme : ouvre la boite de
dialogue qui permet de changer le type de
représentation.

4. Table de données : affiche la Table des
données. Dans Calc, ce bouton est désactivé.

5. AfficherImasquer la grille horizontale
affiche/masque la grille pour I'axe Y.

6. Afficher/masquer la légende
affiche/masque la Iégende.
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7. Echelle de texte : modifie I'échelle du texte du
diagramme lorsqu'on modifie sa taille.

8. Réorganiser le diagramme modifie la
disposition des données du diagramme.

Menu Insertion

Les commandes d'insertion suivantes sont
disponibles :Titre — Légende — Axes — Grilles —
Etiquettes de données — Courbe de tendance —
Courbes de valeur moyenne — Barres d'erreur Y.

Menu Format

Il renferme les options de mise en forme des
éléments internes du diagramme, dés qu'ils sont
sélectionnés. Ces commandes sont également
disponibles depuis le menu contextuel de tout
élément sélectionné. La commande Type de
diagramme ouvre une boite permettant de
changer de type de représentation graphique.

Lorsqu'un graphique est simplement sélectionné
(par un simple clic dessus), comme ci-dessous, il se
comporte comme n'importe quel autre objet inséré
(image, dessin, etc.) et on peut le redimensionner,
le déplacer, le positionner, etc.

= [m] o
[

m] o =]

. o

I:|I:|‘ =

Dans AOO 4.0, le volet Propriétés intégré a la
barre latérale propose les fonctions classiques de
redimensionnement qui s'affichent automatique-
ment lorsqu'un objet graphique se trouve
sélectionné.

La Table des données

Pour afficher la table de données, mettre le
graphique en mode Edition en double cliquant
dessus, puis lancer la commande Affichage >
Table de données du diagramme ... ou cliquer
sur le bouton Table de données dans la barre
d'outils Formatage.

Cette fonctionnalité n'est pas active dans Calc,
parce que non nécessaire : le tableau de données
est affiché dans la feuille de calcul elle-méme.

La fenétre Table de données qui apparait dispose
d'une petite barre d'outils dans sa partie
supérieure.

EEEI B
1 4 5 6
23 Colonne 1 ||l [Colorre 2 | [l [cokorne 3|
Catégories | Valeurss¥ | valsursy | Valewrsy |
1 9.1 32 +.51
2 |ligne2 24 8.8 2.65
3 Ligne 3 3.1 1.5 3.7
4 Ligne # 4.3 9,02 6.2

1. Insérer une lighe : permet de rajouter une
nouvelle ligne sous la ligne active.

2. Insérer des séries : ajoute une nouvelle
colonne a droite de la colonne active.

3. Supprimer une ligne : supprime la ligne
active, mais jamais la ligne des en-tétes de
colonnes.

4. Supprimer des séries : supprime la colonne
active, mais jamais la colonne renfermant les
en-tétes de lignes.

5. Déplacer les séries vers la droite : intervertit
la colonne active et celle située a sa droite.

6. Déplacer la ligne vers le bas : intervertit la
ligne active et la ligne située en dessous.

Il ne vous reste alors qu'a remplacer les données
fournies en exemple dans la tabelle par celles a
représenter pour obtenir le graphique souhaité et
pouvoir procéder aux modifications et formatages
désirés.

Changer de représentation

Pour changer de type de représentation :

— Double-cliquez sur le graphique pour le faire
basculer en mode Edition (bordure de sélection
grise).

—Lancez la commande Format > Type de
diagramme ... ou cliquez sur le bouton Type de

diagramme dans la barre Formatage

—La boite de dialogue ci-dessous s'ouvre et
affiche la liste des types de représentations
possibles.
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Type de graphique |£|
Marmal
B | [
@i Taile Eorme
|:i Graphique boursier
||,i'|1 Colonne et ligne Cylindre
Cdne
Pyramide
L Fol'dl J [ Annuler J [ Aide J

Cette boite permet de choisir un type de
graphigue dans une liste et propose, pour chaque
type, une série de variantes (sous-types)
possibles.

Cliguez dans le volet gauche de la boite sur les
différents types de diagramme disponibles pour
faire apparaitre a droite un apercu des sous-types
disponibles.

En cochant la case 3D, vous obtiendrez, lorsque
le type de diagramme choisi le permet, une
représentation en relief et vous pouvez également
changer la valeur Simple de la liste déroulante
pour la valeur Réaliste afin d'obtenir un rendu final
plus fin.

Le type de graphique a utiliser dépend des
données a représenter et de l'effet recherché
dans leur représentation.

— Colonne (histogramme) : c'est le modéle de
graphiqgue proposé par défaut. On [utilise
principalement pour comparer plusieurs séries
de données a un moment précis. Celles-ci sont
représentées par des barres de hauteur
proportionnelle a leur valeur. L'axe X affiche les
catégories et l'axe Y les valeurs pour chaque
catégorie.

— Barre : c'est un histogramme avec des colonnes
horizontales et non verticales. L'axe Y affiche
les catégories et I'axe X les valeurs pour chaque
catégorie.

— Secteur : un tel graphigue n'affiche qu'une seule
série de données dont il visualise les relations
proportionnelles. Les valeurs s'affichent comme
secteurs circulaires du cercle total. La longueur
d'un arc, ou la zone de chaque secteur, est
proportionnelle a sa valeur. Les graphiques en
tore (anneau) sont un sous-type de graphique
en secteur qui permet de représenter les

relations proportionnelles existant entre les
éléments de plusieurs séries en utilisant un
anneau différent pour chacune d'elles.

— Zone (aire) graphique en courbes dont les
espaces entre les lignes sont remplis.

— Ligne (courbes) : utilisé pour étudier I'évolution
d'une ou plusieurs variables, par rapport & une
autre, par exemple pour représenter |'évolution
de grands ensembles de données dans le
temps (ventes d'un produit sur une période
donnée, etc...), ou pour la mise en évidence de
tendances. Un diagramme en ligne affiche des
valeurs sous forme de points sur I'axe Y. L'axe X
affiche les catégories. Les valeurs Y de chaque
série de données peuvent étre connectées par
une ligne.

— XY (nuage de points ou dispersion) : graphique
mettant en évidence des relations entre
différentes séries de données. Chaque paire de
valeurs (X|Y) s'affiche comme un point dans un
systéme de coordonnées.

— Toile (radar) affiche les valeurs de données
comme des points connectés par des lignes, sur
une grille en toile qui ressemble a une toile
d'araignée ou a un affichage sur un écran radar.
Pour chaque ligne de données du diagramme,
une ligne radiale est affichée sur laquelle les
données sont tracées. Toutes les valeurs de
données sont affichées avec la méme échelle.
De tels graphiques sont généralement utilisés
pour comparer la valeur totale de plusieurs
séries de données.

— Cours (Graphique boursier) : illustre la tendance
du marché en fonction du cours d'ouverture, du
cours plancher, du cours plafond et du cours de
cléture.

— Colonne et ligne (courbe/histogramme) : permet
de combiner deux types de représentations pour
comparer de multiples séries de données :
superposition, par exemple, d'un graphique en
courbes représentant les données de ventes
réalisées, a un graphique en histogrammes,
représentant les données des ventes prévues.

Modifier les éléments internes

Pour accéder aux éléments internes du graphique
et pouvoir les modifier, il faut d'abord basculer le
graphique en mode Edition en double cliquant
dessus.
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Une fois le graphique activé, 4 méthodes
permettent d'accéder a la boite de modification
d'un élément :

1. Choisir directement dans le menu Format la
commande qui permet de modifier I'élément
souhaité. Cette procédure évite de devoir
sélectionner a la souris I'élément a modifier.

2. Cliquer sur l'élément & modifier pour le
sélectionner, puis choisir la commande
permettant de le modifier dans son menu
contextuel.

3. Double cliquer sur I'élément a modifier pour a
la fois le sélectionner et directement ouvrir sa
boite de modification.

4. Dans la barre Formatage, choisir I'élément a
formater dans la liste déroulante Sélectionner
I'élément de diagramme, puis cliquer sur le
bouton Formater la sélection pour accéder a
la boite de formatage spécifique.

Modifier la plage de données

Pour modifier les données représentées, ouvrir la
Table de données en cliqguant sur le bouton
correspondant dans la barre d'outils Formatage.

Créer et modifier des titres

— Création par la commande Insertion > Titres ...

— Edition aprés un double clic sur le titre & éditer
de maniére a y faire apparaitre un curseur
d'édition.

— Formatage par la commande Format > Titre.
Cette boite renferme 6 onglets (bordures,
remplissage, transparence, caracteres, effets de
caracteres et alignement) qui permettent une
mise en forme compléte des zones de titre.

Créer et modifier une Iégende

La commande Insertion > Légende ....ouvre une
boite permettant de créer une légende et de
choisir la position qu'elle occupera sur le
graphique.

La mise en forme d'une légende existante se fait
par la commande Format > Légende ..., ou par
appel de la commande contextuelle équivalente,
si la légende est déja sélectionnée.

La boite de formatage de légende renferme, sous
6 onglets, les options nécessaires au formatage
complet d'une légende : définition d'une bordure,

dun fond et dune transparence, options
complétes de formatage de caractéres.

Les axes et leur quadrillage

La commande Insertion > Axes ... ouvre une
boite qui permet d'ajouter des axes secondaires
X etY ou un axe Z a un diagramme 3D.

La commande Format > Axe permet de formater
les différents axes. La boite qui s'ouvre renferme,
sous différents onglets, des options qui
permettent de formater la ligne des axes (couleur,
style de trait, etc.), de positionner leurs étiquettes
et les marques dintervalle et de formater
complétement les caractéres des étiquettes.

Les grilles

La commande Insertion > Grilles
d'ajouter un quadrillage a un axe.

permet

La commande Format > Grille permet de
formater le quadrilage des différents axes
(couleur, épaisseur et type de trait).

Les séries de données

Lorsque le graphique est activé, un simple clic sur
'une des données représentées sélectionne
automatiquement la série correspondante. A ce
moment, la commande contextuelle Formater les
séries de données ouvre une boite de dialogue
de formatage intitulée Séries de données.

Cette boite renferme, dans ses différents onglets,
toutes les options de mises en forme de la série
de données sélectionnée. On peut ainsi choisir un
type de ligne, une couleur de remplissage et une

transparence applicable a la série de données
sélectionnée.

Les données peuvent également étre étiquetées,
avec des étiquettes qui peuvent étre formatées a
'aide des onglets Caractéres et Effets de
caracteres.

Lorsque le type de graphique le permet, il est
possible d'ajouter une courbe de tendance, une
courbe de valeur moyenne, et des barres d'erreur Y,
apres avoir choisi sous Catégorie d'erreur, 'un des
modes d'expression proposés pour la marge d'erreur
(variance, écart type, pourcentage, erreur maximale
ou valeur constante).

Paroi du graphique

La Paroi du diagramme correspond a sa partie
centrale, ou se trouvent représentées les
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données, comme le montre la copie d'écran ci-
contre.

On peut également la formater (contour et couleur
de remplissage) a l'aide de la commande Format
> Paroi du diagramme...

[ ] - | |
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Fond (arriere-plan) du graphique
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¥ qies £ ongEil &
quer
Type de déohets
" [ m

L'arriere-plan correspond a toute la surface
occupée par le diagramme comme le montre la
copie d'écran ci-dessous. La commande Format
> Arriére-plan du diagramme ... permet de le
mettre en forme (bordure, couleur d'arriére-plan et
transparence).

Ajouter des dessins

Y

Il est possible d'intégrer a un graphique des
graphismes ou des zones de texte créés a l'aide
de la barre d'outils Dessin (commande Affichage
> Barres d'outils > Dessin).

Les éléments insérés se disposent par défaut en
avant plan du diagramme et il est possible d'éditer
du texte a l'intérieur.

On peut manipuler de tels objets par
I'intermédiaire de leurs menus contextuels, aprés
les avoir sélectionnés d'un simple clic de souris
ou mis en mode édition par un double clic.

Graphiques 3D

Les types de graphique Colonne, Barre, Secteur
et Zone peuvent étre représentés en 3D en
cochant l'option correspondante dans la boite de
dialogue Type de graphique.

Dans un graphique 3D, la commande Format >
Affichage 3D ... ouvre une boite a 3 onglets pour
paramétrer la perspective, l'apparence et
I'éclairage du graphique.

L'onglet Eclairage permet ainsi d'appliquer un
certains nombre d'effets particuliers d'éclairage et
d'ajuster le filtre couleur et la lumiére ambiante.

Affichage 3D %]

|Perspective || Apparence |Eclairage l

Source de lurmigre

- |
[ aris 0% || )
Lurnigre ambiante P i ——]

(M Gis 60 (| [

[

[im

¥
il ]

[ QK J[ Annuler J[ Aide J

De méme on peut faire basculer et pivoter des
diagrammes 3D interactivement a l'aide de la
souris, en se servant des poignées rouges qui
apparaissent sur le pourtour de leur arriére-plan
lorsque celui-ci est sélectionné (diagramme au
préalable en mode édition).

Dans un graphique 3D, aprés sélection de sa Paroi
ou de son Arriere-plan, il est possible de modifier la
disposition des séries de données en les déplagant
vers l'avant ou l'arriere a l'aide des commande
Format > Disposer > Vers l'avant/arriére.

Une telle modification peut parfois améliorer la
lisibilité du diagramme sans toutefois affecter ses
données sources.
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9.7. Objets multimedia

Vous pouvez insérer du contenu multimédia dans
un document :

—en cliquant sur l'icone Insérer une vidéo dans
un espace réservé d'une diapositive,

—en langant la commande de menu Insertion >
Vidéo et son ...

Dans les deux cas, la boite de dialogue
Sélectionnez un fichier s'ouvre et vous pouvez
alors choisir sur votre disque le fichier multimédia
a insérer.

La boite renferme une option permettant également
I'insertion d'un fichier multimédia sous forme de
lien.

Une fois votre fichier chargé, I'image ci-dessous le
représente dans votre document.

Dans Writer, vous pouvez modifier son ancrage,
sa taille et son alignement comme vous le feriez
pour une image normale. Pour exécuter le fichier
multimédia, cliquez sur l'image qui le représente
pour afficher le lecteur multimédia représenté ci-
dessous qui permet de le lire.

Lecteur de médias X

“@e@e - [powoie —] =

Dans Impress, pour qu'un fichier multimédia soit Iu
en projection automatiquement lors de I'apparition
de la diapositive qui le contient, son exécution doit
étre définie dans la transition attachée a Ia
diapositive.

9.8. Objets OLE

Insérer un objet OLE dans un document consiste
a intégrer dans celui-ci un objet provenant d'une
application externe, comme une image en
provenance d'un logiciel de manipulation
d'images, un document texte en provenance d'un
traitement de texte, une feuille de calcul
provenant d'un tableur, etc. L'objet OLE s'ouvre
avec le programme qui I'a généré, ce qui permet
d'accéder a toutes les commandes qui permettent
de le modifier.

On peut ainsi insérer dans un document Writer,
une diapositive Impress un classeur Calc par la
commande Insertion > Objet > Objet OLE ... ce
qui ouvre la boite ci-dessous.

P - - -
Insérer un objet OLE

Creer un nouvel objet: © Créer a partir d'un fichier

Type d'objet

Classeur OpenOffice.org 3.4.1
Diagramme OpenOffice.org 3.4.1
Dessin OpenOffice.org 3.4.1

Formule OpenOffice.org 3.4.1 %
Texte OpenOffice.org 3.4.1

Autres objets

Choisir entre créer un nouveau classeur ou
importer un classeur existant. A la validation, une
feuille de calcul apparait dans le document, et les
menus et barres d'outils de Calc se substituent a
ceux du document original pour permettre de
travailler dans la feuille de calcul affichée.
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Les extensions sont des paquets qui ajoutent des
fonctionnalités a  OpenOffice. Elles sont
disponibles sur un dépbt officiel a I'adresse
suivante :

http://extensions.openoffice.org/fr

Les extensions ne sont pas toutes gratuites. Il est
donc indispensable de toujours consulter leur
description et de lire leur licence pour connaftre
leurs conditions exactes d'utilisation.

Avertissement

Ce document est un travail en cours. Les
extensions faisant I'objet d'une courte description
ont été testées sous Apache OpenOffice 3.4, mais
pas encore sous OOoLight et OOoKids.

Comme ces deux suites bureautiques sont des
versions allégées de AOO fonctionnant sans
Java, certaines extensions ne pourront pas étre
utilisées avec elles. Au fur et & mesure que ce
chapitre évoluera, je procéderai aux tests
nécessaires afin de constituer une liste

d'extensions fonctionnant sur ces deux suites.

10.1. Le gestionnaire des
extensions

I permet dinstaller facilement de nouvelles
extensions ou d'en retirer. Pour installer une
extension, procédez comme suit :

1. Téléchargez I'extension souhaitée et
enregistrez-la  sur votre ordinateur. Si
I'extension se trouve sur le dépdt officiel, il
suffit de lancer la commande Outils >
Gestionnaire des extensions... et de cliquer
sur le lien Obtenez des extensions
supplémentaires en ligne.

2. Dans la boite de dialogue Gestionnaire des
extensions, cliquez sur le bouton Ajoutetr....

3. Dans la fenétre Ajouter des extensions,
indiqguez le chemin conduisant a I'extension
téléchargée sur votre disque, puis cliquez sur
le bouton Ouvrir. L'installation commence et
vous pouvez étre invité a accepter un contrat
de licence.

4. Une fois linstallation terminée, la nouvelle
extension apparait dans la liste de la boite de
dialogue Gestionnaire des extensions.

5. Quittez complétement OpenOffice (y compris
le démarrage rapide), puis redémarrez votre
programme. Votre nouvelle extension est
maintenant préte a étre utilisée.

Il est également possible de démarrer la procédure
d'installation d'une extension en double cliquant
dessus dans I'Explorateur Windows.

10.2. Lorem ipsum generator

Cette extension est un générateur de faux-texte.
Vous pouvez la télécharger a I'adresse suivante :

http://extensions.openoffice.org/fr/project/Magenta
Lorem_ipsum_generator

Le faux-texte (également appelé lorem ipsum,
lipsum ) est, en imprimerie, un texte sans valeur
sémantique, permettant de remplir des pages lors
d'une mise en forme afin d'en calibrer le contenu en
I'absence du texte définitif.

Généralement, on utilise un texte en faux latin (le
texte ne veut rien dire, il a été modifié), le Lorem
ipsum ou Lipsum, qui permet donc de faire office de
texte d'attente. L'avantage de le mettre en latin est
que l'opérateur sait au premier coup d'ceil que la
page contenant ces lignes n'est pas valide, et
surtout l'attention du client n'est pas dérangée par le
contenu, il demeure concentré seulement sur
l'aspect graphique?.

3 Crédit : http://fr.wikipedia.org/wiki/Faux-texte
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L'installation de I'extension crée la barre d'outils

Lorem Ipsum = dont [laffichage est
contrdlé par la commande : Affichage > Barre
d'outils > Lorem Ipsum.

Un clic sur l'icbne ouvre la boite de dialogue ci-
dessous, qui permet de définir le nombre de
paragraphes de texte a générer. Le texte créé
s'insére a la position courante du point d'insertion.

Lorem Ipsum |X|

GEn&ter |§ ¥ ”paragraphes - |

Commencer par ‘Larem'?

Service Lorem Ipsum Fourni par James [

Wilson (v lipsum, comm). SEDErEr ]

L'exécution de ce programme nécessite une

connexion Internet active.

10.3. Mini-Calculator

Adresse de téléchargement :

http://extensions.openoffice.org/fr/project/Mini-
Calculator

Il Cette extension ne s'installe que sous Writer |

Aprés installation de l'extension, quittez
OpenOffice (y compris le démarrage rapide), puis
redémarrez le programme : une nouvelle icéne

intitulée Mini-Calculator = apparait dans la barre
d'outils Standard de Writer, juste a droite du
bouton commande de vérification orthographique.

Mini-Calculator [simple]

Dizplary...
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scientific

Un clic sur cette icone fait apparaitre la
calculatrice avec ses 3 boutons : simple, finance,
scientific permettant la réalisation de calculs
dans ces 3 domaines.

......

La validation par un clic sur le bouton affiche
le résultat du calcul dans la zone d'affichage de la
calculatrice.

Le nombre de décimales est choisi dans la liste

déroulante ﬁ M.

La validation par le raccourci clavier Ctrl+Enter
insére le résultat dans le document a l'endroit ou
se trouvait placé le point d'insertion lorsqu'on a
demandé l'affichage de la calculatrice.

Le bouton Display ... permet de régler les attributs
de caractéres pour l'affichage.

Malheureusement, l'acces au document n'est pas
possible lorsque la calculatrice est affichée.

Autre regret, les valeurs doivent étre introduites en
cliquant sur les touches de la calculatrice, il n'est
pas possible de les saisir au clavier.

10.4. EuroOffice Unit Converter

Cette extension, composée de deux modules,
permet d'effectuer des conversions entre
différentes unités physiques.

Adresse de téléchargement :

http://extensions.openoffice.org/en/project/EuroOff
ice_Unit_Converter

Aprés installation de [l'extension, quittez
OpenOffice (y compris le démarrage rapide), puis
redémarrez le programme : le menu Outils
s’enrichit de deux nouvelles entrées appelées
Unit Converter et Unit Converter — Sélection.

Outils > Unit Converter

Linit Converter

Unik tvpe mass ] L
Uit Urik:2
[ pound 2 I kioaram L
[ 1] 4 [ 5 4, 5350257
b
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=

. Ici vous pouvez définir le nom de la grandeur

physique a convertir (par exemple la masse, la

longueur, la pression, etc.).

Sous Unit 1, choisissez l'unité a convertir

Sous Unit 2, choisissez I'unité de conversion.

4. Entrez la valeur a convertir et validez par
Enter pour obtenir le résultat de la conversion.

5. Champ affichant le résultat de la conversion.
Le contenu de ce champ est automatiquement
actualisé si on modifie un élément dans les
champs (2) et (3).

6. Permet de coller le résultat dans votre

document a la position du curseur (cette

fonction ne fonctionne que dans Writer).

Outils > Unit Converter -
Selection

Ce module n'est accessible que depuis Writer.

wn

Convert Selection

Unit bype lenoth |

Unit1 Uitz
| meber Lo | Facat L |
[0.1350000000 | 0.44201 3355827 |

[ | [ |

Si vous sélectionnez une quantité donnée d'une
grandeur physiqgue dans votre document (par
exemple 0.135 m), [lextension identifie
automatiquement le type d'unité et la valeur a
convertir. Il ne reste plus qu'a choisir l'unité de
conversion pour voir s'afficher la valeur de
conversion pour cette unité.

Si vous cliguez sur Cancel, rien ne se passe,
mais si vous appuyez sur OK, le résultat de la
conversion s'insére dans le document avec
l'abréviation de I'unité choisie dans la liste
déroulante située en bas a gauche de la boite.

10.5. Modeles

Un grand nombre de modeéles peuvent étre
installés sous forme d'extensions.

OooDesignedLabels

Cette extension installe une série de modeéles
d'étiquettes classés en différentes catégories :
Adresses, Livres, Cds, Mailing, etc.

Adresse de téléchargement :

http://extensions.openoffice.org/fr/project/ooodesi
gnedlabels

Modern Impress Templates

Cette extension installe plus de 30 modéles
d'arriére-plan pour Impress. lls apparaissent dans
le volet central de la boite Modéles et documents
lorsqu'on clique sur le bouton Modéles. lIs sont
classés dans la catégorie Présentations.

Adresse de téléchargement :

http://extensions.services.openoffice.org/project/m
odern-impress-templates

Professional Template Pack -
French

Adresse de téléchargement :
http://extensions.openoffice.org/fr/project/SunTem

latepack 1 fr

Plus de 80 modeéles pour OpenOffice Writer, Calc,
Draw et Impress regroupés en catégories :

— Correspondance commerciale.
— Correspondance et documents privés

— Divers : pages de couvertures pour boites Cds,
certificats, etc.

— Documents commerciaux divers.
— Education.

10.6. SuperbChemistry

SuperbChemistry est une macro qui permet de
formater correctement et d'un seul coup dans un
document Writer toutes les formules chimiques
brutes qui y ont été saisies sans aucune mise en
indice et exposant.

Adresse de téléchargement :
http://extensions.openoffice.org/fr/project/schem

Par exemple, H2S04, H202, K2Cr207 et KMnO4
apparaitront comme suit aprés exécution de la
macro . H2804y H202, chrzol KmnO4_
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10.Les extensions

Pour lancer le formatage dun document
contenant des formules brutes, utilisez la
commande :

Outils > Macros > Exécuter la macro ... -
Macros OpenOffice.org — SuperbChemistry -
Main FormatDocument — Exécuter.

10.7. Chemestry

Adresse de téléchargement :

http://extensions.libreoffice.org/extension-
center/chemistry/releases/1.0

Cette extension installe une barre d'outils a un
bouton intitulée Chemestry. Un clic sur son unique
bouton fait apparaitre la boite ci-dessous dans
laguelle il suffit de saisir le nom de la substance
dont on souhaite obtenir la formule (il faut étre
connecté a Internet). A la validation, la formule
apparait ancrée au paragraphe contenant le point
d'insertion (format GIF ou PNG).

Formula; | pabal |

Format : | GIF |

Widkh: Height:
Line width: Symbol font size;

|5h|:|w all syrbals? [IH-symbals [ c-symbals |
|Sh|:|w cteren? | | ves |
[
H
0~ -0
HNH

10.8. Template Changer

Extension opensource qui ajoute deux nouvelles
entrées au menu Fichier > Modéles pour
permettre d'associer un nouveau modéle au
document actif ou & un dossier de documents.

Adresse de téléchargement :

http://extensions.services.openoffice.org/fr/project/
templatechanger

Tous les styles et les formatages sont alors
chargés a partir du nouveau modele associé et le
document se comporte comme s'il avait été créé a
partir de celui-ci.

10.9. Compose Special
Characters

Extension opensource qui permet l'insertion de
caractéres accentués et spéciaux a l'aide d'un
raccourci clavier défini dans une boite ouverte par
la commande Insertion > Compose character.

Une fois le paramétrage terminé, appuyez
simplement sur la combinaison de touche
appropriée, suivie par la combinaison exécutant la
macro.

Adresse de l'extension :

http://extensions.services.openoffice.org/fr/project/
ComposeSpecialCharacters

10.10. Oracle PDF Import

Extension opensource permettant l'importation et
la modification de fichiers PDF.

L'installation de cette extension rajoute l'option
Créer un fichier hybride au bas de l'onglet
Général de la boite de dialogue Options PDF.

Le fichier PDF hybride généré en activant cette
option se comporte comme un PDF normal mais
posséde l'avantage de pouvoir étre édité dans
OpenOffice.

http://extensions.services.openoffice.org/fr/project/
pdfimport

10.11. eLAIX

Adresse : http://elaix.org/

L'extension open source eLAIX convertit vos
documents Writer en modules d'apprentissage
ILIAS ou en ebooks au format EPUB 3.0.
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10.Les extensions

Une barre d'outils riche en fonctionnalités vous
aide a créer des documents bien formés et
structurés directement dans Writer.

10.12. Autres extensions

Ci-dessous une liste de liens de téléchargement
vers des extensions qui peuvent vous étre utiles.
Elle sont classées selon leur fonctionnalité.

Conversion format ePub

http://extensions.openoffice.org/fr/project/\Writer2e
Pub

Correcteur grammatical

http://extensions.openoffice.org/fr/project/after-
the-deadline

http://extensions.openoffice.org/fr/project/grammal
ecte

http://extensions.openoffice.org/fr/project/languag
etool

Documents scientifiques
http://extensions.openoffice.org/fr/project/AST#co
mments

http://extensions.openoffice.org/fr/project/Bibliogra
phyManager

Formules math/chimie
http://extensions.openoffice.org/fr/project/quick fo
rmule

http://extensions.openoffice.org/fr/project/CmathO
Oo

Dessin
http://extensions.openoffice.org/fr/project/cropooo

http://extensions.openoffice.org/fr/project/WriterRo
tationTool

http://extensions.openoffice.org/fr/project/freie-
schaltzeichen

http://extensions.openoffice.org/fr/project/GeOOo0

http://extensions.openoffice.org/fr/project/KemilLa
b

Comparer des documents

http://extensions.openoffice.org/fr/project/DeltaXM
LODTCompare

Gravure

http://extensions.openoffice.org/fr/project/DirectBu
m

Calculatrices
http://extensions.openoffice.org/fr/project/iMath
Cloud

http://extensions.openoffice.org/fr/project/smartclo
ud

Planificateur
http://extensions.openoffice.org/fr/project/icsGantt

Partitions musicales

http://extensions.openoffice.org/fr/project/O0oLily
Pond

Impress

http://extensions.openoffice.org/fr/project/presente
r-screen

http://extensions.openoffice.org/fr/project/PhotoAl
bumES

http://extensions.openoffice.org/fr/project/Portable
PhotoAlbum

Modéles
http://extensions.openoffice.org/fr/project/template
changer
http://extensions.openoffice.ora/fr/project/MLATem
plate

Vocal

http://extensions.openoffice.org/fr/project/Read T
exte
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